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This appendix lists navigation paths for pages in the Oracle Manufacturing Operations 
Center application.

Glossary

Related Information Sources

Integration Repository
 The Oracle Integration Repository is a compilation of information about the service 
endpoints exposed by the Oracle E-Business Suite of applications. It provides a 
complete catalog of Oracle E-Business Suite's business service interfaces. The tool lets 
users easily discover and deploy the appropriate business service interface for 
integration with any system, application, or business partner. 

 The Oracle Integration Repository is shipped as part of the Oracle E-Business Suite. As 
your instance is patched, the repository is automatically updated with content 
appropriate for the precise revisions of interfaces in your environment. 

Oracle Advanced Planning Implementation and User's Guide
This guide describes how to use Oracle's supply chain planning performance for 
forecasting and managing both supply and demand for your items. You plan your 
requirements, and execute and release the plan for discrete jobs, repetitive schedules, 
and flow schedules.

Oracle Cost Management User's Guide
This guide describes how to use Oracle Cost Management in either a standard costing 
or average costing organization. Cost Management can be used to cost inventory, 
receiving, order entry, and work in process transactions. It can also be used to collect 
transaction costs for transfer to Oracle Projects. Cost Management supports multiple 
cost elements and multiple sub–elements. It also provides comprehensive valuation and
variance reporting

Oracle Inventory User's Guide
This guide describes how to define items and item information, perform receiving and 
inventory transactions, maintain cost control, plan items, perform cycle counting and 
physical inventories, and set up Oracle Inventory.
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Oracle Manufacturing Operations Center Implementation Guide
This guide describes how to install and implement Oracle Manufacturing Operations 
Center. The tasks include setup for the following areas: Manufacturing Operations 
Center, Oracle Data Integrator source system data, and various manufacturing 
dimensions

Oracle Work in Process User's Guide
This guide describes how Oracle Work in Process provides a complete production 
management system. Specifically this guide describes how discrete, repetitive, 
assemble-to-order, project, flow, and mixed manufacturing environments are 
supported.

Do Not Use Database Tools to Modify Oracle E-Business Suite Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle E-Business Suite data 
unless otherwise instructed. 

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle E-Business Suite data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data. 

Because Oracle E-Business Suite tables are interrelated, any change you make using an 
Oracle E-Business Suite form can update many tables at once. But when you modify 
Oracle E-Business Suite data using anything other than Oracle E-Business Suite, you 
may change a row in one table without making corresponding changes in related tables.
If your tables get out of synchronization with each other, you risk retrieving erroneous 
information and you risk unpredictable results throughout Oracle E-Business Suite. 

When you use Oracle E-Business Suite to modify your data, Oracle E-Business Suite 
automatically checks that your changes are valid. Oracle E-Business Suite also keeps 
track of who changes information. If you enter information into database tables using 
database tools, you may store invalid information. You also lose the ability to track who
has changed your information because SQL*Plus and other database tools do not keep a
record of changes. 
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1
Overview

This chapter covers the following topics:

• Overview of Oracle Manufacturing Operations Center

• Technology Overview

• Architecture Overview

• Manufacturing Operations Center Instances

Overview of Oracle Manufacturing Operations Center
Oracle Manufacturing Operations Center (MOC) is a prebuilt, flexible, and extensible 
solution that improves your plant performance by collecting data from disparate plant 
floor systems, contextualizing them with business context, and provides real-time 
intelligence on plant floor operations. Oracle Manufacturing Operations Center is the 
foundation for continuous improvement. Key components of this application include:

• A data model based on ISA-95 industry standard and extensible attribute 
framework.

• Pre-built extensible adapters for Oracle EBS.

• A robust contextualization rules engine to convert raw shop floor data into 
meaningful business information.

• Pre-built key performance indicators and analytics, delivered in Oracle's industry 
leading, easy to configure and extend Business Intelligence (BI) technology.

• Ability to monitor production performance in real time.

Oracle Manufacturing Operations Center provides new capabilities to drive 
sustainability initiatives. Sustainability Aspect is a generic name used for continuous 
inputs consumed by companies to be able to operate and create goods or services. 
Common examples of sustainability aspects are electricity, gas, oil, water, helium etc. 
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The Sustainability Sensor Data Management system of Oracle MOC helps you meet the 
legislative requirements and social responsibilities to go green and accelerate 
sustainability improvements of companies focusing on manufacturing, innovation, or 
services, and enables you to: 

• Monitor and analyze energy consumption, energy cost, and carbon emissions with 
dashboards and built-in key performance indicators (KPIs), leveraged by Oracle 
Business Intelligence Enterprise Edition (OBIEE) technology.

• Integrate with smart meters, environmental management systems.

• Build automation systems and collect energy consumption and emissions data.

• Identify specific opportunities for improving energy efficiency and reduction in 
carbon emissions.

• Normalize and correlate energy consumption to operating conditions and 
production variables, and enable energy-aware manufacturing.

• Leverage as a certifiable data repository for energy usage reporting based on Global
Reporting Initiative (GRI) framework and Green House Gas (GHG) protocol.

Technology Overview
Manufacturing Operations Center uses the following Oracle technologies: 

• Oracle Data Integrator (ODI)

• Oracle Business Intelligence Enterprise Edition (OBIEE)

• Oracle E-Business Suite (EBS) Foundation

Architecture Overview
The following diagram provides an overview of Oracle Manufacturing Operations 
Center's architecture:
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The diagram describes the following:

Data Model
Oracle MOC data model complies with ISA-95 standards and is optimized for 
intelligence and integration. ISA-95 is a standard for Enterprises to control system 
integration that includes batch, continuous, and discrete industries. Managed by ISA 
(Instrumentation, Systems and Automation Society), ISA-95 defines terminology, 
functional requirements, and borrows or is based on PRM (Purdue Reference Model) 
for manufacturing. The Oracle MOC Data model is open and scalable for capturing user
specific attributes and building custom hierarchies, etc. and lets you incorporate data 
collection for energy consumption, energy costs, emissions of multiple sustainability 
aspects (i.e. electricity, gas etc.). The data model's granularity accommodates 
measurement frequencies collected down to a minute's level in order to perform 
accurate analysis and energy contextualization. 

Extensibility
• Ad hoc dashboards and reports with OBIEE
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Connectivity
Oracle MOC supports heterogeneous systems including device data and provides wide 
range of options for collecting shop floor data, directly from Programmable Logic 
Controllers (PLCs), Supervisory Control and Data Acquisition (SCADA) systems, 
Meters, Sensors and Distributed Control Systems (DCSs). Oracle MOC leverages Oracle 
Data Integrator (ODI), the data warehousing tool to extract and process data. A 
concurrent program is used to process meter readings for sustainability aspect 
consumptions.

Prepackaging
EBS Adapters: Oracle MOC is prepackaged with EBS adapters Release 11.5.10, Release 
12.0.6 , Release 12.1.3, and Release 12.2.

KPIs and Dashboards: Oracle MOC is prepackaged with more than one hundred forty 
metrics and role-based dashboards and reports.

Manufacturing Operations Center Instances
Typically, Oracle Manufacturing Operations Center (MOC) is installed locally at a plant
location. There can be single or multiple plant installations. It can be installed on a 
server for a single plant or for multiple plants that are connected. A company may have 
several instances of Oracle MOC installed. 

Consider the following example of a global manufacturing company with plants at two 
locations, in the U.S. and in India, and the U.S. has two different plant locations:

In this example, following options are available for installing MOC instances:

Option 1

• MOC Instance 01 - USA - SFO
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• MOC Instance 02 - USA - Denver

• MOC Instance 03 - India

With this option, plants are not grouped together and an instance of MOC is installed at
each plant and organized at the plant level.

Option 2

• MOC Instance 01 - USA

• MOC Instance 02 - India

With this option, plants are grouped by country. The plants at SFO and Denver have 
been grouped together into a single instance called USA.

Option 3

• MOC Instance 01 - USA & India

This option is a corporate installation for which all three of the individual plants are 
grouped into one instance called USA & India.
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2
Setup Steps

Setting Up Manufacturing Operations Center 
The Oracle Manufacturing Operations Center (MOC) setup steps span several Oracle 
systems including Oracle Business Intelligence Enterprise Edition (OBIEE), Oracle Data 
Integrator (ODI), and the MOC setup pages:

• OBIEE provides analytics from data spanning enterprise sources and applications.

• ODI provides data extraction, and transformation and loading from source systems 
into the MOC environment.

• The MOC Administrator role is used to setup Sustainability Aspect, Emission 
Factors, Tags, Meters, Entity Hierarchy, and setup contextualization methods for 
business context, and create and associate attribute groups and attribute data 
entities. It can also be used to create meters, run concurrent program to process 
meter readings, and use extensible attributes workbench to setup classifications and
attributes for user-defined attributes.

• The User role is used to view and integrate data collection, and perform analytic 
reporting. User can use extensible attributes workbench to create attributes and 
attribute groups, and associate them with classifications.

The following chart lists the setup steps for Oracle Manufacturing Center Operations. 
Some steps are required, others are optional, depending upon other functions in your 
environment:
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1. Source Systems Setup

Source system definitions are set up to load data from different source systems.

See: Setting Up Source Systems, Oracle Manufacturing Operations Center 
Implementation Guide

2. Site Setup

Site definitions are set up and mapped to source organizations in different systems.

See: Setting Up Sites, Oracle Manufacturing Operations Center Implementation Guide

3. Sustainability Aspect Setup

Sustainability Aspect is a generic name used for continuous inputs consumed by 
companies in order to be able to operate and create goods or services. Common 
examples of sustainability aspect are electricity, gas, oil, water, helium etc. 
Sustainability aspects always have associated costs for companies and are often 
source of harmful emissions to environment. Companies usually monitor 
consumption of sustainability aspects and make efforts to minimize them for 
efficiency and environmental concerns. Setting up sustainability aspect refers to 
defining energy, usage categories, and emissions. 
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See: Setting Up Sustainability Aspect, Oracle Manufacturing Operations Center 
Implementation Guide

4. Site Sustainability Setup

Setting up sustainability aspect for a site by defining energy sources, planned 
energy usage, cost, and emission factors. You must perform this setup to populate 
sustainability aspect for any entity belonging to the site.

See: Setting Up Sustainability Aspect, Oracle Manufacturing Operations Center 
Implementation Guide

5. Time Dimension Setup

Define time dimensions including calendars and workday shifts. You can analyze 
data for different hierarchies for time dimension.

See: Setting Up Time Dimension Hierarchies, Oracle Manufacturing Operations Center
Implementation Guide

6. Item Dimension Setup

Define item dimensions. You can analyze items by different hierarchies. Three item 
hierarchies are seeded, and any number of hierarchies can be built and analyzed. 
Item hierarchy supports ten levels.

See: Setting Item Dimension Hierarchies, Oracle Manufacturing Operations Center 
Implementation Guide

7. Equipment Dimension Setup

Define equipment dimensions. You can build multiple hierarchies for equipment, 
and these can be rolled up using different hierarchies for reporting. Five seeded 
hierarchies are provided, and ten hierarchy levels are supported. Any number of 
equipment hierarchies can be built and analyzed.

See: Setting Equipment Dimension Hierarchies, Oracle Manufacturing Operations 
Center Implementation Guide

8. Data Collection Setup

This task involves setting the profile option MTH: System Global Name in the 
source EBS system for collecting data from E-Business Suite applications master 
data. This data includes item and item hierarchies, resource and resource 
hierarchies, and shift definition. Reference data is also collected for production 
schedules and material produced, item and resource costs, and sale order lines 
pegged to work orders. Set up Oracle Data Integrator to load data using Microsoft 
Excel templates from other source systems into the MOC staging tables.

See: Load Data Reference and Transaction Data, Oracle Manufacturing Operations 
Center Implementation Guide
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9. Tag Setup

After loading tag master details from the device connector into MOC, you can 
configure tags to equipment and the data element to define the data the tag contains
like Output Quantity, Scrap Quantity etc. You can also define tags to associate with 
meters.

See: Setting Up Tags, page 3-2

10. Contextualization Setup

The contextualization setup enables the type of contextualization required for the 
equipment, defines whether the business context is mandatory or optional. 

See: Creating Equipment Contextualization Information, page 3-7

11. Inbound and Outbound Integration Setup

Inbound integration with Oracle EBS enables you to collect resource instances as 
equipment entities within MOC and also work order or process manufacturing 
batches reference data such as:

• Operations.

• Activities.

• Resource requirements from EBS.

• Resource instance schedules as equipment production schedules from EBS.

• Material consumed.

The outbound integration with Oracle EBS for Discrete Manufacturing creates the 
following discrete job transactions:

• Move transaction: MOC tags for completed, scrap, rejected quantities create 
corresponding move transactions in Oracle WIP.

Note: In EBS, you have to manually perform To Move of 
current operation to the Queue of next operation.

• Completion Transaction: Using output quantity, scrap and rejected quantity 
tags you can perform a To Move to Completion transaction.

• Resource Transaction: The status tags from shop floor process resource 
transactions in MOC and create resource transactions in Oracle EBS. The 
transaction posted is for run hours of the resource.

12. Meter Setup
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Setup Actual and Virtual Meters for data acquisition of electricity usage. 

See: Setting Up Meters, Oracle Manufacturing Operations Center Implementation Guide

13. Extensible Attributes Setup

The extensible attributes framework captures specific attributes for manufacturing 
entities including item, equipment, user-defined attributes, work order, batch 
operation, and miscellaneous custom entities. The entities and associated attributes 
are setup in the Extensible Attributes Workbench. 

See: Setting Up Extensible Attributes for MOC Entities, page 3-17, and Viewing 
Extensible Attributes Data for Entities, page 4-5

14. Defining Manual Contextualization

This task involves entering and editing business context for active tags that have 
not been summarized to the equipment summary tables. 

See: Using the Manual Contextualization Method, page 4-2

15. Defining Reason Codes

You can define a list of possible reason codes for equipment downtime, equipment 
run time, equipment idle time, and equipment scrap quantity.

See: Reason Codes, page 4-4

16. Event Setup

MOC provides a Workbench to generate and process events based on event types. 
You must set up event actions for the event types. 

See: Event Setup, page 3-14

17. MOC Catalog Setup

The prepackaged KPIs, reports and dashboards in OBIEE toolset needs to be 
configured through this setup. The MOC Catalog provides the KPIs, Plant Manager 
and Facilities Manager Dashboards related to manufacturing operations and 
monitoring sustainability aspect usage. This provides visibility to shop floor and 
operational analytics. 

See: Overview of the MOC Catalog, page 7-1

Related Topics
Setup Overview, Oracle Manufacturing Operations Center Implementation Guide

Overview of the Administrator Role, page 3-1

Overview of the User Role, page 4-1
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3
Administrator Role

Overview of the Administrator Role
The MOC Administrator role is used to setup and maintain master data for the 
Manufacturing Operations Center application. It is also used to calculate meter readings
and sustainability consumption. Following is a brief overview of the tasks under this 
role: 

• Contextualization setup: Used to setup contextualization method for equipment.

• Tag setup: Used to associate tags to equipment and MOC entities, and define rules 
for adding the business context through the contextualization setup.

• Sustainability aspect setup: Used to setup sustainability aspect and its 
corresponding usage categories and emission codes. 

• Site setup: Used to setup site.

• Site sustainability setup: Used to setup the association of site to sustainability aspect
and define the sustainability aspect sources and emission factors.

• Equipment setup: Used to setup equipments.

• Tag equipment mapping setup: Used to associate tags to equipment.

• Resource setup: Used to setup resources.

• User-defined entities setup: Used to setup user defined entities.

• Shift setup: Used to create shift templates and generate shifts for site and its entities.

• Hierarchy setup: Used to setup and build hierarchy.

• Meter setup: Used to setup meters.
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• Meter entity association: Used to associate meter to entities.

• Lookups setup: Used to setup lookup values. 

• Extensible attributes setup: Used to create attribute groups and attributes and 
associate to classifications and create pages.

• Run Requests: Used to run the MTH: Process and Populate MOC Entity 
Sustainability Aspect program that calculates meter readings and sustainability 
aspect consumption. 

• Events

Refer to the Oracle Manufacturing Operations Implementation Guide for detailed 
information on setting up sustainability, site sustainability, equipment, resources, user 
defined entities, shifts, hierarchy, meters and lookups.

Related Topics
Setting Up Tags, page 3-2

Creating Equipment Contextualization Information, page 3-7

Setting Up Extensible Attributes for MOC Entities, page 3-17

Running the MTH: Process and Populate MOC Entity Sustainability Aspect, page 3-6

Setting Up Events, page 3-14

Setting Up Tags
A tag is the metadata configured in PLC or other device connector providing data at the
program interval. MOC requires specific tags for obtaining the operation details and 
business context. There are two types of tags. Business context tags provide work order,
operation, product, and equipment details. Data tags provide value of output, scrap, 
rework, quantity, and completed quantity.

To define tag data information:
1. Navigate to the Tag Setup page. If you have already imported the tag metadata 

using the csv template, then they display on this page.

2. To add a new Tag Data Source, Click Add Source.

3. Enter the name of the new tag data source in the Tag Data Source field.

4. Select the Type of the tag. Options are Operation and Sustainability.
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5. Select the System for the tag. The list of Source Systems that you set up while 
setting up the MOC application display in the list of values for this field. Refer to 
the "Setting Up Source Systems" chapter of the Oracle Manufacturing Operations 
Systems Implementation Guide for more information.

6. Save your work.

To add tags to a tag data source:
1. Select a Tag Data Source to which you want to add tags.

2. Click Add.

3. Enter the following information for a tag:

• Tag Code is the code for the tag.

• Tag is the name of the tag.

• Description is a brief description of the tag.

4. Select the Data Type for the tag. Options are Alphanumeric and Numeric. Numeric 
displays by default.

5. Select the Reading Type for the tag. Options are Cumulative and Incremental. 
Cumulative displays by default.

6. Select the Order in which the readings for the tag are recorded. Options are 
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Ascending and Descending. This field is enabled only if you select Cumulative as 
the Reading Type. If you select Cumulative as the Reading Type, then Ascending 
displays by default.

7. Enter a Reset Value. Reset Value is the value at which the tag reading recording 
must be reset. This field is enabled only if you select Cumulative as the Reading 
Type.

8. Enter an Initial Value. Initial Value is the starting value that you expect to receive 
from a tag meter recording. This field is enabled only if you select Cumulative as 
the Reading Type. Zero is the default value.

9. Enter a Reading Interval (in minutes) as the time interval at which the tag readings 
must be recorded. You can enter a reading interval only for a tag of the 
sustainability type tag data source.

10. Status displays as Active by default. To inactive a tag, click Inactivate.

11. Click Save.

Note: A tag can be associated to an equipment record only once, 
but can be associated to multiple equipment.

To update a tag:
1. Select a tag.

2. Click Update. Edit the following fields:

• Tag
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• Description

• Reading Type

• Order. This field is enabled for a Cumulative reading type tag only.

• Reset Value. This field is enabled for a Cumulative reading type tag only.

• Initial Value. This field is enabled for a Cumulative reading type tag only.

• Reading Interval. This field is enabled for Incremental reading type tag of a 
Sustainability type tag data source.

3. Click Save.

Mapping Tags to Equipment
Oracle Manufacturing Operations Center enables you to map tags to equipment using 
the Tag Mapping page. You map a separate tag for each equipment output. 

To map tags to equipment:
1. Navigate to the Tag Mapping page.

2. Select the Site Name. All the Sites defined in the MOC application display in the list
of values (LOV).

3. Select Equipment Name of the equipment to which you want to map tags.

4. Click Go. If tags are already mapped to the selected equipment, then they display.

5. Click Add to map a tag.

6. Enter the Tag Code that you want to map to the equipment. All the tags in the Tag 
Master display in the LOV. This is a required field.
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7. Optionally, enter a Data Element for the tag. 

8. Optionally, enter Attribute Group Name and Attribute Name. You can choose from 
a list of attribute groups and attributes that you define using the Extensible 
Attributes page as part of setting up the MOC application. Refer to the topic "
Setting Up Extensible Attributes" chapter of the Oracle Manufacturing Operations 
Implementation Guide for more information.

9. Click Submit.

Note: You can associate a tag to either to an entity or an attribute 
belonging to an attribute group. MOC does not allow an 
association to both an entity and attribute.

Running the MTH: Process and Populate MOC Entity Sustainability Aspect
Run the MTH: Process and Populate MOC Entity Sustainability Aspect to calculate the 
carbon emission and electricity usage costs for an entity. When you run the concurrent 
program the data obtained from the meter readings is processed to calculate the 
sustainability aspect consumed, the cost of and the carbon emission due to the 
consumption. 

To run the MTH: Process and Populate MOC Entity Sustainability Aspect
1. Navigate to the Parameters window.

2. Enter the Process Mode as:

• INIT to run the process in Initial mode.
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• INCR to run the process in Incremental mode.

3. Enter the Meter Calculation Start Date. 

4. Click Submit.

5. Note the Request ID number.

6. Choose View from the menu and select Requests to view the status of your request 
in the concurrent program manager. 

7. When your request ID is complete with a Status of Normal, click View Details to 
view the details of the run.

Creating Equipment Contextualization Information
Contextualization is the ability to take highly granular tag data collected from shop 
floor transactions and convert it into meaningful business data for analyzing. The 
contextualization rules engine enables users with various levels of sophistication on the 
shop floor to add the business context to the data tags. There are two tag types used:

• Business Context Tags–tags that provide work order, operation, product, and 
equipment details.

• Data Tags–tags that provide value of output quantity, scrap quantity, rework 
quantity, reject quantity, completed quantity, equipment status, and attribute tags.

The Equipment Contextualization page is used to associate a contextualization method 
for equipment and to define the mandatory or optional context for the business related 
to that equipment. The following three methods are used to add the business context:

Tag Based Contextualization

Business context such as work order, operation, and item is derived from the tags that 
are configured in the PLC for that equipment from the shop floor. The business context 
tags and the data tags are received into MOC with using the same group identifier for 
this type of contextualization.

Schedule Based Contextualization

Business context is derived from the equipment production schedule. If this 
contextualization method is selected, MOC uses the data tags from the equipment to 
select business context of:

• Work order and operation from the equipment production schedule

• Product from production material produced 

• Equipment based on the setup of the tag to equipment association is done 



3-8    Oracle Manufacturing Operations Center User's Guide

• Shift based on the reading time

Manual Contextualization

Context is determined through data entered manually and is not derived from the 
Manufacturing Operations Center hub. The Manual Contextualization page on the Tag 
Data Workbench under the User role enables you to manually enter and edit context for
all active tags that have not been summarized in the Equipment Summary tables.

To select equipment for contextualization:
1. Navigate to the Equipment Contextualization Setup page.

2. Select a value in the Plant field.

3. In the Equipment field, select a specific record and then select Go. You can also 
leave the field null and select Go to display all the equipment records for the plant.

The results table displays all the equipment associated to this plant record.

4. To edit equipment contextualization values, select equipment records and select a 
Contextualization Method. Choices are:

• Tag Based—context is determined through tag readings of the equipment. 

• Schedule Based—context is determined through schedule data in the 
Equipment Production Schedules table.

• Manual—context is determined through data entered manually.

5. In the Workorder field, indicate whether a business context is Mandatory or 
Optional for the selected equipment.

Workorder context is determined from either the tag or the equipment production 
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schedule. 

6. In the Workorder Segment field, indicate whether a business context is Mandatory 
or Optional for the selected equipment.

7. In the Item field, indicate whether a business context is Mandatory or Optional for 
the selected equipment. 

8. Save your work. 

To change multiple records using the same contextualization rule:
1. Select equipment records to create similar contextualization rules.

2. Select Enter Context in Batch to display the Batch Equipment Contextualization 
Update page.

3. Select the appropriate values in the following fields for the batch update:

• Contextualization Method

• Workorder

• Workorder Segment

• Item

4. Select OK to return to the Equipment Contextualization Setup page. 

5. Save your work to create the batch update for the selected records. 

Related Topics
Setting Up Tags, page 3-2

Adding Reason Codes
You can use tags to display reasons for downtime status and scrap quantity. You can 
define a list of all reason codes and reason meanings for Manufacturing Operations 
Center (MOC) plants, at the Instance level in FND_LOOKUPS, and equipment level in 
the Equipment Reason Setup user interface. In the Tag Mapping setup for the reason 



3-10    Oracle Manufacturing Operations Center User's Guide

tag, map the tag to a data element (Equipment Downtime Reason and Scrap Reason).

You can set up Reason Codes using FND Lookup. Lookup types seeded by 
Manufacturing Operations Center include:

• MTH_SCRAP_REASON (for setting up scrap reasons)

• MTH_EQUIP_DOWNTIME_REASON (for setting up downtime reason)

• MTH_EQUIP_IDLE_REASON (for setting up idle time reason)

• MTH_MESSAGE_DOMAIN_NAME (for setting up domain name for mobile alert 
messages)

When you enter the lookup_code, meaning, and description for 
MTH_MESSAGE_DOMAIN_NAME, the text in the description field should be 
prefixed with an @ symbol. For example:

LOOKUP_CODE Meaning Description

ASCENDQUICK ascendquick.com @ascendquick.com

Add reason codes in the Application Object Library Lookups window from the 
Development Manager responsibility. You can also set up reason codes using the 
Lookups menu from the MOC Administrator's responsibility.

To add reason codes:
1. Navigate to the Application Object Library Lookups window.

2. In the Type field, query by example MTH_SCRAP_REASON, 
MTH_EQUIP_DOWNTIME_REASON, or MTH_EQUIP_IDLE_REASON. The 
window displays all Reason Codes associated with these types.
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3. Click a new (empty) row to add a new code.

4. Enter a Code.

5. Enter a Meaning for the code.

6. Enter an optional Description.

7. Enter an Effective date range. The From date defaults to the current date.

8. The Enabled indicator defaults to Enabled.

9. Save your work.

Related Topics
Viewing and Adding Reason Codes, page 4-4

Setting Up Equipment Reason Codes
You must add equipment reason codes prior to adding events. Reason codes define the 
Equipment Down event types with associated reasons.

Equipment can be down and unavailable due to planned preventive maintenance 
activities. MOC updates the equipment shift for each equipment item, taking into 
account planned downtime.

MOC captures the expected uptime for each equipment item when the equipment is 
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down due to unplanned downtime, or when equipment is idle. The application helps to
identify equipment availability for production.

To set up equipment reason codes:
1. Navigate to the Equipment Reason Code Setup page. Use the Equipment Reason 

Code Setup page to set up equipment downtime reason codes. You can define the 
following reasons for equipment:

• Downtime Reasons and Expected Uptime

• Idle Time Reasons and Expected Uptime

• Run Time Reasons

• Scrap Reasons

2. Select an Equipment Hierarchy from the List of Values (LOV).

3. Select a Level Name from the LOV.

4. Select a Level Instance.

5. You can optionally select an Equipment Criticality value from the LOV.

6. Click Go to perform your search. Based on the search criteria, the page displays the 
Level Instance and equipment for the selected Level in the Equipment Hierarchy.

7. Select one or more equipment rows and click the Update Sequentially button to 
navigate to the Update Equipment Reason Code Sequentially page. You can add 
Downtime reasons, Idle Time reason, and Scrap reasons for your equipment. You 
can also define Expected Uptime for each Downtime and Idle Time reason code.

To add or update equipment reason code sequentially:
1. From the Update Equipment Reason Code Sequentially page, select the Downtime 

tab to add or update equipment downtime reason codes and expected uptime.
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2. Enter a Downtime Reason Code, or select a code from the search page.

3. Enter a value for Expected Uptime (Hours).

4. Click the Next button to enter Downtime reasons for the next equipment item that 
you selected, or click Apply to save your work.

5. Select the Idle Time tab to enter equipment idle time reason and expected uptime.

6. Enter an idle time Reason Code, or select a code from the search page.

7. Enter a value for Expected Uptime (Hours).

8. Click the Next button to enter Idle Time reasons for the next equipment item that 
you selected, or click Apply to save your work.

9. Select the Scrap tab to enter equipment scrap reasons.
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10. Click Add to enter a new scrap reason.

11. Enter a Reason Code, or select a code from the search page.

12. Click the Next button to enter Scrap reasons for the next equipment item that you 
selected, or click Apply to save your work.

Setting Up Events
Oracle Manufacturing Operations Center (MOC) provides a workbench to generate and
process events based on event types. Based on the event type, action is taken by 
PL/SQL.

MOC supports collection of data from external OPC systems, and by using Event 
Management Framework, the application routes events and takes appropriate actions.

Update Equipment Event Action Sequentially Page

Use this page to add and update Event Types and Event Actions. You can also add 
notifications when events occur. You can add and update event types and actions for 
equipment items in order of selection from the Events Setup page. You can also view 
event actions previously added for equipment items (rows).

To set up events:
1. Navigate to the Event Setup page. Use the Event Setup page to set up event actions 

for event types. You can select the following actions against an event type by 
equipment items:

• Seeded action such as creating work requests in EAM

• Calling custom APIs or PL/SQL scripts

• Sending e-mail notifications

• Sending mobile alerts 
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2. Select an Equipment Hierarchy from the List of Values (LOV).

3. Select a Level Name from the LOV.

4. Select a Level Instance.

5. You can optionally select an Equipment Criticality value from the LOV.

6. Click the Go button to perform your search. Based on the search criteria, the page 
displays the Level Instance and equipment for the selected Level in the Equipment 
Hierarchy.

7. Select one or more equipment rows and click the Update Sequentially button to 
navigate to the Update Equipment Event Action Sequentially. You can add or 
update event actions for each equipment row selected.

To add or update equipment event actions:
1. From the Update Equipment Event Action Sequentially page, click the Add button 

in the Event Types region to add a new Event Type. If an event action was 
previously defined for an event type and you return to this page, then the earlier 
definition appears and you can modify the actions, if required.
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2. Select an Event Type from the LOV.

3. Select a Reason Code from the LOV (if applicable.) The Reason Code LOV is 
enabled only for the Equipment Down event type.

4. Click the Add button to add Event Types.

5. Select the Event Action tab. The Seeded Actions region appears.

6. Click the Add button to add a seeded event action.

7. Select a seeded Event Action from the LOV.

8. Select the Name and the appropriate indicators for the notification method.

9. Click the Add button in the Custom Actions region to add custom event actions

10. Select the Notification tab to add event notifications.
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11. Click the Add button to add new notifications.

12. Enter notification details for the selected event.

13. Click Finish to save your work.

14. Click the Next button to add event actions for the next equipment item that you 
selected, or click Finish to save your work.

Setting Up Extensible Attributes for MOC Entities
Oracle Manufacturing Operations Center supports an extensible attributes framework 
to capture specific attributes for manufacturing entities. The extensible attributes 
framework helps in setting up and capturing parameters that are unique for your 
business environment, plant, equipment, items, work orders, batch operations and 
user-defined entities. The extensible attributes setup consists of the following steps:

• Setting up profile options for item and equipment entity classifications

• Defining classifications for Others entity type

• Creating attribute groups

• Creating attributes

• Associating attribute groups to classifications

• Creating attribute pages

Entities and Classifications
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Shop floor or manufacturing entities are business objects in Oracle Applications with 
unique characteristics and processes. MOC supports item, equipment, work order, 
batch operation, and miscellaneous custom entities. 

Entities are grouped into classification to define the type of attributes they can monitor. 
For example, boiler equipment in the shop floor are classified into one group which is 
the resource Boiler. You can define this classification using attribute metadata such as 
Pressure, Temperature, and so forth. Each MOC entity type page contains two tabbed 
regions: Classifications and Attributes. Entity pages open with all the classification 
values displaying in the search results table region. You can filter this list.

Classifications are defined based on the hierarchy of the entities. The hierarchy level is 
determined by the information in the following table:

Entity Classification Source 
Creation

Values

Item: Profile Option–MTH:Item 
Classification for Extensible 
Attributes

Hierarchy Name. The level is 
always Level 9 for the 
hierarchy selected.

Equipment: Profile Option–
MTH:Equipment 
Classification for Extensible 
Attributes

Hierarchy Levels.

Work Order: Work order type Discrete or Process 
Manufacturing work order 
types only.

Other:. No classification N/A

Batch Operations Work order Work Order Number

Attributes and Attribute Groups

Attribute groups are a grouping of similar attributes used to monitor an entity. For 
example, Specifications is a seeded attribute group for the Equipment entity containing 
the attributes Parameter, Upper Control Limit, and Lower Control Limit. Oracle 
Product Information Management functionality is used for attribute creation. 

Similar attributes can be categorized in an attribute group, such as a collection of items 
similar in type or function. You can:

• Group attributes based on business functions

• Define and use an unlimited number of attribute groups 
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• Create attribute pages for ease of viewing attributes

Attribute Pages

An attribute page is a view used to display, create, and edit different attributes from the
various attribute group categories. An attribute page is a way of categorizing attribute 
groups and displaying them separately in these categories based on different functional 
areas. You can create attribute pages for each item, equipment, work order, batch 
operation, user-defined entity and other values of your entities—and assign 
corresponding attribute groups to these pages.

Refer to the Oracle Manufacturing Operations Center Implementation Guide for more 
information.

Related Topics
Viewing Classifications for Shop Floor Entities, page 3-43

Viewing and Creating Attribute Group Data for Entities, page 3-45

Viewing and Creating Attribute Pages for Entities, page 3-47

Setting Up E-Business Suite to run the Inbound Integrations for Discrete 
Flow

Manufacturing Operations Center (MOC) inbound integration is designed to work with
E-Business Suite (EBS) and non-EBS target systems. The inbound integration with 
Oracle E-Business suite includes and enhances the collection of equipment entities and 
reference data, such as production segments, sub-segments, and resource schedules. 
This integration reduces the entity creation effort within MOC and also helps to 
reconcile data with Oracle EBS.

With MOC inbound integration, master and reference data collection from EBS into 
MOC is enhanced to collect resource instance, operation, and activity data so that there 
is no reconciliation issue of the references used in MOC and EBS for this integration.

MOC also collects the output and usage data from shop floor. On a demand basis, this 
data is consolidated to perform operation move, work order completion, and scrap and 
resource transactions. This data is pushed to the interface table for non-EBS 
consumption and targets the EBS interface table for EBS transactions.

To set up and collect inventory organizations from Oracle EBS:
Prerequisites

• Set up MOC Locations under the source organizations.

• For outbound integration, set flag PROJECT_REFERENCE_ENABLED = 2.
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1. Navigate to the Organizations window:

Manufacturing and Distribution Manager > Inventory > Setup > Organizations > 
Organizations

2. Select an organization in the Name field.

3. Enter a location in the Location field.

4. Enter address details in the Address field.

5. In the Organizations Classification region, enter Inventory Organization.

6. Select the corresponding Enabled check box.

7. Save the record.

8. Select the Others button.

The Additional Organization Information window opens.

9. Select Accounting Information.

10. Click OK.

11. In the Accounting Information window, select the appropriate record in the 
Primary Ledger, Legal Entity, and Operating Unit fields.

12. Click OK, and save the record.

13. Click the Others button.

The Organization Parameters window opens.

14. Select a workday calendar.

15. Optionally, select the EAM Enabled check box if you want this location to be 
associated to the EAM organization.

16. Click Costing Information tab.

17. Enter costing details in the mandatory fields.

18. Save and close the window.

For more information on setting up parameters, see: Defining Default Inventory 
Parameters, Oracle Inventory User's Guide.

19. Navigate to MTH Project > MTH Setup > MTH Systems to run the Oracle Data 
Integrator (ODI) package for the organization setup.
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20. Run the ODI package MTH_PKG_ORGANIZATIONS_SRC

To create the site in MOC and map the organization to that site:
1. Navigate to the Sites Summary window.

2. Select the Add button.

The Add Site window opens.

3. Enter a site code in the Site Code field.

4. Enter a site name in the Site Name field.

5. Click the Add button in the Data Sources region.

6. Select a system code from the System Code LOV.

7. Select the source organization from the Source Organization LOV.

8. Click the Save & Close button.

To create a department:
1. Navigate to the Departments window:

Manufacturing and Distribution Manager > Bills of Material > Routings > 
Departments

2. Select an organization in the Organization window.

3. Enter a department in the Department field of the Departments window.

4. Save and Close the window.

For detailed information on creating departments, see: Defining a Department, 
Oracle Bills of Material User's Guide.

To create a resource group:
1. Navigate to the CRP RESOURCE GROUPS Lookups window:

Manufacturing and Distribution Manager > Bills of Material > Setup > Resource 
Groups

The Application Utilities: CRP RESOURCE GROUPS Lookups window opens.

2. Click New from the File menu.

3. Enter the organization code in the Code field.
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4. Enter the meaning of the code in the Meaning field.

5. Enter a description in the Description field.

6. Save and close the window.

See: Defining Resource Groups, Oracle Capacity User's Guide.

7. Navigate to MTH Project > MTH Setup > MTH Equipment Hierarchy.

8. Run the ODI package MTH_PKG_EQUIPMENT_ENTITIES_SRC.

To define a resource and attach the resource to the department:
1. Navigate to the Resources window:

Manufacturing and Distribution Manager > Bills of Material > Routings > Resources

2. Enter the resource, description, type, charge type details in the Resources window.

3. Save the record.

4. Click the Equipment button.

The Equipment Types window opens.

5. Enter the equipment name in the Equipment field.

6. Save and close the window.

7. Navigate to the Departments window.

8. Query the department you want to attach to the resource.

9. Select the Resources button.

10. Query the resource that you created and assign it to the department.

See: Defining a Resource, Oracle Bills of Material User's Guide.

Defining a Department, Oracle Bills of Material User's Guide.

11. Navigate to MTH Project > MTH Setup > MTH Resources.

12. Run the ODI package MTH_PKG_RESOURCES _SRC.

To create resource costs:
1. Navigate to the Resources window.
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2. Query for the resource you created and select the Costed check box. This enables 
the Absorption Account field.

3. Select the Standard Rate check box.

4. Enter Absorption Account and Variance Account details in the respective fields.

5. Click the Rates button.

The Resource Costs window opens.

6. Enter the cost type as Frozen or Pending.

7. Enter the Resource Unit Cost.

8. Save and close the window.

See: Defining a Resource, Oracle Bills of Material User's Guide.

9. Navigate to MTH Project > MTH Setup > MTH Resources.

10. Run the ODI package MTH_PKG_RESOURCE_COST_SRC.

To collect resource instances, such as an equipment:
Note: Resource instances are collected as equipment entities and they 
are of type Machine in MOC.

Prerequisite

Create items of type Equipment and then generate a serial number for the equipment 
items.

1. Create items.

See: Defining Items, Oracle Inventory User's Guide.

2. Define equipment items.

See: Define Equipment Items, Oracle Warehouse Management Implementation Guide.

3. Generate serial number for the item.

See: Setting Up Serial Number Control, Oracle Inventory User's Guide.

4. Run the ODI package MTH_PKG_EQUIPMENTS_SRC 001.

To collect department and resource group hierarchies:
1. Associate the department or resource groups with resources and equipment.
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2. Map the serial number with resource instances by setting up the hierarchy between 
equipment entities and resources and equipments.

3. Assign the resources to the department.

See: To define a resource and attach the resource to the department, page 3-19.

4. Run the ODI package MTH_PKG_EQUIPMENT_HIERARCHY_SRC.

5. Review the equipment hierarchy and the equipment denorm tables.

To collect the inventory items with BOM and routing setup:
1. Create an item and assign it to your organization.

See: Defining Items, Oracle Inventory User's Guide.

2. Navigate to MTH Project > MTH Setup > MTH Items.

3. Run the ODI package MTH_PKG_ITEMS_SRC.

To set up and collect item categories from EBS:
Prerequisite

Update MTH_DIM_HIERARCHY table with the CATEGORY_SET_NAME column.

1. Create an item category and assign it to an existing item.

See: Defining Categories, Oracle Inventory User's Guide.

2. Navigate to MTH Project > MTH Setup > MTH Items.

3. Run the ODI package MTH_PKG_ITEM_CATEGORIES_SRC.

4. Search for the new item category in the MTH_ITEM_CATEGORIES_D table.

To set up and collect the item costs from EBS:
1. Define cost type for the item.

See: Define Your Cost Types, Oracle Inventory User's Guide.

Defining Cost Types, Oracle Cost Management User's Guide.

2. Navigate to MTH Project > MTH Setup > MTH Items.

3. Run the ODI package MTH_PKG_ITEM_COST_SRC.

4. Search for the cost details in the MTH_ITEM_COST table.
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To set up and collect item hierarchy and item denorm from EBS:
1. Navigate to MTH Project > MTH Setup > MTH Items.

2. Run the ODI package MTH_PKG_ITEM_HIERARCHY_SRC.

3. Validate the item hierarchy created for the created items, item categories in the 
MTH_ITEM_HIERARCHY table.

4. Search for the new records in the item Denorm table, MTH_ITEM_DENORM_D.

To collect the work orders:
1. Create a discrete job.

See: Defining Discrete Jobs Manually, Oracle Work in Process User's Guide.

2. Navigate to MTH Project > MTH Transactions > MTH Production Schedules.

3. Run the ODI package MTH_PKG_PRODUCTION_SCHEDULES_SRC.

4. Search for the discrete job in the MTH_PRODUCTION_SCHEDULES_F table.

To set up and collect work order associated with sales order reservations 
from EBS:
1. Create a sales order.

See: Defining Sales Order Main and Other Header Information, Oracle Order 
Management User's Guide.

2. Attach the sales order to a WIP job.

See: Creating Reservations, Oracle Inventory User's Guide.

3. Navigate to MTH Project > MTH Transactions > MTH Sales Orders.

4. Run the ODI package MTH_PKG_WORKORDER_RESERVATION_SRC.

5. Search for the created sales order in the MTH_WO_SALES_ORDERS_F table.

Note: You can also update and delete the work order associated 
with sales order reservations.

To collect the work order segments:
1. Query the discrete job.
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See: Finding Discrete Jobs, Oracle Work in Process User's Guide.

2. Select the Operations button to review the operation details.

3. Run the ODI package to collect production segments.

4. Review the data in the MTH_PRODUCTION_SEGMENTS_F table.

To collect the work day shifts:
Prerequisites

Set the profile MTH: Shifts Setup as External Source.

Create a workday calendar and assign it to Inventory organization.

1. Create a workday calendar.

See: Using the Workday Calendar, Oracle Bills of Material User's Guide.

2. Update the calendar value in the Organizations Parameters window.

3. Navigate to MTH Project > MTH Setup > MTH Workday Shifts.

4. Run the ODI package MTH_PKG_WORKDAY_SHIFTS_SRC.

5. Search for the workday shifts in the MTH_WORKDAY_SHIFTS_D table.

To collect the equipment shifts:
Prerequisite

Work day shifts must be collected for the plant.

1. Navigate to MTH Project > MTH Setup > MTH Workday Shifts.

2. Run the ODI package MTH_PKG_EQUIPMENT_SHIFTS_SRC.

3. Search for the shifts in the MTH_EQUIPMENT_SHIFTS_D table with entity type as 
Site and Equipment as two different entities.

To set up and collect resource requirements or resource usage from EBS:
Prerequisite

You should have already collected work order and work order segment.

1. Query the discrete job.

See: Finding Discrete Jobs, Oracle Work in Process User's Guide.

2. Run the ODI package to view the data collected in 
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MTH_RESOURCE_REQUIREMENTS_F table.

To set up and collect material requirements and material consumed from 
EBS:
Prerequisite

You should have already collected work order and work order segment.

1. Query the discrete job.

See: Finding Discrete Jobs, Oracle Work in Process User's Guide.

2. Review the required quantities in the Material Requirement window by selecting 
the Components button.

3. Run the ODI package to view the data collected in 
MTH_PROD_MTL_CONSUMED_F table.

To set up and collect equipment schedule and resource instance schedule
from EBS:
Prerequisites

Collect work day shifts and equipment shifts to collect the equipment production 
schedules.

Collect work orders and work order segments.

1. Update the discrete job.

See: Adding and Updating Operations, Oracle Work in Process User's Guide.

2. Update the date in the Resource Requirements window.

See: Viewing Job and Schedule Operations, Oracle Work in Process User's Guide.

3. Select the Instance button to add the instances and save the record.

4. Run the ODI package to view the data collected in 
MTH_EQUIP_PROD_SCHEDULES_F table.

Setting Up E-Business Suite to run the Outbound Integrations for Discrete 
Flows

MOC outbound integration is designed to work with EBS and non-EBS target systems. 
MOC's outbound integration with ERP Systems enables you to automate the process of 
updating the enterprise and transaction system data with operational data captured 
from shop floor with minimal or no latency. The equipment transaction data such as 
status and output are collected from Shop floor, processed within MOC and then 
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interfaced to Oracle EBS as Oracle WIP transactions.

The outbound integration's primary objective is to avoid the redundant effort of having 
to enter the transaction and reference data back into the enterprise and transaction 
systems. It also provides close integration with Oracle E-Business suite for Discrete 
Shop Floor Management and Flow Manufacturing applications.

Master and Reference data collection from EBS into MOC is enhanced to collect 
resource instances, operation and activity references so that there is no reconciliation 
issue of the references used in MOC and EBS for this integration.

MOC also collects the output and usage data from shop floor. The data is consolidated 
on a demand basis to perform the operation move, work order completion, scrap, and 
resource transactions. The data is pushed to the interface table for non-EBS 
consumption and then targets the EBS interface table for EBS transactions.

Prerequisites
❒ Export details profile should be set as Yes to collect the outbound integration data.

To set up tags in MOC for outbound integration after collecting inbound 
data:
Create the tags and set up the tag mapping in MOC. See: Setting Up Tags, page 3-2

The types of tags required include:

• Output

• Status

• Item

• Work Order

• Work Order Segment

Note: Set up tags separately for equipment associated with each 
segment of the work order. Tag data should be populated for the first 
part of the ITEM_PK (item tag). The work order tag is the first part of 
the WorkOrder_PK. The work order segment tag is the first part of the 
WOSegment_PK.

To set up the tag based contextualization for the equipment collected from
EBS:

Note: Set up the tags separately for equipment associated with each 
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segment of the work order.

• Set up equipment contextualization.

See: Creating Equipment Contextualization Information, page 3-7.

To launch the interface managers:
1. Launch a transaction manager from the list.

See: To launch a transaction manager, Oracle Inventory User's Guide.

2. Select the Schedule button in the Launch Inventory Managers window.

The Schedule window opens.

3. Enter the Start At and End At dates.

4. Enter the time in Re-run every field.

5. Click OK.

6. Repeat the steps for Material Transaction and Move Transaction in the Interface 
Managers window.

Setting Up Inbound Data Collection for Oracle Process Manufacturing 
(OPM)

Set Up and Collect the Organization Information:
Prerequisites

• Set up MOC Locations under the source organization.

• Ensure that system_pk is the same as source system SID as defined in 
MTH_SOURCE_LOCATION.

• Set up Yield Subinventory and Yield Locator parameters for the outbound 
collection in OPM organization.

1. Set up the organization.

See: Setting Up E-Business Suite to run the Inbound Integrations for Discrete Flow, 
page 3-19.

Note: In the Inventory Parameters tab of the Organization 
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Parameters window, select Process Manufacturing Enabled check 
box for process manufacturing organization in the Enabled 
Products & Features region.

2. Create the site in MOC and map the organization to that site.

See: Setting Up E-Business Suite to run the Inbound Integrations for Discrete Flow, 
page 3-19.

Collect Resource Class and Resource Category:
Note: In OPM flow, Resource Class is same as the Resource Group and 
Resource Category is same as the Department of MOC. Hence, 
Resource Category and Resource Class are collected into MOC as 
Department and Resource Group, respectively.

To create resource class
1. Navigate to the Resource Classes window.

OPM Process Planning > Capacity Planning > Setup > Resource Classes

2. Enter the name of the resource class.

3. Save the record.

To create a generic resource
1. Navigate to the Resources window.

OPM Process Engineer > Setup > Generic Resources

2. Enter a resource name in the Resource field.

3. Enter a description for the resource.

4. Enter the unit of measure in the Usage UOM field.

5. Enter a component class in the Cost Component Class field.

6. Clear the Capacity region fields.

7. Save and close the window.

To create a resource category and plant resource
1. Navigate to the Resource Information window.
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Process Engineer > Setup > Plant Resources

2. Query the resource that you created in the Resources window.

3. Enter the count number.

4. Enter the planning cost number.

5. Select a value from the Schedule Indicator LOV.

6. Enter the Usage UOM value.

7. Enter the capacity range values in the Range and To fields.

8. Enter the Ideal Capacity value.

9. Select the Capacity UOM value from the LOV.

10. Save the record.

Collect Resources:
Note: Resources of type Machine and Person are only collected, for 
which Resource Class should be Machine for machine type resource 
and Labor for person type resource. The resources must be attached to 
a department.

1. Create a generic resource in the Resources window.

Note: Create records with Machine and Labor in Resource Class 
field.

2. Create a plant resource by navigating to the Resource Information window.

See: To create a resource category and plant resource, page 3-29.

3. Run the ODI Package MTH_PKG_RESOURCES_SRC.

Collect Resource Instances:
Prerequisite

Create items of type Equipment and then generate a serial number for the equipment 
items.

See: Setting Up E-Business Suite to run the Inbound Integrations for Discrete Flow, page
3-19.
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1. Navigate to the Resource Information window.

2. Query the resource created.

3. Click the Equipments button.

The Resource Equipments window opens.

4. Enter the Equipment Item.

5. Save the record.

6. Select Scheduling to Instance from the Schedule Indicator LOV.

The Instances button is now enabled.

7. Click the Instances button.

8. Enter the Start Date. This defaults to the system date.

9. Enter the End Date.

10. Click the Accept button.

The Resource Instances window opens.

11. Enter the Serial Number, Equipment Item, and Equip Serial Number in the 
respective fields.

12. Save and close the window.

13. Run the ODI package MTH_PKG_EQUIPMENTS_SRC.

14. Query the created records in the MTH_RESOURCES_D and 
MTH_EQUIPMENTS_D tables.

Set Up Hierarchy between Equipment Entities and Resources and 
Equipments:

Note: When the entities, resources and resource instances are set up, 
the hierarchies between equipment entities and resources and 
equipments are simultaneously set up. 

1. Run the ODI package MTH_PKG_EQUIPMENT_HIERARCHY_SRC.

2. Query the equipment hierarchy and equipment denorm tables for the collected 
hierarchies.
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Collect Inventory Items from EBS:
Note: Items are collected if INVENTORY_ITEM_FLAG = Y, 
MTL_TRANSACTIONS_ENABLED_FLAG = Y, 
STOCK_ENABLED_FLAG = Y

To set up formula
1. Navigate to the Formula Details window.

Formulator > Formulas

2. Enter the Formula name.

3. Enter a version for the formula.

4. Enter a description in the Description field.

5. Enter product details.

6. Select the Ingredients tab.

7. Enter the ingredient.

8. Enter quantity in the Quantity field.

9. Enter all the mandatory information for the product line.

10. Save the record.

11. Select Change Status option from the Actions menu.

The Change Status window opens.

12. Change the status to Approved for General Use.

13. Click OK.

See: Setting Up Formula Information, Oracle Process Manufacturing Product 
Development User's Guide.

To set up process operations
1. Navigate to the Process Operation Details:Activities window.

Process Engineer > Process Operations

2. Enter the operation name, version, description, and the process quantity in the 
respective fields.
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3. Enter the activity details in the Activities region.

4. Click the Resources button.

The Process Operation window for the activity opens.

5. Select the resource from the Resource LOV.

6. Enter the Process Quantity and the Usage details.

7. Save the record.

8. Select Change Status option from the Actions menu.

The Change Status window opens.

9. Change the status to Approved for General Use.

10. Click OK.

To set up routing
1. Navigate to the Process Routing Details window.

Process Engineer > Process Routings

2. Enter a routing name.

3. Enter a description for the routing.

4. Enter the quantity in the Quantity field.

5. Select the unit of measure in the UOM LOV.

6. In the Routing Steps region, enter the operation step.

7. Enter the name of the operation, and the version for each routing step.

8. Save the record.

9. Select Change Status from the Actions menu.

The Change Status window opens.

10. Change the status to Approved for General User.

11. Click OK.

To set up recipe
1. Navigate to the Recipe Details window.
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Process Engineer > Recipes

2. Enter a recipe name, its version, and description.

3. Enter a product name, formula, and the version.

4. Enter a routing and its version.

5. Select a unit of measure from the UOM LOV.

6. Save the record.

7. Click the Step/Material Association button.

The Recipe: Step/Material Association window opens.

8. Select an operation step from the Step LOV.

9. Select a line from the Line LOV.

10. Save the record.

11. Select Change Status from the Actions menu.

The Change Status window opens.

12. Change the status to Approved for General Use.

13. Click OK.

To set up validity rules
1. Navigate to the Recipe Details window.

2. Query the recipe that you created.

Ensure that the status of the recipe is Approved for General Use.

3. Click the Validity Rules button.

The Recipe: Validity Rule Details window opens.

4. Enter the Organization name.

5. Check the effective start date, unit of measure, and the product details.

6. Save the record.

7. Select Change Status from the Actions menu.

The Change Status window opens.
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8. Change the status to Approved for General Use.

9. Click OK.

To collect the EBS inventory items
1. Create an item and assign it to your organization.

Note: Enable the Recipe Enabled and Process Execution Enabled 
check boxes in the Process Manufacturing tab of the Master Items 
window.

See: Defining Items, Oracle Inventory User's Guide.

2. Navigate to MTH Project > MTH Setup > MTH Items.

3. Run the ODI package MTH_PKG_ITEMS_SRC.

4. Query the item in the MTH_ITEMS_D table.

Set Up and Collect Item Categories from EBS:
Prerequisite

Update MTH_DIM_HIERARCHY table with the Category_set_name column.

1. Create an item category.

See: Defining Categories, Oracle Inventory User's Guide.

2. Navigate to MTH Project > MTH Setup > MTH Items.

3. Run the ODI package MTH_PKG_ITEM_CATEGORIES_SRC.

4. Search for the new item category in the MTH_ITEM_CATEGORIES_D table.

Set Up and Collect the Item Hierarchy and Item Denorm from EBS:
1. Navigate to MTH Project > MTH Setup > MTH Items.

2. Run the ODI package MTH_PKG_ITEM_HIERARCHY_SRC.

3. Validate the item hierarchy created for the items and item categories in 
MTH_ITEM_HIERARCHY table.

4. Search for the records in the MTH_ITEM_DENORM_D table.
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Collect the Production Batches:
Prerequisites

• Create items with recipe and formula information.

• Batch information such as resources, equipment hierarchies, and items should have 
already been collected.

• Sufficient on-hand stock of components and ingredients must be available before 
executing work orders or batches.

• OPM batch and batch steps should be in WIP released status.

To create batch details
1. Navigate to the Create Batch/Firm Planned Order window.

Production Supervisor > Batch Details

2. Select the organization.

Note: The organization much be Process Manufacturing Enabled.

The Find Batches window opens.

3. Click the New button.

The Create Batch/Firm Planned Order window opens.

4. Select a recipe from the Recipe LOV and the version of the recipe from the Version 
LOV.

5. Select the Product Output tab.

6. Select a product from the Product LOV.

7. Enter the product quantity and the unit of measure.

8. Click OK.

The Batch Details window opens listing the new production batch with status as 
Pending.

9. Select the Release option in the Actions menu.

The Release Batch dialog box opens.

10. Click OK.
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11. Navigate to Batch Steps window.

Production Supervisor > Batch Steps

12. Select a step.

13. Select the Release Step option in the Actions menu. Optionally, you can also 
complete the batch from the Actions menu.

14. Navigate to MTH Project > MTH Transactions > MTH Production Schedules

15. Run the ODI package MTH_PKG_PRODUCTION_SCHEDULES_SRC.

16. Query the record in the MTH_PRODUCTION_SCHEDULES_F table.

Set Up and Collect Production Batches associated with Sales Order 
reservations from EBS:

Note: Only those sales orders associated with an OPM batch are 
collected. Any modification done to the reservation in EBS will 
automatically update the record in MOC.

To create an OPM batch associated with sales order reservation
1. Create a sales order of Order Type Standard(Process).

See: Defining Sales Order Main and Other Header Information, Oracle Order 
Management User's Guide.

2. Attach the sales order to an OPM batch.

1. Navigate to the Item Reservations window.

Inventory Super User (Process Operations) > On-hand, Availability > 
Reservations.

The Item Reservations window opens.

2. Create a sales order with the Demand Source Type as Sales Order and the 
Supply Type as Job or Schedule (Process Batch). 

See: Creating Reservations, Oracle Inventory User's Guide.

3. Navigate to MTH Project > MTH Transactions > MTH Sales Orders.

4. Run the ODI package MTH_PKG_WORKORDER_RESERVATION_SRC.

5. Search for the created sales order in the MTH_WO_SALES_ORDERS_F table.
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Note: You can also update and delete work orders associated with 
sales order reservations.

Collect the Production Batch Segments:
Prerequisites

• Set up process operations for recipe.

• Production batches should have already been collected.

1. Navigate to the Batch Details window.

Production Supervisor > Batch Details

The Batch Details window opens.

2. Query the batch that you created.

3. Select the Steps button.

The Batch Steps window opens.

4. Review the batch step and operation details.

5. Run the ODI package MTH_PKG_PRODUCTION_SEGMENTS_SRC to collect the 
production segments.

6. Review the data in the MTH_PRODUCTION_SEGMENTS_F table.

Collect the Production Batch Sub-segments:
Prerequisites

• Set up process operations for the recipe for which the batch is created.

• Associate activities (sub-segments) with each operation (batch steps).

• Batch and batch segments should have already been collected.

1. Navigate to the Batch Steps window.

Production Supervisor > Batch Details > Steps (Button)

2. Select the Activities button.

The Step Activities window opens.

3. Review the batch step activities.
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4. Run the ODI package MTH_PKG_PRODUCTION_SUB_SEGMENTS_SRC to collect
the production sub-segments.

5. Review the data collected in the MTH_PROD_SUB_SEGMENTS_F table.

Create Workday Shifts from UI:
Prerequisites

• Set up the profile option MTH: Shifts Setup as MOC.

• Your plant should have been created and mapped to the OPM organization.

1. Navigate to the Sites Summary window.

The Sites Summary window opens.

2. Select the Entity Shift Setup tab.

The Entity Shift Setup window opens.

3. Select the plant for which process manufacturing is set up from the Site LOV.

4. Enter the Start Date and the End Date.

5. Select the Generate button.

6. Choose Yes in the Confirmation window.

Create Equipment Shifts from UI:
Prerequisites

• Set up the profile option MTH: Shifts Setup as MOC.

• Your plant should have been created and mapped to the OPM organization.

• Resources and equipments (resource instances) must have been created and 
collected in MOC for the OPM organization.

Create workday shifts from UI.

Note: Generating workday shifts for the plant will automatically 
generate the shifts for all its child entities in that plant.

Set Up and Collect Resource Requirements or Resource Usage from EBS:
Prerequisites
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• Set up process operations for the recipe for which the batch is created.

• Associate activities with each operation.

• Batch, batch segments, and batch sub-segments should have already been collected.

1. Navigate to the Step Resources window.

Production Supervisor > Batch Details > Steps (B) > Batch Steps > Activities (B) > 
Step Activities > Resources (B)

The Step Resources window opens.

2. Review the resource details.

3. Run the ODI package MTH_PKG_RESOURCE_REQUIREMENTS_SRC to collect 
the resource requirements.

4. Review the data collected in the MTH_RESOURCE_REQUIREMENTS table.

Set Up and Collect Material Requirements or Materials Consumed from 
EBS:
Prerequisites

• Set up Step/Material Association for the recipe for which the batch is created.

• Associate ingredients and final product with the operation steps.

• Batch, batch segments, and batch sub-segments should have already been collected.

1. Query the batch created in the Find Batches window.

2. Review the material requirements information in the Ingredients, Products, and 
By-Products tabs.

3. Run the ODI package MTH_PKG_MTL_CONSUMED_SRC to collect the material 
requirements.

4. Review the data in MTH_PROD_MTL_CONSUMED_F table.

Set Up and Collect Equipment Schedule or Resource Instance Schedule 
from EBS:
Prerequisites

• Workday shifts and equipment shifts must have been already collected.

• Production batch, batch segments, and batch sub-segments should have been 
already collected.
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• Planned_End_Date of a batch is determined based on the process operations and 
process routing set up of a recipe or product.

1. Query the batch already created.

2. Review the Plan Start Date and Plan Completion Date of each resource in the batch 
in the Step Resources window.

3. Run the ODI package MTH_PKG_EQUIPMENT_PROD_SCHEDULE_SRC to 
collect the equipment production schedules.

4. Review the data collected in the MTH_EQUIP_PROD_SCHEDULES_F table.

Note: Plan Start Date and Plan Completion Date of each resource in
the batch should be collected as Schedule_from_date and 
Schedule_to_date in the MTH_EQUIP_PROD_SCHEDULES_F 
table.

Setting Up Tags for Outbound Integration after Collecting Inbound Data for
OPM

Create Tags and Set Up the Tag Mapping in MOC
See: Setting Up Tags, page 3-2.

The types of tags required include:

• Output

• Status

• Item

• Work Order

• Work Order Segment

Note: Set up tags separately for equipment associated with each 
segment of the work order.

1. Tag data should be populated for the Status and Output tags along with the item, 
work order and work order segment as the three data elements are mandatory in 
the tag based contextualization.
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2. Value for the item tag should be populated in the first part of the ITEM_PK. 
Similarly, value for the work order tag should be populated in the first part of the 
WorkOrder_PK and value for the work order segment tag in the first part of the 
WOSegment_PK.

Set Up the Tag Based Contextualization for the Equipment Collected from EBS
• Set up equipment contextualization.

See: Creating Equipment Contextualization Information, page 3-7.

Viewing Classifications for Shop Floor Entities
Manufacturing Operation Center entities are grouped into classifications, and 
associated to attributes that define specific characteristics for items in your organization.
MOC supports item, equipment, work order, user-defined entities, batch operation, and
other miscellaneous entities:

• Equipment classifications can designate the machine or plant location where 
manufacturing activity is performed on the shop floor. 

• Item entity classifications can be group by categories such as product or line type, 
ABC classes, or cost structure.

• Other entity classifications are created on the Extensible Attributes Workbench per 
your requirements for miscellaneous categories in your organization.

• Work Order classifications designate Work in Process work order types, choices are 
discrete or process types. 

To view entity classifications:
1. Navigate to the specific Entity page. 

MOC provides Entity: Batch Operation, Entity: Equipment, Entity: Item, Entity: 
Others, Entity: User Defined and Entity: Work Order.

There are two tabbed regions: Classifications and Attributes. The page opens with 
all the classification values displaying in the search results table region. 
Classifications are created in several different areas depending on the entity type, 
see: Setting Up Extensible Attributes for MOC Entities, page 3-17

You can filter your list by entering a value in the Classification field and selecting 
Go.
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2. Select a value link in the Classification column to navigate to the Classifications 
Details page. 

This page displays the following values in the Basic Information and Other Details 
regions:

• Classification—name for this grouping

• Entity—type of entity

• Classification Code

This page enables you to navigate to associated attribute groups and attribute pages
for this item classification. 

To create and update Others entity classifications:
1. Navigate to the Entity: Others page. 

The page opens with all the Classification values displaying in the search results 
table region.

2. Select Create to create a new classification record. 
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3. On the Create Classification page— enter values in the Name and, optionally, 
Description fields.

4. Select Apply to save your work.

To update an Other entity classification record:
1. Navigate to the Update Classification page. 

2. Change the appropriate information in the Name and Description fields. 

3. Select Apply to save your work. 

Related Topics
Setting Up Extensible Attributes for MOC Entities, page 3-17

Viewing and Creating Attribute Group Data for Entities, page 3-45

Viewing and Creating Attribute Pages for Entities, page 3-47

Viewing and Creating Attribute Group Data for Entities
Manufacturing Operation Center Equipment entities are associated to attributes that 
capture specific characteristics for functional areas in your organization. Similar 
attributes can be categorized in an attribute group, and you can define an unlimited 
number of attribute groups that fit your business environment.

To view all attribute groups created for specific entities:
1. In the specific Entity page, select the Attributes tabbed region. 

This includes the Entity: Batch Operation, Entity: Equipment, Entity: Item, Entity: 
Others, Entity: User Defined, and Entity: Work Order pages.

All the existing attribute groups for the specific entity type selected appear in the 
results table. 

You can filter the display by using a combination of values and conditional 
qualifiers in the following fields: Attribute Group Display, Attribute Group 
Description, Attribute Group Descriptions, Behavior, Business Entity, Database 
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View, and Internal Name.

This page enables you to select:

• A record link in the Display Name column to navigate to the Attribute Group 
Details page

• Create to navigate to the Create Attribute Group for Equipments page

• Copy to create a new attribute group using information in an existing record

To view and add attribute groups to a shop floor entity:
1. On the specific Entity Classification Details page, select Attribute Groups to display 

the Attribute Groups for an entity page.

All attribute groups associated to this equipment entity appear. 

You can filter the results by using values for Display Name or Description. This 
page enables you to:

• Navigate to the Attribute Group Details page.

Select an attribute group value link.

• Add attribute groups to this specific entity. 

2. Select Add Attribute Groups to associate attribute groups to the entity selected. 
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Depending on the entity is selected, the following pages appear:

• Add Attribute Groups for Batch Operation

• Add Attribute Groups for Equipment

• Add Attribute Groups for Item

• Add Attribute Groups for Others

• Add Attribute Groups for User Defined Entities

• Add Attribute Groups for Work Order

On the Add Attribute Groups page you can filter the display by using a 
combination of Attribute Group Type, Behavior, Display Name, Description, and 
Internal Name.

3. In the results table, select the attribute group records you want to add to the 
selected entity.

4. Select Apply to save your work.

The records appear on the refreshed Attribute Groups for this entity page.

Related Topics
Setting Up Extensible Attributes for MOC Entities, page 3-17

Viewing Classifications for Shop Floor Entities, page 3-43

Viewing and Creating Attribute Pages for Entities, page 3-47

Viewing and Creating Attribute Pages for Entities
Attribute pages can be created for each entity for ease of use in data entry and viewing. 
You can assign multiple attribute pages to a specific entity attribute group. For each 
page, you can choose the attributes displayed and the specific order listed.
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To view and create Attribute Group Pages:
1. Select Pages to display attribute pages created for this entity classification.

This includes Batch Operation Pages, Equipment Pages, Items Pages, Others Pages, 
User Defined pages, and Work Order Pages.

The attribute group pages for the specific entity selected appear in the results table. 

You can search records on the entity Pages by Display Name or Description.

2. Select Create to create a new page for this entity.

The Add Pages for the select entity type appears. 

3. Enter the following data in the Basic Information region:

• Display Name—name displayed on the page.

•  Description—a description of the attribute category.

• Internal Name—internal name for the page, this value cannot be updated once 
a page has been created.

• Sequence—sequence number for each page associated with an attribute group, 
the sequence number determines the order pages are listed.
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4. In the Attribute Groups region, select Add Another Row to add attributes groups to
this page. To add an existing attribute group:

• Enter a Sequence number 

• Select an existing Display Name value

5. Select Apply to save your work. 

The attributes for this entity, and the display sequence appear in the Pages region.

Related Topics
Setting Up Extensible Attributes for MOC Entities, page 3-17

Viewing Classifications for Shop Floor Entities, page 3-43

Viewing and Creating Attribute Group Data for Entities, page 3-45
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4
User Role

Overview of the User Role
The Manufacturing Operations Center (MOC) User role is used to integrate shop floor 
devices in manufacturing plants to the Manufacturing Operations Center for the 
purpose of data collection and reporting. The MOC User role consists of three 
functional areas - Tag Data Workbench, Extensible Attributes Data, and Manufacturing 
Operations Center Analytics.

• Tag Data Workbench includes:

1. Manual Contextualization page - use this page to view or update business 
context for data that has the context method as Manual Contextualization.

2. Equipment Downtime Reason page - use this page to provide Downtime 
Reasons for the downtime event.

3. Equipment Scrap Reasons page - use this page to provide scrap reasons for the 
scrap event.

• Extensible Attributes Data - used to view and add data to entities such as Items, 
Equipment, Work Orders, Batch Operations, and miscellaneous custom entities.

• Manufacturing Operations Center Analytics - provides analytical tools and 
reporting using the Manufacturing Operations Center Catalog and the Plant 
Manager, Facilities Manager, and Ad hoc Dashboards.

• Shift Exceptions - use this page to edit shifts for exceptions. Refer to the topic 
"Editing Shifts for Exceptions" in the Setting Up Time Dimension Hierarchies 
chapter of the Oracle Manufacturing Operations Center Implementation Guide for more 
information.

• Actual Meters Data Entry- Use this page to enter meter readings manually using the
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Actual Meters Data Entry page and also view the history of readings for a meter.

Related Topics
Adding Reason Codes, page 3-9

Viewing and Adding Reason Codes, page 4-4

Extensible Attributes Data for Entities, page 4-5

Performing Actual Meters Data Entry, page 4-6

Using the Manual Contextualization Method
Use the Manual Contextualization page to manually enter and edit context for all active 
tags that have not been summarized to the equipment summary tables, and whose 
contextualization method is either schedule-based or manual-based. If you use the 
manual contextualization method, then the application will not apply any logic to get 
the context, other than equipment and shift, and you can manually enter the work 
order, segment, or item context in the Manual Contextualization page.

For the schedule-based contextualization method, you must update the Equipment 
Production Schedule to get the context of shift, work order, segment, and item. Using 
Manual Contextualization page, mark the rows for reprocessing to get the updated 
context for the tag from Equipment Production Schedule.

To manually enter and edit context:
1. Navigate to the Manual Contextualization page.

2. Select a Plant. You can refine your search further by selecting a value in the 
Equipment field and Tag field.

3. Enter From and To Dates to refine your search to a specific date range.

4. Click Go.

5. You can display your search results by Missing Mandatory Context Only, Missing 
Optional Context Only, or All Context. The Missing Mandatory Context Only 
option displays tag rows that do not have the context, but were set as mandatory 
context for the equipment. The Missing Optional Context Only option displays tag 
rows which do not have the context but were set as optional context for the 
equipment. All context displays rows from both Missing Mandatory and Optional 
Context options.
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To update context detail:
You can update context detail for each row, or update context detail for multiple rows 
in a batch.

1. To update context within a single row, click the search icon for a context field. The 
Search and Select window appears.

2. Enter your search criteria and click Go. A list of results displays. Select a value and 
click Select. 

3. To update context for multiple rows in a batch, select rows that you want to update 
and click the Enter Context in Batch button. The Batch Contextualization Update 
page appears.

4. Enter each context and click the Enter in Batch button. Each context field for the 
selected rows are updated.

5. Save your work.

Related Topics
Creating Equipment Contextualization Information, page 3-7
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Viewing and Adding Reason Codes
From the Tag Data Workbench, you can add or view reasons for equipment downtime 
or equipment scrap quantity.

To view and add reason codes from the Tag Data Workbench:
1. Navigate to the Equipment Downtime Reason page or the Scrap Reason page. The 

Tag Data Workbench appears.

Note: The following steps apply to both Equipment Downtime 
Reasons and Equipment Scrap Reasons.

2. Select a Plant from the List of Values (LOV).

3. Enter a valid value for Equipment, or search for a value.

4. Specify a date range for viewing or adding equipment downtime or scrap reason.

5. Click Go. The page displays the equipment downtime or scrap reading.

6. Select rows to view and add one or more reasons.

7. Click the View Reason button to view existing reasons for the date range specified.

8. Click the Enter Downtime Reason button to add a downtime reason to your 
equipment. The Downtime Reasons Entry page appears.
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Note: If you are adding Equipment Scrap Reasons, then the 
Equipment Scrap Reasons page appears.

9. In the Downtime Reason field or Scrap Reason field, enter a value, or search for a 
valid reason. You can add multiple reasons to selected equipment downtime or 
scrap reading rows.

10. Save your work. You can now click the View Reason button to verify that the 
reason code is now attached to the selected downtime or scrap reading rows.

Extensible Attributes Data for Entities
Equipment and other manufacturing entities are business objects in the shop floor with 
unique characteristics and processes. MOC supports the collection of attributes for item,
equipment, work order, batch operation, and miscellaneous custom entities. You can 
update or view attributes for manufacturing entities from the Manufacturing 
Operations Center User responsibility. 

To view extensible attributes data for entities:
1. Navigate to the entity-specific page. The entity-specific attributes display.
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2. You can further refine your display by searching on the Entity Name.

3. Click on an Entity Name link to view details. The Overview page appears and 
displays entity-specific details.

Note: The MOC User Role allows you to enter the values for the 
attributes. A typical example would be defining specification 
attributes and comparing with actual attribute values for the 
entities.

The Entity Instance Attribute Details page of the MOC 
Administrator Role appears in the MOC User Role for the entity, 
and allows you to enter or view the attribute values.

Actual Meters Data Entry
You can enter meter readings manually using the Actual Meters Data Entry page and 
also view the history of readings for a meter.

To enter meter readings manually:
1. Navigate to the Actual Meter Data Entry page. 

2. Enter Sustainability Aspect to find a meter using its sustainability aspect.
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3. Enter the following criteria to search for a meter:

• Meter Type to find a meter using its type. 

• Entity Hierarchy to find a meter using its entity hierarchy

• Entity and Entity Name to find a meter by its entity.

4. Click Go. The page displays a list of all the actual meters for which you can enter 
data readings.

5. The following fields display for each meter:

• Meter Code

• Meter Name

6. Enter the time period for which you want to enter the readings in the From Time 
and To Time fields. 

7. Enter the value of the sustainability aspect usage in the Usage Value field. Usage 
UOM is the unit of measure in which the sustainability aspect usage is expressed.
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5
Reprocessing of MOC Data

Overview of Reprocessing of MOC Data
Reprocessing of MOC Data feature recalculates the past data for tag readings, output, 
status, output summary, status summary, and reason readings table when you provide 
input data for tag readings raw, CSV data for equipment output, or CSV data for 
equipment status. Recalculation enables you to go back in time and update any past 
status data coming from the CSV file, providing you the flexibility to correct any past 
data. This feature is used at a specific equipment level and all equipments level in a 
plant.

Prerequisites

1. Build equipment hierarchy.

2. Define equipment reason setups.

3. Maintain transactions for status and output.

4. Prepare new status and/or output data.

5. Set BNE Allow No Security Rule as Yes to access WEBADI.

Note: You can execute recalculation at the status, output, and both at 
the status and the output levels.

Status Recalculation
1. Upload new status flat file to file location.

2. Run ODI scenario for reprocessing.
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3. Check scenario completion and then review log.

4. Query status, summary, tag reason readings.

Output Recalculation
1. Upload new output flat file to file location.

2. Run ODI scenario for reprocessing.

3. Check scenario completion and review log.

4. Query output, summary, tag reason readings.

Status and Output Recalculation
1. Upload new status and output flat files to file location.

2. Run ODI scenario for reprocessing.

3. Check scenario completion and review log.

4. Query status, summary, and tag reason readings.

Variable Name Expected Value

MTH_V_USER_NAME MFG or MOC 

MTH_V_RESPONSIBILITY_NAME Manufacturing Operations Center 
Administrator

MTH_V_FROM_TIMEZONE User Defined Time Zone (Optional)

MTH_V_TO_TIMEZONE User Defined Time Zone (Optional)

MTH_V_PROCESS_MODE RECAL

MTH_V_SOURCE_VALUE For Status Recalculation: CSVS

For Output Recalculation: CSVO

For Both Status and Output Recalculation: 
CSVSO
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Variable Name Expected Value

MTH_V_SITE_FOR_RECAL PLANT_PK

MTH_V_EQUIP_FOR_RECAL EQUIPMENT_PK

MTH_D_RECAL_FROM_DATE For Status: From Date of First Record

For Output: Reading Time of first Record

MTH_D_RECAL_TO_DATE For Status: To Date of last Record less one 
second

For Output: Reading Time of last record

Reprocessing OUTOUT CSV data only
Reprocessing of equipment output data and equipment status data can be done 
individually or both at a time based on the input parameters that you choose.

Prerequisites
Organizations, Plants, WorkdayShifts, Equipments, resources and EquipEntities, 
EquipmentShifts, Equip Hierarchy, EquipDenorm and EquipmentReasonSetup data 
should be set up.

Example Data:

Plant_pk = Plant_01.

Plant_Pk_Key = 1000.

Equipment_Pk = Equip_01.

Equipment_Pk_Key = 1001.

Workday shifts and Equipment shifts are defined for the plant and equipment.

Assume that Shift_Workday_pk_key is the same as the corresponding hour number. 
(For example, for 10:00:00 it is 10, for 17:00:00 it is 17, and so on.)

Scrap reason codes: HAZ, UC (Reason type = 2)

Existing data in output, status and their summary tables, and tag reason readings table 
are listed below.
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Existing data in Equipment Output table

Equipment_Fk_
key

Reading_Time Hour_fk_key Qty_completed QTY_SCRAP

1001 2012.09.17 
10:07:00

10 50

1001 2012.09.17 
10:28:00

10 25 5(UC)

1001 2012.09.17 
10:50:00

10 30

1001 2012.09.17 
11:25:00

11 25

1001 2012.09.17 
11:25:00

11 60 10(HAZ)

Existing data in Equipment Output Summary table

Equipment_ 
Fk_Key

From_time 
(mth_hour_d
)

To_time 
(mth_hour_d
)

Hour_fk_key Qty_Comple
ted

QTY_SCRAP

1001 2012.09.17 
10:00:00

2012.09.17 
10:59:59

10 115 5

1001 2012.09.17 
11:00:00

2012.09.17 
11:59:59

11 85 10

Existing data in Equipment Tag Reason Readings table

REASON_
TYPE

Equipment
_Fk_key

From_time To_time Hour_Fk_
Key

READING_
TIME

REASON_
CODE

2 1001 2012.09.17 
10:28:00

2012.09.17 
10:28:00

10 2012.09.17 
10:28:00

UC
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REASON_
TYPE

Equipment
_Fk_key

From_time To_time Hour_Fk_
Key

READING_
TIME

REASON_
CODE

2 1001 2012.09.17 
11:48:00

2012.09.17 
11:48:00

11 2012.09.17 
11:48:00

HAZ

1. Update the OUTPUT CSV with records to be reprocessed.

OUTPUT CSV data

Equipment_ 
Fk_Key

Reading_Time Qty_Complete
d

QTY_SCRAP Scrap_ 
Reason_code

1001 2012.09.17 
10:10:00

110 10 HAZ

1001 2012.09.17 
10:30:00

60

1001 2012.09.17 
10:40:00

50

1001 2012.09.17 
11:30:00

40 20 UC

1001 2012.09.17 
11:56:59

30

2. Upload the CSVs to the  (or EXT table) using FileZilla.

3. Follow the steps below to run ODI scenario:

1. Go to ODI studio.

2. Navigate to MTH Transactions > MTH Equipment Transactions > 
MTH_PKG_REPROCESS_TRANSACTIONS.

3. Right click and select Execute to run the Scenario.

4. Select the correct Context in the Execution window that appears.

5. Click OK.

Variable Values window appears.
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6. Deselect the Last Values.

7. Enter the following parameters:

• MTH_V_USER_NAME : <MOC>

• MTH_V_RESPONSIBILITY_NAME : <Manufacturing Operations Center 
Administrator>

• MTH_V_FROM_TIMEZONE : <>

• MTH_V_TO_TIMEZONE : <>

• MTH_V_PROCESS_MODE : <RECAL>

• MTH_V_SOURCE_VALUE : <CSVO>

• MTH_V_SITE_FOR_RECAL : <Plant_01>

• MTH_V_EQUIP_FOR_RECAL : <Equip_01>

• MTH_D_RECAL_FROM_DATE : <2012.09.17 10:10:00>

(Reading_Time of first record in OUTPUT CSV.)

• MTH_D_RECAL_TO_DATE : <2012.09.17 11:56:59>

(Reading_Time of last record in OUTPUT CSV)

8. Click OK to run the Scenario.

9. Click on Operator tab.

If the scenario is completed, a CP request is submitted.

4. Log on to the application.

User name is MOC and the password is welcome.

5. Select View Requests from the Tool menu.

Verify the CP request status and log information.

6. Connect to the SQL tool.

7. Query the OUTPUT, OUTPUT SUMMARY, and TAGReasonReadings tables.

Verify if the data has been reprocessed or not. If reprocessed, then the recalculated 
data in OUTPUT, OUTPUT SUMMARY, TAGReasonReadings tables are as follows:
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New and recalculated data in Equipment Output table

Equipment_Fk_
key

Reading_Time Hour_fk_key Qty_completed QTY_SCRAP

1001 2012.09.17 
10:10:00

10 110 10(HAZ)

1001 2012.09.17 
10:30:00

10 60

1001 2012.09.17 
10:40:00

10 50

1001 2012.09.17 
11:30:00

11 40 20(UC)

1001 2012.09.17 
11:56:59

11 30

New and recalculated data in Equipment Output Summary table

Equipment_ 
Fk_Key

From_time 
(mth_hour_d
)

To_time 
(mth_hour_d
)

Hour_fk_key Qty_Comple
ted

QTY_SCRAP

1001 2012.09.17 
10:00:00

2012.09.17 
10:59:59

10 220 10

1001 2012.09.17 
11:00:00

2012.09.17 
11:59:59

11 70 20

New and recalculated data in Equipment Tag Reason Readings table

REASON_
TYPE

Equipment
_Fk_key

From_time To_time Hour_Fk_
Key

READING_
TIME

REASON_
CODE

2 1001 2012.09.17 
10:10:00

2012.09.17 
10:10:00

10 2012.09.17 
10:10:00

HAZ
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REASON_
TYPE

Equipment
_Fk_key

From_time To_time Hour_Fk_
Key

READING_
TIME

REASON_
CODE

2 1001 2012.09.17 
11:30:00

2012.09.17 
11:30:00

11 2012.09.17 
11:30:00

UC

Note: The recalculation of the Equipment Output Summary and Status 
Summary for Equip_01 involves the following scenarios based on the 
data you populate in CSVs to reprocess:

1. Output Summary and Status Summary do not have data prior to 
the RECAL_FROM_DATE and data after the RECAL_TO_DATE.

2. Output Summary and Status Summary do not have data prior to 
the RECAL_FROM_DATE but have data for Equip_01 after the 
RECAL_TO_DATE.

3. Output Summary and Status Summary have data prior to the 
RECAL_FROM_DATE but the data do not exist for the dates after 
RECAL_TO_DATE for Equip_01.

4. Output Summary and Status Summary have data prior to the 
RECAL_FROM_DATE and data for dates after the 
RECAL_TO_DATE for Equip_01.

5. Output Summary and Status Summary do not have data prior to 
the RECAL_FROM_DATE and also for dates after the 
RECAL_TO_DATE for Equip_01.

6. Output Summary and Status Summary do not have data prior to 
the RECAL_FROM_DATE but have data for the dates after the 
RECAL_TO_DATE for Equip_01.

7. Output Summary and Status Summary have data prior to the 
RECAL_FROM_DATE but do not have data for the dates after the 
RECAL_TO_DATE for Equip_01.

8. Output Summary and Status Summary have data prior to the 
RECAL_FROM_DATE and also have data for dates after the 
RECAL_TO_DATE for Equip_01.
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Reprocessing STATUS CSV data only
Reprocessing of equipment output data and equipment status data can be done 
individually or both at a time based on the input parameters that you choose.

Prerequisites
Organizations, Plants, WorkdayShifts, Equipments, resources and EquipEntities, 
EquipmentShifts, Equip Hierarchy, EquipDenorm and EquipmentReasonSetup data 
should be set up.

Example Data:

Plant_pk = Plant_01

Plant_Pk_Key = 1000

Equipment_Pk = Equip_01

Equipment_Pk_Key = 1001

Workday shifts and Equipment shifts are defined for the plant and equipment.

Assume that Shift_Workday_pk_key is the same as the corresponding hour number. 
(For example, for 10:00:00 it is 10, for 17:00:00 it is 17, and so on.)

Idle reason codes: LOA, CLE (Reason type = 3).

Down reason codes: DRV, HT (Reason type = 1).

Existing data in status, status summary, and tag reason readings table are listed below:

Existing data in Equipment Status table

Equipment_ 
Fk_Key

From_time To_time Hour_fk_key Status READING_TI
ME

1001 2012.09.17 
10:00:00

2012.09.17 
10:25:00

10 1 2012.09.17 
10:00:00

1001 2012.09.17 
10:25:01

2012.09.17 
10:45:00

10 2(LOA) 2012.09.17 
10:25:01

1001 2012.09.17 
10:45:01

2012.09.17 
10:59:59

10 3(DRV) 2012.09.17 
10:45:01

1001 2012.09.17 
11:00:00

2012.09.17 
11:15:00

11 1 2012.09.17 
11:00:00
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Equipment_ 
Fk_Key

From_time To_time Hour_fk_key Status READING_TI
ME

1001 2012.09.17 
11:15:01

2012.09.17 
11:37:00

11 2(LOA) 2012.09.17 
11:15:01

Existing data in Equipment Status Summary table

Equipment
_ Fk_Key

UP_Hours Down_Ho
urs

Idle_Hours Run_Hour
s

Off_Hours Hour_FK_
key

1001 .750000 .250000 .3333 .416667 0.00000 10

1001 1.0000 0.00000 .594595 .405405 0.00000 11

Existing data in Equipment Tag Reason Readings table

REASON_
TYPE

Equipment
_Fk_key

From_time To_time Hour_Fk_
Key

READING_
TIME

REASON_
CODE

3 1001 2012.09.17 
10:25:01

2012.09.17 
10:45:00

10 2012.09.17 
10:25:01

LOA

1 1001 2012.09.17 
10:45:01

2012.09.17 
10:59:59

10 2012.09.17 
10:45:01

DRV

3 1001 2012.09.17 
11:15:00

2012.09.17 
11:37:00

11 2012.09.17 
11:15:00

LOA

1. Update the STATUS CSV with records to be reprocessed.

STATUS CSV data

Equipment_ 
Fk_Key

From_time To_time Status Down_Time_ 
Reason_code

1001 2012.09.17 
10:10:00

2012.09.17 
10:40:00

2
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1001 2012.09.17 
10:40:00

2012.09.17 
10:55:00

3 HT

1001 2012.09.17 
10:55:00

2012.09.17 
11:10:00

2 CLE

1001 2012.09.17 
11:10:00

2012.09.17 
11:35:00

3 DRV

1001 2012.09.17 
11:35:00

2012.09.17 
11:57:00

1

2. Upload the Status CSV to the Flat file Directory (or EXT table) using FileZilla.

3. Follow the steps below to run ODI scenario.

1. Go to ODI studio.

2. Navigate to MTH Transactions > MTH Equipment Transactions > 
MTH_PKG_REPROCESS_TRANSACTIONS.

3. Right click and select Execute to run the scenario.

4. Select the correct Context in the Execution window that appears.

5. click OK.

Variable Values window appears.

6. Deselect the Last Values.

Enter the following parameters:

• MTH_V_USER_NAME : <MOC>

• MTH_V_RESPONSIBILITY_NAME : <Manufacturing Operations Center 
Administrator>

• MTH_V_FROM_TIMEZONE : <>

• MTH_V_TO_TIMEZONE : <>

• MTH_V_PROCESS_MODE : <RECAL>

• MTH_V_SOURCE_VALUE : <CSVS>



5-12    Oracle Manufacturing Operations Center User's Guide

• MTH_V_SITE_FOR_RECAL : <Plant_01>

• MTH_V_EQUIP_FOR_RECAL : <Equip_01>

• MTH_D_RECAL_FROM_DATE : <2012.09.17 10:10:00>

(From_date of first record in STATUS CSV.)

• MTH_D_RECAL_TO_DATE : <2012.09.17 11:56:59>

(To_date of last record minus one second in status CSV)

7. Click OK to Run the scenario.

8. Click on the Operator tab.

If the scenario is completed, a CP request is submitted.

4. Log on to the application.

User name is MOC and the password is welcome.

5. Select View Requests from the Tool menu.

Verify the CP request status and log information.

6. Connect to SQL tool.

7. Query the STATUS, STATUS SUMMARY, TAGReasonReadings tables.

Verify if the data has been reprocessed or not. If reprocessed, then the recalculated 
data in status, status summary, and Tag reason readings table are as follows:

New and recalculated data in Equipment Status table

Equipment_ 
Fk_Key

From_time To_time Hour_fk_key Status READING_TI
ME

1001 2012.09.17 
10:00:00

2012.09.17 
10:40:00

10 2 2012.09.17 
10:00:00

1001 2012.09.17 
10:40:01

2012.09.17 
10:55:00

10 3(HT) 2012.09.17 
10:40:01

1001 2012.09.17 
10:55:01

2012.09.17 
10:59:59

10 2(CLE) 2012.09.17 
10:55:01



Reprocessing of MOC Data    5-13

Equipment_ 
Fk_Key

From_time To_time Hour_fk_key Status READING_TI
ME

1001 2012.09.17 
11:00:00

2012.09.17 
11:10:00

11 2(CLE) 2012.09.17 
11:00:00

1001 2012.09.17 
11:10:01

2012.09.17 
11:35:00

11 3(DRV) 2012.09.17 
11:10:01

1001 2012.09.17 
11:35:01

2012.09.17 
11:57:00

11 1 2012.09.17 
11:35:01

New and recalculated data in Equipment Status Summary table

Equipment
_ Fk_Key

UP_Hours Down_Ho
urs

Idle_Hours Run_Hour
s

Off_Hours Hour_FK_
key

1001 .750000 .250000 .750000 0.000 0.00000 10

1001 .561403509 .438596 .175439 .385965 0.00000 11

New and recalculated data in Equipment Tag Reason Readings table

REASON_
TYPE

Equipment
_Fk_key

From_time To_time Hour_Fk_
Key

READING_
TIME

REASON_
CODE

3 1001 2012.09.17 
10:00:00

2012.09.17 
10:40:00

10 2012.09.17 
10:00:00

1 1001 2012.09.17 
10:40:01

2012.09.17 
10:55:00

10 2012.09.17 
10:40:01

HT

3 1001 2012.09.17 
10:55:01

2012.09.17 
10:59:59

10 2012.09.17 
10:55:01

CLE

3 1001 2012.09.17 
11:00:00

2012.09.17 
11:10:00

11 2012.09.17 
11:00:00

CLE

1 1001 2012.09.17 
11:10:01

2012.09.17 
11:35:00

11 2012.09.17 
11:10:01

DRV
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Note: The recalculation of the Equipment Status Summary for Equip_01
involves the following scenarios based on the data you populate in 
CSVs to reprocess:

1. Status Summary does not have data prior to the 
RECAL_FROM_DATE and also has data after the 
RECAL_TO_DATE.

2. Status Summary does not have data prior to the 
RECAL_FROM_DATE but has data for Equip_01 after the 
RECAL_TO_DATE.

3. Status Summary has data prior to the RECAL_FROM_DATE but no
data exists for the dates after RECAL_TO_DATE for Equip_01.

4. Status Summary has data prior to the RECAL_FROM_DATE and 
also has data for dates after the RECAL_TO_DATE for Equip_01.

5. Status Summary does not have data prior to the 
RECAL_FROM_DATE and also for dates after the 
RECAL_TO_DATE for Equip_01.

6. Status Summary does not have data prior to the 
RECAL_FROM_DATE but has data for the dates after the 
RECAL_TO_DATE for Equip_01.

7. Status Summary has data prior to the RECAL_FROM_DATE but 
does not have data for the dates after the RECAL_TO_DATE for 
Equip_01.

8. Status Summary has data prior to the RECAL_FROM_DATE and 
also has data for dates after the RECAL_TO_DATE for Equip_01.

Reprocessing both STATUS and OUTOUT CSVs data at a time
Reprocessing of equipment output data and equipment status data can be done 
individually or both at a time based on the input parameters that you choose.

Prerequisites
Organizations, Plants, WorkdayShifts, Equipments, resources and EquipEntities, 
EquipmentShifts, Equip Hierarchy, EquipDenorm and EquipmentReasonSetup data 
should be set up.

Example Data:
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Plant_pk = Plant_01

Plant_Pk_Key = 1000

Equipment_Pk = Equip_01

Equipment_Pk_Key = 1001

Workday shifts and equipment shifts are defined for the plant and equipment.

Assume that Shift_Workday_pk_key is the same as the corresponding hour number. 
(For example, for 10:00:00 it is 10, for 17:00:00 it is 17, and so on.)

Idle reason codes: LOA, CLE (Reason type = 3).

Down reason codes: DRV, HT (Reason type = 1).

Scrap reason codes: HAZ, UC (Reason type = 2).

Existing data in output, status and their summary tables, and Tag reason readings table 
are listed below:

Existing data in Equipment Status table

Equipment_ 
Fk_Key

From_time To_time Hour_fk_key Status READING_TI
ME

1001 2012.09.17 
10:00:00

2012.09.17 
10:25:00

10 1 2012.09.17 
10:00:00

1001 2012.09.17 
10:25:01

2012.09.17 
10:45:00

10 2(LOA) 2012.09.17 
10:25:01

1001 2012.09.17 
10:45:01

2012.09.17 
10:59:59

10 3(DRV) 2012.09.17 
10:45:01

1001 2012.09.17 
11:00:00

2012.09.17 
11:15:00

11 1 2012.09.17 
11:00:00

1001 2012.09.17 
11:15:01

2012.09.17 
11:37:00

11 2(LOA) 2012.09.17 
11:15:01
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Existing data in Equipment Status Summary table

Equipment
_ Fk_Key

UP_Hours Down_Ho
urs

Idle_Hours Run_Hour
s

Off_Hours Hour_FK_
key

1001 .750000 .250000 .3333 .416667 0.00000 10

1001 1.0000 0.00000 .594595 .405405 0.00000 11

Existing data in Equipment Output table

Equipment_Fk_
key

Reading_Time Hour_fk_key Qty_completed QTY_SCRAP

1001 2012.09.17 
10:07:00

10 50

1001 2012.09.17 
10:28:00

10 25 5(UC)

1001 2012.09.17 
10:50:00

10 30

1001 2012.09.17 
11:25:00

11 25

1001 2012.09.17 
11:48:00

11 60 10(HAZ)

Existing data in Equipment Output Summary table

Equipment_ 
Fk_Key

From_time 
(mth_hour_d
)

To_time 
(mth_hour_d
)

Hour_fk_key Qty_Comple
ted

QTY_SCRAP

1001 2012.09.17 
10:00:00

2012.09.17 
10:59:59

10 115 5

1001 2012.09.17 
11:00:00

2012.09.17 
11:59:59

11 85 10
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Existing data in Equipment Tag Reason Readings table

REASON_
TYPE

Equipment
_Fk_key

From_time To_time Hour_Fk_
Key

READING_
TIME

REASON_
CODE

2 1001 2012.09.17 
10:28:00

2012.09.17 
10:28:00

10 2012.09.17 
10:28:00

UC

2 1001 2012.09.17 
11:48:00

2012.09.17 
11:48:00

11 2012.09.17 
11:48:00

HAZ

3 1001 2012.09.17 
10:25:01

2012.09.17 
10:45:00

10 2012.09.17 
10:25:01

LOA

1 1001 2012.09.17 
10:45:01

2012.09.17 
10:59:59

10 2012.09.17 
10:45:01

DRV

3 1001 2012.09.17 
11:15:00

2012.09.17 
11:37:00

11 2012.09.17 
11:15:00

LOA

1. Update the STATUS CSV and OUTPUT CSV with records to be reprocessed.

STATUS CSV data

Equipment_ 
Fk_Key

From_time To_time Status Down_Time_ 
Reason_code

1001 2012.09.17 
10:10:00

2012.09.17 
10:40:00

2

1001 2012.09.17 
10:40:00

2012.09.17 
10:55:00

3 HT

1001 2012.09.17 
10:55:00

2012.09.17 
11:10:00

2 CLE

1001 2012.09.17 
11:10:00

2012.09.17 
11:35:00

3 DRV

1001 2012.09.17 
11:35:00

2012.09.17 
11:57:00

1
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OUTPUT CSV data

Equipment_ 
Fk_Key

Reading_Time Qty_Complete
d

QTY_SCRAP Scrap_ 
Reason_code

1001 2012.09.17 
10:10:00

110 10 HAZ

1001 2012.09.17 
10:30:00

60

1001 2012.09.17 
10:40:00

50

1001 2012.09.17 
11:30:00

40 20 UC

1001 2012.09.17 
11:56:59

30

2. Upload the CSVs to the Flat file Directory (or EXT table) using FileZilla.

3. Follow the steps below to run ODI scenario:

1. Go to ODI studio.

2. Navigate to MTH Transactions > MTH Equipment Transactions > 
MTH_PKG_REPROCESS_TRANSACTIONS.

3. Right click and select Execute to run the scenario.

Check if the correct Context is selected in the Execution window that appears.

4. Click OK.

Variable Values window appears.

5. Deselect the Last Values.

6. Enter the following parameters:

• MTH_V_USER_NAME : <MOC>

• MTH_V_RESPONSIBILITY_NAME : <Manufacturing Operations Center 
Administrator>
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• MTH_V_FROM_TIMEZONE : <>

• MTH_V_TO_TIMEZONE : <>

• MTH_V_PROCESS_MODE : <RECAL>

• MTH_V_SOURCE_VALUE : <CSVSO>

• MTH_V_SITE_FOR_RECAL : <Plant_01>

• MTH_V_EQUIP_FOR_RECAL : <Equip_01>

• MTH_D_RECAL_FROM_DATE : <2012.09.17 10:10:00>

(From_date of first record in STATUS CSV or Reading_Time of first record 
in OUTPUT CSV.)

• MTH_D_RECAL_TO_DATE : <2012.09.17 11:56:59>

(To_date of last record minus one second in status CSV or Reading_Time of
last record in OUTPUT CSV.)

7. Click OK to Run the Scenario.

8. Click on the Operator tab.

If the scenario is completed, a CP request is submitted.

4. Log on to the application.

User name is MOC and the password is welcome.

5. Select View Requests from the Tool menu.

Verify the CP request status and log information.

6. Connect to the SQL tool.

7. Query the OUTPUT, STATUS, SUMMARY, TAGReasonReadings tables.

Verify if the data has been reprocessed or not. If reprocessed, then the recalculated 
data in output, status and their summary tables, and tag reason readings table are 
as follows:
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New and recalculated data in Equipment Status table

Equipment_ 
Fk_Key

From_time To_time Hour_fk_key Status READING_TI
ME

1001 2012.09.17 
10:00:00

2012.09.17 
10:40:00

10 2 2012.09.17 
10:00:00

1001 2012.09.17 
10:40:01

2012.09.17 
10:55:00

10 3(HT) 2012.09.17 
10:40:01

1001 2012.09.17 
10:55:01

2012.09.17 
10:59:59

10 2(CLE) 2012.09.17 
10:55:01

1001 2012.09.17 
11:00:00

2012.09.17 
11:10:00

11 2(CLE) 2012.09.17 
11:00:00

1001 2012.09.17 
11:10:01

2012.09.17 
11:35:00

11 3(DRV) 2012.09.17 
11:10:01

1001 2012.09.17 
11:35:01

2012.09.17 
11:57:00

11 1 2012.09.17 
11:35:01

New and recalculated data in Equipment Status Summary table

Equipment
_ Fk_Key

UP_Hours Down_Ho
urs

Idle_Hours Run_Hour
s

Off_Hours Hour_FK_
key

1001 .750000 .250000 .750000 0.000 0.00000 10

1001 .561403509 .438596 .175439 .385965 0.00000 11

New and recalculated data in Equipment Output table

Equipment_Fk_
key

Reading_Time Hour_fk_key Qty_completed QTY_SCRAP

1001 2012.09.17 
10:10:00

10 110 10(HAZ)
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Equipment_Fk_
key

Reading_Time Hour_fk_key Qty_completed QTY_SCRAP

1001 2012.09.17 
10:30:00

10 60

1001 2012.09.17 
10:40:00

10 50

1001 2012.09.17 
11:30:00

11 40 20(UC)

1001 2012.09.17 
11:56:59

11 30

New and recalculated data in Equipment Output Summary table

Equipment_ 
Fk_Key

From_time 
(mth_hour_d
)

To_time 
(mth_hour_d
)

Hour_fk_key Qty_Comple
ted

QTY_SCRAP

1001 2012.09.17 
10:00:00

2012.09.17 
10:59:59

10 220 10

1001 2012.09.17 
11:00:00

2012.09.17 
11:59:59

11 70 20

New and recalculated data in Equipment Tag Reason Readings table

REASON_
TYPE

Equipment
_Fk_key

From_time To_time Hour_Fk_
Key

READING_
TIME

REASON_
CODE

2 1001 2012.09.17 
10:10:00

2012.09.17 
10:10:00

10 2012.09.17 
10:10:00

HAZ

2 1001 2012.09.17 
11:30:00

2012.09.17 
11:30:00

11 2012.09.17 
11:30:00

UC

3 1001 2012.09.17 
10:00:00

2012.09.17 
10:40:00

10 2012.09.17 
10:00:00
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REASON_
TYPE

Equipment
_Fk_key

From_time To_time Hour_Fk_
Key

READING_
TIME

REASON_
CODE

1 1001 2012.09.17 
10:40:01

2012.09.17 
10:55:00

10 2012.09.17 
10:40:01

HT

3 1001 2012.09.17 
10:55:01

2012.09.17 
10:59:59

10 2012.09.17 
10:55:01

CLE

3 1001 2012.09.17 
11:00:00

2012.09.17 
11:10:00

11 2012.09.17 
11:00:00

CLE

1 1001 2012.09.17 
11:10:01

2012.09.17 
11:35:00

11 2012.09.17 
11:10:01

DRV

Note: Recalculation of the equipment output summary and status 
summary for Equip_01 involves the following scenarios based on the 
data you populate in CSVs to reprocess:

1. Output summary and status summary do not have data prior to the
RECAL_FROM_DATE and data after the RECAL_TO_DATE.

2. Output summary and status summary do not have data prior to the
RECAL_FROM_DATE but have data for Equip_01 after the 
RECAL_TO_DATE.

3. Output summary and status summary have data prior to the 
RECAL_FROM_DATE but no data exists for the dates after 
RECAL_TO_DATE for the Equip_01.

4. Output summary and status summary have data prior to the 
RECAL_FROM_DATE and also data for dates after the 
RECAL_TO_DATE for Equip_01.

5. Output summary and status summary do not have data prior to the
RECAL_FROM_DATE and also for dates after the 
RECAL_TO_DATE for Equip_01.

6. Output summary and status summary do not have data prior to the
RECAL_FROM_DATE but have data for the dates after the 
RECAL_TO_DATE for Equip_01.

7. Output summary and status summary have data prior to the 
RECAL_FROM_DATE but do not have data for the dates after the 
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RECAL_TO_DATE for Equip_01.

8. Output summary and status summary have data prior to the 
RECAL_FROM_DATE and also data for dates after the 
RECAL_TO_DATE for Equip_01.
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6
Error Management

WebADI based Error Reprocessing
The Manufacturing Operations Center provides capability to correct the errors 
encountered during loading of data through flat files or collected from source systems 
such as Oracle E-Business Suite using a simple WebADI based template. It also 
provides an ability to view the entire error data, improving the efficiency and accuracy 
of data integration.

Note: You do not require database access for data upload to correct the 
incorrectly entered data.

Reprocessing Errors:
1. Navigate to Reprocess Errors window.

Reprocess Errors window opens with a list of 45 error tables.
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2. Click on the error record's number link against the Table Name you want to 
reprocess in the Not Modified column.

The Viewer window appears.

3. Select Excel 2007 option from the list of values in the Viewer field. 
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4. Click Next.

The Document Creation Review window appears with the list of parameters that 
will be used to create your document.

5. Click the Create Document button.

The File Download window appears.

6. Click Open.

The Confirmation window appears with a message that the download process has 
been completed successfully.
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7. Click Close.

8. Go to Add-Ins in the menu bar.

9. Click Upload option in the Oracle drop-down list.

The Upload Parameters window appears.

10. Click the Upload button.

The Confirmation message appears.

Note: Validations are added to ensure REPROCESS_READY_YN is 
D for time dimension tables and Y, N, D for all other tables. 
REPROCESS_READY_YN column allows mandatory values of Y, 
N, and D for all error tables and for the following 
TIMEDIMENSION error tables only D is allowed: 

• MTH_TIME_HIERARCHY_ERR 

• MTH_DAY_ERR 

• MTH_YEAR_ERR 

• MTH_QUARTER_ERR

• MTH_PERIOD_ERR 

• MTH_WEEK_ERR 

Records will not be committed if a batch has any invalid value 
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other than D, Y, or N.

11. Click Close.

Check the Error table data and the Fact table data before reprocessing.

12. Place an empty flat file in the CSV file path of the ODI configured environment.

13. Check the EXT table to ensure that an empty flat file is placed.
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14. Select the scenario and right click to Execute in the ODI.

15. Select the Context in the Execution window to run the ODI scenario.

16. Click OK to run the ODI scenario.
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Check if reprocessing is complete in the Error table and the Fact table after the 
Scenario is completed successfully.
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7
Manufacturing Operations Center Catalog

Overview of the MOC Catalog
The Manufacturing Operations Center Catalog provides the Plant Manager Dashboard, 
Facilities Manager Dashboard, Production Supervisor Dashboard, Asset Performance 
Dashboard, and Ad hoc Dashboard with performance areas related to manufacturing 
operations. It uses the ISA-95 (Instrumentation, Systems and Automation Society) 
structure to integrate Enterprise Resource Planning (ERP) and shop floor 
manufacturing equipment and systems transactions. This combination enables the 
catalog to provide operational analytics visibility. The catalog uses data from multiple 
sources and builds a logical data model providing industry-rich operational metrics to 
be analyzed by multiple dimensions and hierarchies. The manufacturing performance 
areas include the following: 

Performance Areas Description

Agility Responsiveness Used to analyze flexibility related measures 
by system, plant, item, time and equipment.

Batch Analyzer Used to analyze usage and production 
variance and other work order related 
measures by system, item, plant and time.

Equipment Attributes Data Attributes associated to equipment entities.

Equipment Down Time Analysis Used to analyze the downtime duration of 
equipment.

Equipment Scrap Analysis Used to analyze the scrap quantity reported 
for the equipment at different points of time.
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Performance Areas Description

Manufacturing Asset Performance Used to analyze overall equipment 
effectiveness and production loss analysis by 
system, plant, item, time, and equipment.

Plant Maintenance Used to analyze maintenance related 
downtime measures by system, time, and 
equipment. 

Production Performance Used to analyze operation cycle time and its 
components of run, down, and idle time 
contributing to cycle time.

 Quality Used to analyze first pass yield, scrap, reject, 
and rework measures by system, plant, time, 
and equipment.

Schedule Adherence Used to analyze production to performance 
and backlog related measures by system, 
plant, item, time, and equipment. 

Service Level Used to analyze manufacturing performance 
relative to pegged sales orders shipped using 
request and promise dates by system, plant, 
item and time. 

Sustainability Performance This performance area contains metrics that 
measures sustainability performance of 
manufacturing and non-manufacturing 
companies. It contains metrics that a company
can use to monitor and reduce energy 
consumption, its cost, and associated Green 
House Gas emissions.

Production Sustainability Performance Used to analyze sustainability performance of 
production organizations. Contains 
normalized sustainability metrics by 
production activity.

Equipment Sustainability Analysis used to analyze sustainability characteristics 
of manufacturing equipments. Contains 
metrics that contextualize manufacturing 
activity and consumption data.
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Performance Areas Description

Ad hoc Analysis It is used to analyze electricity consumption, 
pressure, and temperature for an entity and 
specific time-period.

Key Performance Indicators (KPIs)

The MOC Catalog provides KPIs based on the analytics layer of Oracle Business 
Intelligence. These KPIs are industry-rich metrics used in managing the plant 
operations. Since these metrics are available on the metadata-driven Oracle Business 
Intelligence tool, you can personalize and modify existing reports and the Plant 
Manager and Facilities Manager Dashboards. It also enables flexibility to add new and 
modify existing KPIs in the catalog.

Performance Area: Batch Analyzer

KPI Description

Work Order Quantity variance Variance of actual produced quantity 
compared to the planned production quantity 
in units. 

Work Order Quantity variance % Variance of actual produced quantity 
compared to the planned production quantity 
in percentage. 

Work in Progress Planned Quantity WIP Planned Quantity for OPM batches. The 
quantity that is planned during the release of 
process batch for production.

Material Usage Variance Cost of variance of actual usage quantity 
compared to the planned usage quantity for 
components 

Resource Usage Variance Cost of variance of actual usage quantity 
compared to the planned usage quantity for 
resources 

Work order or Batch Cycle Time (Hours) Cycle time between start and end of a work 
order or batch
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KPI Description

First Time Quality % Ratio of the total production that is good the 
first time without any rejection or scrap

PPM on completed Work Orders Parts per Million - estimated rejected and 
scrapped quantity for every million units of 
production.

Work Order Planned Start Date Work Order Planned Start Date

Work Order Planned Completion Date Work Order Planned Completion Date 

Work Order Actual Start Date Work Order Actual Start Date

Work Order Actual Completion Date Work Order Actual Completion Date

Work Order Actual Completion Quantity Work Order Actual completed quantity 
without reject or scrap

Work Order Planned Completion Quantity Work Order Planned Completion Quantity

Work Order Planned Material Usage Quantity Planned material usage quantity for the work 
order

Work Order Actual Material Usage Quantity Actual material usage quantity for the work 
order

Work Order Planned Resource Usage 
Quantity

Planned resource usage quantity for the work 
order 

Work Order Actual Resource Usage Quantity Actual resource usage quantity for the work 
order 

Work Order First Time Good Quantity Work Order Output Quantity that has not 
been reworked or scrapped 

Work Order Total Rejected Quantity Work Order Total Rejected Quantity which 
includes rework and scrap 

Production Material Consumed Scrap 
Quantity

Planned Scrap quantity based on scrap factor 
associated with ingredients in process batches
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Performance Area: Service Levels

KPI Description

Manufacturing Performance to scheduled ship
date 

Percentage of work orders that were 
completed on or before scheduled ship date of
the pegged SO line 

Manufacturing Performance to request date Percentage of work orders that were 
completed on or before request date of the 
pegged SO line 

Manufacturing Performance to promise date Percentage of work orders that were 
completed on or before promise date of the 
pegged SO line 

Sales Order Number Sales Order Number 

Sales Order Line Number Sales Order Line Number 

Customer Customer Name 

Sales Order Ship Date Sales Order Ship Date 

Sales Order Request Date Sales Order Request Date 

Sales Order Promise Date Sales Order Promise Date

Performance Area: Manufacturing Asset Performance

KPI Description

Equipment Calendar Time (Hours) Work Hours Based on Site Calendar 

Equipment Scheduled Time (Hours) Scheduled Availability Time based on 
Equipment Shift Availability 

Production Loss - Planned (Hours) Planned equipment downtime (down for 
maintenance or other reasons) in Hours
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KPI Description

Production Loss - Planned (Value) Cost of Planned equipment downtime (down 
for maintenance or other reasons) in terms of 
resource cost 

 Production Loss - Planned (%) Cost of Planned equipment downtime (down 
for maintenance or other reasons) in 
percentage terms of % 

Actual Down Time (Hours) Unplanned Equipment Down time

Actual Available Time (Hours Actual Available time for the equipment after 
accounting for planned and unplanned 
downtimes 

Production Loss due to Unplanned Downtime
(Hours) 

Unplanned equipment downtime (down 
because of breakdown or other reasons) in 
Hours 

Production Loss due to Unplanned Downtime
(Value) 

Unplanned equipment downtime (down 
because of breakdown or the reasons) in terms
of resource cost

Production Loss due to Unplanned Downtime
(%)

Unplanned equipment downtime (down 
because of breakdown or other reasons) in 
percentage terms 

Machine Availability Ratio Actual time for which equipment was 
available for operation divided by calendar 
time based on the site calendar 

Actual Run Time (Hours) Equipment Run Time

Production Loss due to Other Reasons 
(Hours) 

Unplanned Equipment Production Loss in 
Hours due to reasons other than downtime, 
efficiency or bad quality (lack of demand or 
material) 

Production Loss due to Other Reasons (Value) Unplanned Equipment Production Loss in 
cost terms due to reasons other than 
downtime, efficiency or bad quality (lack of 
demand or material) 
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KPI Description

Production Loss due to Other Reasons (%) Unplanned Equipment Production Loss in 
percentage terms due to reasons other than 
downtime, efficiency or bad quality (lack of 
demand or material)

Machine Efficiency Actual rate of production compared to the 
ideal rate of production 

Effective Run Time (Hours) Effective Equipment Run time after taking 
machine efficiency into account 

Performance Ratio Ratio of effective run time to actual available 
time

Production Loss due to Efficiency (Hours) Unplanned Equipment Production Loss in 
Hours Due to Machine inefficiency when 
compared to ideal rate of production 

Production Loss due to Efficiency in % Unplanned Equipment Production Loss in 
cost terms Due to Machine inefficiency when 
compared to ideal rate of production 

Production Loss due to Efficiency (Value) Unplanned Equipment Production Loss in 
percentage terms Due to Machine inefficiency 
when compared to ideal rate of production 

Equipment Output Quantity Total Equipment output quantity including 
good and bad quantities 

Equipment Standard Rate Equipment Standard production rate in units 
per hour 

Equipment First Time Good Quantity Equipment Output Quantity that has not been
reworked or scrapped

First Pass Yield Percentage of the total production that is good
the first time itself without any rejection or 
scrap

Overall effective run time (Hours) Effective Run Time after deducting for bad 
quality
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KPI Description

Production Loss due to Bad Quality (%) Unplanned Equipment Production Loss in 
Hours due to bad quality 

 Production Loss due to Bad Quality (Hours) Unplanned Equipment Production Loss in 
cost terms due to bad quality

Production loss due to Bad Quality (Value) Unplanned Equipment Production Loss in 
percentage terms due to bad quality

Equipment Standard Efficiency Standard efficiency of the equipment in 
Percentage 

 Equipment Standard Utilization Standard Utilization of Equipment in 
Percentage

Resource Standard Efficiency Standard efficiency of the Resource in 
Percentage 

Resource Standard Utilization Standard Utilization of Resource in Percentage

Overall Equipment Effectiveness Overall Equipment Effectiveness

Performance Area: Schedule Adherence

KPI Description

Performance to schedule % Actual production compared to Scheduled 
production 

Production to Schedule linearity (Actual vs 
Schedule) Applies to Lean

Difference between actual and scheduled 
production measured on a linearity scale of 1 

Shift Scheduled Production Production Scheduled for the current shift

Shift Actual Production Actual Production for the current shift 

Total Production $ (Production Reporting) The cost value of total production 
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KPI Description

Remaining Shift Time (Hours) Remaining hours of production for current 
shift 

Work remaining for the Shift Cost value of Open Work orders meant to be 
produced in the given shift 

Production Backlog Value Cost value of Open Work orders meant to be 
produced in the given period 

Production Backlog Hours The number of hours required to complete the
remaining backlog production for the period 

Actual Completion Quantity Actual completed quantity without reject or 
scrap

Equipment Scheduled Quantity Planned completion quantity for the 
equipment 

Equipment Standard Rate Equipment Standard production rate in units 
per hour

Performance Area: Plant Maintenance

KPI Description

Equipment Downtime % Equipment Downtime Compared to 
Equipment Scheduled Time 

Equipment Scheduled Time (Hours) Scheduled Availability Time based on 
Equipment Shift Availability

Performance Area: Quality

KPI Description

First Pass Yield Percentage of the total production that is good
the first time itself without rejection or scrap 
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KPI Description

Bad Output % Percentage of the total production that is 
rejected 

Scrap % Percentage of the total production that is 
scrapped 

Rework % Percentage of the total production that is 
reworked

Equipment First Time Good Quantity Equipment Output Quantity that has not been
reworked or scrapped 

Equipment Output Quantity Total Equipment output quantity including 
good and bad quantities

Equipment Scrapped Quantity Equipment Scrapped Quantity 

Equipment Reworked Quantity Equipment Reworked Quantity 

Equipment Rejected Quantity Equipment Rejected Quantity

Performance Area: Agility and Responsiveness

KPI Description

Flexibility Ratio The ratio of actual daily production to the 
average daily production 

Actual Completion Quantity Completed quantity from the equipment 
without rework or scrap

Performance Area: Work Order

KPI Description

Work Order Schedule Number Work Order Schedule Number
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KPI Description

Work Order Status  Work Order Status 

Work Order Type Work Order Type

Performance Area: Production Performance

KPI Description

Average Cycle Time Average Cycle time for an Equipment to 
process a Work Order Operation in a Shift 

Cycle Time Cycle Time for an Equipment to process a 
Work Order Operation in a Shift

Down Time during Cycle Down Time during Cycle 

Idle Time during Cycle Idle Time during Cycle 

Run Time during Cycle Run Time during Cycle
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Performance Area: Sustainability Performance

KPI Description

Sustainability Aspect Sustainability Aspect is a generic name used 
for continuous inputs consumed by 
companies in order to be able to operate and 
create goods or services. Common examples 
of sustainability aspect are electricity, gas, oil, 
water, helium etc. Sustainability aspects 
always have associated costs for companies 
and are often source of harmful emissions to 
environment. Companies usually monitor 
consumption of sustainability aspects and 
make efforts to minimize them for efficiency 
and environmental concerns. Sustainability 
aspect must be used along with other KPIs for 
creating a query in OBIEE answers, in order to
constraint the result of the query to the 
sustainability aspect of interest.

Consumption Actual sustainability aspect consumed by an 
entity. For instance, an electric meter measures
electricity consumption readings of the entity. 
The meter readings are collected for a 
specified time frequency and transferred to 
MOC, which then calculates the consumption 
on an hourly basis. Consumption can be rolled
up from an hour to a shift, day, month, and 
year.

Planned Consumption Planned sustainability aspect consumed by an 
entity. For instance, electricity planned to be 
consumed is entered in MOC and can be 
rolled up to a quarter or a year.

Consumption (Last Year) Actual sustainability aspect consumed by an 
entity in a specified period of the previous 
year.

Consumption % Change (Plan) Percentage deviation of actual from planned 
electricity consumption and is calculated as 
Actual Electricity Usage - Planned Electricity 
Usage x 100/ Planned Electricity Usage
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KPI Description

Consumption % Change (Last Year) Percentage deviation of actual consumption in
a specific period of the current year from that 
of the last year and is calculated as 
Consumption % Change (Last Year) = (Actual 
Consumption - Last Year's Actual 
Consumption) x 100/ Last Year's Actual 
Consumption.

Production Output Production output for an equipment, 
production line, area, floor, or a department 
expressed in the Primary UOM of the product.
The production output higher than equipment
level is calculated as the sum of the output of 
all work orders for a specific product.

Production Output Value Value of the production output for an 
equipment, production line, area, floor, or a 
department.

Consumption Per Unit Area Actual consumption of an entity normalized 
by total area of that entity. This is calculated 
as Consumption per Unit Area = Actual 
Consumption of Entity/Effective Surface Area 
of Entity

Consumption Per Person Actual consumption of an entity normalized 
by total number of persons of that entity. This 
is calculated as Consumption per Person = 
Consumption of Entity/Number of Persons.

Consumption per Unit Area (Last Year) Actual consumption of an entity normalized 
by total area of that entity in a specified period
of the previous year.

Consumption per Person (Last Year) Actual consumption of an entity normalized 
by total persons of the entity in a specified 
period of the previous year.

Emission Actual emissions based on actual 
sustainability consumption. 
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KPI Description

Planned Emission Planned emissions based on sustainability 
aspect consumption. It is calculated at every 
level in the entity hierarchy where data is 
available. This is calculated as Emission = 
Emission Factor x Planned Consumption.

Emissions (Last Year) Emission (Last Year) Emissions based on 
sustainability aspect consumed by an entity in
a specified period of the previous year.

Emission % Change (Plan) Percentage deviation of actual from planned 
emissions and is calculated as Emission % 
Change (Plan) = (Actual Emission - Planned 
Emission) x 100/ Planned Emission.

Emission % Change (Last Year) Percentage deviation of actual emission in a 
specific period of the current year from that of
the last year and is calculated as Emission % 
Change (Last Year) = (Actual Emission - Last 
Year's Actual Emission) x 100/ Last Year's 
Actual Emission.

Emission per Unit Area Actual emission of an entity normalized by 
total area of that entity. This is calculated as 
Emission per Unit Area = Actual Emission of 
Entity/Effective Surface Area.

Planned Emission per Unit Area Planned emission of an entity normalized by 
total area of that entity. This is calculated as 
Emission per Unit Area = Planned Emission of
Entity/Effective Surface Area.

Emission per Person Actual emission of an entity normalized by 
total persons of that entity. This is calculated 
as Emission per Person = Emission of 
Entity/Number of Persons.

Planned Emission per Person Planned emission of an entity normalized by 
total persons of that entity. This is calculated 
as Emission per Person = Emission of 
Entity/Number of Persons.
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KPI Description

Emission per Unit Area (Last Year) Actual emission of an entity normalized by 
total area of that entity in a specified period of 
the previous year.

Emission per Person (Last Year) Actual emission of an entity normalized by 
total persons of the entity in a specified period
of the previous year.

Cost Cost of the actual sustainability aspect 
consumed by an entity.

Planned Cost Cost of the actual sustainability aspect 
planned to be consumed by an entity.

Cost (Last Year) Cost of the actual sustainability aspect 
consumed by an entity in a specified period of
the previous year.

Cost % Change (Plan) Percentage deviation of the actual Cost from 
Planned cost and is calculated as Cost % 
Change (Plan) = (Cost- Planned Cost) x 100/ 
Planned Cost.

Cost % Change (Last Year) Percentage deviation of actual cost in a 
specific period of the current year from that of
the last year and is calculated as Cost % 
Change (Last Year) = (Cost - Last Year's Cost) 
x 100/ Last Year's Cost.

Planned Cost per Unit Area Planned cost of sustainability aspect to be 
consumed by an entity normalized by total 
area of that entity. This is calculated as 
Planned Cost per Unit Area = Planned Cost of 
Entity/Effective Surface Area.

Cost per Unit Area Cost of sustainability aspect consumed by an 
entity normalized by total area of that entity. 
This is calculated as Cost per Unit Area = Cost 
of Entity/Effective Surface Area.
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KPI Description

Planned Cost per Person Planned cost of sustainability aspect to be 
consumed by an entity normalized by total 
number of persons of that entity. This is 
calculated as Planned Cost per Person = 
Planned Cost of Entity/Number of Persons.

Cost per Person Cost of sustainability aspect consumed by an 
entity normalized by total number of persons 
of that entity. This is calculated as Cost per 
Person = Cost of Entity/Number of Persons.

Cost per Unit Area (Last Year) Cost of sustainability aspect consumed by an 
entity normalized by total area of that entity in
a specified period of the previous year.

Cost per Person (Last Year) Cost of sustainability aspect consumed by an 
entity normalized by total number of persons 
of that entity in a specified period of the 
previous year.

Total Consumption By Direct Usage Actual sustainability aspect consumed by an 
entity for production purposes. For example, 
conveyor, robot, assembly station, automated 
storage/retrieval system, air compressor, and 
industrial lighting etc.

Total Consumption By Indirect Usage Actual sustainability aspect consumed by an 
entity for functions other than production, 
such as research and development, sales and 
marketing etc. For example, air compressor, 
equipment, maintenance equipment, and 
lighting.

Overall Consumption Actual sustainability aspect consumed by an 
entity by direct and indirect usages.



Manufacturing Operations Center Catalog    7-17

Performance Area: Production Sustainability Performance

KPI Description

Consumption Per Production Output Actual sustainability aspect consumed by an 
entity for the production of one unit of 
production output. This is calculated as 
Consumption Measurements for Production 
of a Product in a Period/Units Manufactured 
in Period.

Consumption Per Production Value Actual sustainability aspect consumed by an 
entity for the production of the value of one 
unit of production output. This is calculated 
as Consumption Measurements for 
Production of a Product in a Period/Value of 
Units Manufactured in Period.

Emission Per Production Output Emission based on actual sustainability aspect 
consumed by an entity for the production of 
one unit of production output. This is 
calculated as Emission Measurements for 
Production of a Product in a Period/Units 
Manufactured in Period.

Emission Per Production Value Emissions based on actual sustainability 
aspect consumed by an entity for the 
production of the value of one unit of 
production output. This is calculated as 
Emission Measurements for Production of a 
Product in a Period/Value of Units 
Manufactured in Period.

Cost Per Production Output Cost of actual sustainability aspect consumed 
by an entity for the production of one unit of 
production output. This is calculated as Cost 
of Sustainability Aspect Consumed for 
Production of a Product in a Period/Units 
Manufactured in Period.
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KPI Description

Cost Per Production Value Cost of actual sustainability aspect consumed 
by an entity for the production of the value of 
one unit of production output. This is 
calculated as Cost of Sustainability Aspect 
Consumed for Production of a Product in a 
Period/Value of Units Manufactured in 
Period.

Performance Area: Equipment Sustainability Analysis

KPI Description

Total Consumption (TC) Sum of Value Added Consumption and Non 
Value Added Consumption.

Value Added Consumption (VAC) Actual sustainability aspect consumed by an 
entity in the RUN status. This is applicable to 
production entities only.

Non Value Added Consumption Actual sustainability aspect consumed by an 
entity in the IDLE, DOWN, or OFF statuses. 
This is applicable to production entities only.

Value Added Consumption% Percentage of the Value Added Consumption 
per the Total consumption for an entity. This 
can be calculated as (VAC X 100) / TC.

Dimensions

The KPIs in the performance areas can be analyzed by the dimensions seeded in the 
MOC Catalog. Each of the following dimension folders contain the dimensions, 
hierarchies and attributes to analyze the KPIs

• Attribute Group Metadata

• Down Time Reason 

• Entity

• Equipment 

• Equipment Attributes Data 
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• Equipment Standard Rate 

• Item 

• Plant

• Scrap Reason 

• Shift 

• Sustainability Aspect

• System 

• Time

• Time - Period To Date

• Time - Transaction Date

• Time Sustainability

• Time - Work Order Actual Completion Date

• Time - Work Order Actual Start Date

• Time - Work Order Planned Completion Date

• Time - Work Order Planned Start Date

• Time - Ad hoc

• Work Order

• Work Order Segment

• Work Order Sub Segment

Oracle Business Intelligence (BI)
The MOC Catalog is based on the analytics layer of the Oracle Business Intelligence (BI) 
platform from Oracle Fusion Middleware. The catalog uses this technology to organize 
data to analyze and provide the metrics required for measuring in the your business. 
The catalog interface consists of the Oracle BI Presentation Services and the MOC 
application. The interface is organized into pages with the following components: 
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• Answers

The Manufacturing Hub Catalog displays on this page and enables you to build 
and modify reports of the information gathered in your system. The data can be 
presented in charts, tables, and reports. 

• Panes

The Answers page contains two panes. The selection pane is used to navigate, 
select, and manage saved information; the display pane shows the content selected.

Columns in the selection pane are used to choose data for your request. To run a 
request, specify at least one column. A filter mechanism is available to restrict the 
result output. 

• Tabbed Regions

The tabbed regions in the catalog are:

• Criteria provides access to the columns selected for the request.

• Results enables you to work with the results of the request. 

• Prompts enables you to create prompts to filter the request. 

If you do not want Null values in the prompts in dashboards, then set 
instanceConfig setting ShowNullValueWhenColumnIsNullable as Never as 
follows:
<Prompts><ShowNullValueWhenColumnIsNullable>never</ShowNullValueW
henColumnIsNullable></Prompts>



Manufacturing Operations Center Catalog    7-21

• Advanced enables you to work with the XML and logical SQL for the request.

• Dashboards

Accesses the dashboards used to display reports containing content you have set 
up. You can create custom dashboards with specific information, and access the 
Plant Manager Dashboard and Facilities Manager Dashboard from this page. 

• More Products

Accesses Oracle BI Publisher, Delivers, Marketing, and Disconnected Analytics.

• Settings

Accesses the Administration and the My Account pages. Administration displays 
the BI Presentation Services to setup control and issue requests. The My Account 
page enables you to view general account information and set your preferences for 
the BI application.

Related Topics
Using the MOC Catalog, page 7-22

Overview of Oracle BI for End Users, Oracle Business Intelligence Answers, Delivers, and 
Interactive Dashboards User Guide

Performing Common Tasks in Oracle BI, Oracle Business Intelligence Answers, Delivers, 
and Interactive Dashboards User Guide

Using the Oracle BI My Account Page, Oracle Business Intelligence Answers, Delivers, and 
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Interactive Dashboards User Guide

Using the MOC Catalog
More than eighty KPIs are grouped in the Manufacturing Hub Catalog selection pane. 
These provide an aggregate level analysis on KPIs and enable you to drill down to 
detailed analysis.

To select catalog data for reporting:
1. Navigate to the MOC Catalog and select the Answers link.

The Answers page contains two panes. The selection pane contains the 
Manufacturing Hub Catalog columns you select. The display workspace shows the 
columns selected for the request. 

2. In the Selection pane, expand the specific columns for the areas you want on your 
report. 

Columns indicate the columns of data that your request will return. 

3. Select details in the performance areas you want displayed on the report.

Choices selected appear in the display workspace in the Criteria tabbed region.

The Criteria tab is used to view or change the columns and filters for the request. 
You can specify the order in which the results display, column subtotals, 
formatting, formulas. For each selection you can format the column data using the 
following:

• Value Format to override default settings such as font type and size

• Edit Formula to change the formula for the column. 

See: Using Column Formatting Functions in Oracle BI Answers, Oracle Business 
Intelligence Answers, Delivers, and Interactive Dashboards User Guide

4. You have the option to control the output display by creating a filter. Choose the 
Create/Edit Filter icon to create a filter expression to display as a CASE statement.

You can save this filter for other reports. See: Editing the Formula of a Column, 
Oracle Business Intelligence Answers, Delivers, and Interactive Dashboards User Guide

5. Select Display Results or the Results tabbed regions to display your report. 

You can choose several different display views, and combine views and arrange 
them for display on the Plant Manager, Facilities Manager, and Ad hoc Dashboards.

6. To combine the results of multiple requests, choose Select Combine with Similar 
Requests.
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8
Plant Manager Dashboard

This chapter covers the following topics:

• Overview of the Plant Manager Dashboard

• Equipment Performance (OEE)

• Equipment Performance (OEE) by Equipment

• Equipment Runtime Analysis

• Runtime Reasons Report

• Equipment Downtime Analysis

• Equipment Downtime Reasons

• Production Slippage Trend

• Equipment Scrap Analysis

• Equipment Scrap Reasons

• Equipment Efficiency Analysis

• Equipment Efficiency Detail

• Equipment Idletime Analysis

• Equipment Idletime Reasons

• Production Loss Analysis

• Production Loss Detail

• Batch Performance

• Batch Performance Detail

• Production Performance

• Sustainability Performance by Department

• Sustainability Performance by Equipment 

• Sustainability Performance Equipment Hourly Summary Page
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• Sustainability Performance Equipment Hourly Detail Page

Overview of the Plant Manager Dashboard
Overall Equipment Effectiveness (OEE) is a key metric that every plant manager 
monitors. The Plant Manager Dashboard provides a complete view of the equipment 
and helps the plant manager to assess where the source for production losses occur. The
Plant Manager Dashboard and integrated reports provide the plant manager views of 
the production data for the plant in terms of overall equipment effectiveness, batch 
performance, schedule adherence, and production loss analysis for the departments and
equipment on the shop floor

Oracle Manufacturing Operations Center collects data from disparate sources into this 
single role-based dashboard that allows Plant Managers and staff to view 
manufacturing operations efficiently and effectively. The open and flexible BI 
technology from Oracle Fusion Middleware makes it easy to build and modify KPIs and
dashboards.

The Plant Manager Dashboard lets you report and analyze electricity consumption, 
electricity cost, and carbon emission for an entity You can view information for all the 
levels of entity hierarchy, plant, department, floor, floor section, and equipment.

The following table identifies the dashboard pages and the reports made available to 
the Plant Manager role:

Dashboard Pages Reports

Equipment Performance (OEE) Overall Equipment Effectiveness by Plant

Overall Equipment Effectiveness By Department 
(Bottom Performers)

Overall Equipment Effectiveness Details By Plant

Overall Equipment Effectiveness Details By 
Department

Overall Equipment Effectiveness Trend by Plant

Overall Equipment Effectiveness Trend by 
Department

OEE by Equipment Overall Equipment Effectiveness by Department
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Dashboard Pages Reports

Overall Equipment Effectiveness by Equipment 
(Bottom Performers)

Overall Equipment Effectiveness Details by 
Department

Overall Equipment Effectiveness Details by 
Equipment

Overall Equipment Effectiveness Trend by 
Department

Overall Equipment Effectiveness Trend by 
Equipment

Equipment Downtime Analysis Equipment Downtime Analysis

Machine Availability Ratio Trend

Equipment Downtime Reasons Downtime Reasons

Production Slippage Trend Production Slippage Trend

Production Loss Analysis Production Loss Distribution

Effective Production Capacity

Production Loss Analysis

Production Loss Detail Production Loss Detail

Equipment Efficiency Analysis Equipment Efficiency Analysis

Equipment Performance Ratio Trend

Equipment Efficiency Detail Equipment Efficiency Detail

Equipment Scrap Analysis Equipment Scrap Analysis

First Pass Yield Trend
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Dashboard Pages Reports

Equipment Scrap Reasons Equipment Scrap Reasons

Batch Performance Production Variance by Product Category

Production Variance by Product

PPM Trend (Month to Date)

Batch Cycle Time Trend (Month to Date)

Service Level Performance by Product Category

Service Level Performance by Product

Batch Performance Detail Batch Performance Detail

Production Performance Performance to Schedule Measures by Plant

Performance to Schedule Measures by Department

Performance to Schedule Measures by Equipment 
(Bottom Performers)

Production Slippage (Equipment)

Current Month Production Slippage Trend by 
Department

Current Month Production Slippage Trend by 
Equipment

Sustainability Performance Electricity Consumption

Electricity Cost

CO2 Emission

Production Value Analysis by Product

Trend
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Dashboard Pages Reports

Ranking and Distribution

Equipment Performance (OEE)
The Equipment Performance page provides performance data for the plant and displays
the bottom four departments performance in terms of Overall Equipment Effectiveness 
(OEE) measures. It displays Machine Availability Ratio, Machine Performance Ratio, 
and First Pass Yield. Equipment Performance (OEE) reporting regions include:

• Overall Equipment Effectiveness by Plant

• Overall Equipment Effectiveness by Department (Bottom Performers)

• Overall Equipment Effectiveness Details by Plant

• Overall Equipment Effectiveness Details by Department

• Overall Equipment Effectiveness Trend by Plant

• Overall Equipment Effectiveness Trend by Department

You can view Equipment Performance (OEE) by the following dimensions:

• Time dimension – Year, Quarter, Month, Day, and Shift

• Equipment dimension – Plant

To view equipment performance (OEE):
1. From the Manufacturing Operations Center User responsibility, select the Plant 

Manager Dashboard. The Equipment Performance (OEE) page appears. This page 
displays Overall Equipment Effectiveness, Overall Equipment Effectiveness Details,
and Overall Equipment Effectiveness Trend regions.
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2. Scroll down the Equipment Performance (OEE) page to view:

• Overall Equipment Effectiveness By Plant

• Overall Equipment Effectiveness By Department (Bottom Performers)

• Overall Equipment Effectiveness Details By Plant

• Overall Equipment Effectiveness Details By Department

• Overall Equipment Effectiveness Trend By Plant

• Overall Equipment Effectiveness Trend By Department
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From the Equipment Performance (OEE) page, you can navigate to other pages to 
view additional manufacturing operations details.

Related Topics
Asset Performance (OEE) by Equipment, page 8-7

Equipment Performance (OEE) by Equipment
The Asset Performance page provides performance data for equipment and displays the
bottom four equipment performance in terms of Overall Equipment Effectiveness (OEE)
measures. It displays Machine Availability Ratio, Machine Performance Ratio, and First 
Pass Yield. Reporting regions include:

• Overall Equipment Effectiveness by Department

• Overall Equipment Effectiveness by Equipment (Bottom Performers)

• Overall Equipment Effectiveness Details by Department

• Overall Equipment Effectiveness Details by Equipment

• Overall Equipment Effectiveness Trend by Department

• Overall Equipment Effectiveness Trend by Equipment

You can view OEE by Equipment by the following dimensions:

• Time dimension – Year, Quarter, Month, Day and Shift

• Equipment dimension – Plant and Department

To view OEE by Equipment:
1. From the Equipment Performance (OEE) page, click on a Department gauge in the 

Overall Equipment Effectiveness By Department (Bottom Performers) region. For 
example, click on the Paint Shop (SM1) gauge to drill down and display details of 
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low OEE contribution. The OEE by Equipment page displays the Overall 
Equipment Effectiveness (OEE) for Equipment belonging to the Paint Shop 
department.

2. Scroll down the page to view Overall Equipment Effectiveness Details by 
Department and by Equipment regions. The page displays Machine Availability 
Ratio, Machine Performance Ratio, and First Pass Yield by Department and by 
Equipment.

3. Change the View by to: Table

4. Select a link in the Machine Availability column to view Equipment Downtime 
details. See: Equipment Downtime Analysis, page 8-12, and Equipment Downtime 
Reasons, page 8-13.

5. Scroll further to view Overall Equipment Effectiveness Trend by Department and 
by Equipment regions.
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Related Topics
Asset Performance (OEE), page 8-5

Equipment Runtime Analysis
The Equipment Runtime Analysis page enables you to analyze the run time 
transactions by run time reasons. Reason codes are associated with equipment run time 
status in addition to downtime status, idle status, and scrap. Equipment Runtime 
Analysis dashboard allows you to analyze run time transactions by run time reasons.

This report enables you to analyze the run time transactions by run time reasons and to 
view the run time transactions with the following dimensions:

• Time dimension – Year, Quarter, Month, Day, and Shift.

• Equipment dimension – Plant, Department, and Equipment.

To view equipment runtime analysis report
1. Navigate to the Equipment Runtime Analysis page from the OEE By Equipment 

page to view the equipment run time details.

2. Click the Production Loss Analysis link.

3. Click the Equipment Runime Analysis link.
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Equipment Runtime Analysis page displays the following reports:

1. Equipment Runtime Analysis Pie Chart:

• Displays breakup of run time by reason codes for an equipment for a selected 
time period.

2. Machine Runtime Trend Chart:

• Displays date-wise trend of run time for the equipment for a selected time 
period.

3. Equipment Runtime Reason Trend Chart:

• Displays breakup of run time reasons in a date-wise trend in hours for the 
equipment for a selected time period.

4. Equipment Runtime Analysis Tabular Report:

• Shows Equipment Calendar Time (Hours), Equipment Schedule Time (Hours), 
Production Loss - Planned (Hours), Actual Down Time (Hours), Production 
Loss (Hours), Actual Available Time (Hours), Actual Run Time (Hours) for the 
equipment for a selected time period.
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Runtime Reasons Report
Runtime reasons report enables you to view the run time reasons for a particular shift 
selected in the Runtime Analysis report by the following dimensions:

• Time dimension – Year, Quarter, Month, Day, and Shift.

• Equipment dimension - Plant, Department, and Equipment.

Click on the Actual Run Time (Hours) column value in the Equipment Runtime 
Analysis tabular report to navigate to the Runtime Reasons page.
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Equipment Downtime Analysis
You can use the Equipment Downtime Analysis page to analyze the equipment 
downtime by downtime reasons. Reporting regions include:

• Equipment Downtime Analysis

• Machine Availability Ratio Trend

• Equipment Downtime Detail

You can view equipment downtime by the following dimensions:

• Time dimension – Year, Quarter, Month, and Day

• Equipment dimension – Plant, Department, and Equipment

To view equipment downtime details:
1. From the OEE by Equipment page, you can navigate to the Equipment Downtime 

Analysis page to view equipment downtime details. Scroll down to Overall 
Equipment Effectiveness Details by Equipment region.

2. Change the View by to: Table

3. Select a link from the Machine Availability column.

4. The Equipment Downtime Analysis page appears. This page displays Equipment 
Downtime Reasons and Machine Availability Ratio Trend graphs.
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5. Scroll down this page to view daily details of equipment downtime information.

6. Select the OEE by Equipment link to return to that page.

Related Topics
Equipment Downtime Reasons, page 8-13

Equipment Downtime Reasons
The Equipment Downtime Reasons report lets you view the downtime reasons for a 
particular day selected from the Equipment Downtime Analysis page. The report 
displays Downtime Hours and Reasons for the equipment by Shift level for the day.

To view Equipment Downtime Reasons:
1. Navigate to the Equipment Downtime Analysis page and scroll down to the 

Equipment Downtime details region.

2. Select a link from the Actual Down Time (Hours) column. The Downtime Reasons 
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page appears and displays Equipment Downtime reasons by Shift for the day.

3. Click the Return link to return to the Equipment Downtime Analysis page.

Related Topics
Equipment Downtime Analysis, page 8-12

Production Slippage Trend
The Production Slippage Trend report displays the production slippage and trend by 
equipment and shift for a monthly period.

To view Production Slippage Trend:
1. Navigate to the Equipment Downtime Analysis page and scroll down to the 

Equipment Downtime details region.

2. Select a link from the Production Slippage Report column. The Production Slippage 
page appears. The page displays production slippage measures and trend by 
equipment and shift for a month period.
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Related Topics
Production Performance, page 8-29

Equipment Scrap Analysis
You can use the Equipment Scrap Analysis page to analyze the scrap transactions by 
scrap reasons. Reporting regions include:

• Equipment Scrap Analysis

• First Pass Yield Trend

• Equipment Scrap Detail

You can view scrap transactions by the following dimensions:

• Time dimension – Year, Quarter, Month and Day

• Equipment dimension – Plant, Department, and Equipment

To view Equipment Scrap Analysis:
1. Navigate to the OEE by Equipment page.

2. Scroll down to the Overall Equipment Effectiveness Details - By Equipment region.

3. Change the View by to: Table
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4. Select a value in the First Pass Yield column. The Equipment Scrap Analysis page 
appears where you can view quality details. This page displays Equipment Scrap 
Analysis and First Pass Yield Trend graphs. 

5. Scroll down the page to view Scrap Details.

6. Select the OEE by Equipment link to return to that page.

Related Topics
Equipment Scrap Reasons, page 8-17
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Equipment Scrap Reasons
The Scrap Reasons report lets you view the scrap reasons for a particular day. Select 
Scrap Reasons from the Equipment Scrap Analysis page. The report displays the Scrap 
Quantity and Reasons for the equipment at shift level for the day.

To view Equipment Scrap Reasons:
1. Navigate to the Equipment Scrap Analysis page.

2. Scroll down to the Equipment Scrap Analysis Details region.

3. Select a value in the Scrapped Quantity column to view scrap details and reasons by
shift for the day. The Scrap Reasons report appears.

4. Select the Return link to return to the Equipment Scrap Analysis page.

Related Topics
Equipment Scrap Analysis, page 8-15

Equipment Efficiency Analysis
The Equipment Efficiency Analysis page displays production loss due to inefficiency of 
the equipment. Reporting regions include:
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• Equipment Efficiency Analysis

• Machine Performance Ratio Trend

• Equipment Efficiency Detail

You can view Equipment Efficiency Analysis by the following dimensions:

• Time dimension – Year, Quarter, Month, and Day

• Equipment dimension – Plant, Department, and Equipment

To view the Equipment Efficiency Analysis page:
1. Navigate to the OEE by Equipment page.

2. Scroll down to the Overall Equipment Effectiveness Details by Equipment region.

3. Change View by to: Table.

4. Select a value from the Machine Performance column for an equipment item. The 
Equipment Efficiency Analysis page appears. This page displays and reports the 
production loss due to inefficiency.
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5. Scroll down the page to view Equipment Efficiency Details.

6. Select the OEE by Equipment link to return to that page.

Related Topics
Production Loss Analysis, page 8-23

Equipment Efficiency Detail, page 8-19

Equipment Efficiency Detail
The Equipment Efficiency Detail report lets you view the Equipment Efficiency for a 
particular day, and is selected from the Equipment Efficiency Analysis report. The 
report displays the Efficiency for the equipment at shift level for the day.

To view Equipment Efficiency Detail:
1. Navigate to the Equipment Efficiency Analysis page.

2. Scroll down the page to the details region.
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3. Select a value in the Machine Efficiency column. The Equipment Efficiency Details 
report appears.

4. Select the Return link to return to the Equipment Efficiency Analysis page.

Related Topics
Equipment Efficiency Analysis, page 8-17

Equipment Idletime Analysis
You can use the Equipment Idletime Analysis page to analyze the equipment idletime 
by idletime reasons. The reporting regions include:

• Equipment Idletime Analysis.

• Equipment Idletime Trend.

• Equipment Idletime Detail.

You can view equipment idletime with the following dimensions:

• Time dimension - Year, Quarter, Month, and Day.

• Equipment dimension - Plant, Department, and Equipment.

To view equipment idletime details:
1. Navigate to the Equipment Idletime Analysis link from the OEE by Equipment 

page to view equipment idletime details.

2. Click on Production Loss Analysis link.

3. Select Equipment Idletime Analysis link.
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The Equipment Idletime Analysis page appears. This page displays Equipment 
Idletime Reasons and Equipment Idletime Trend graphs.

4. Scroll down this page to view daily details of equipment idletime information.
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5. Select the OEE by Equipment link to return to that page.

Related Topics
See: Equipment Idletime Reasons, page 8-22.

Equipment Idletime Reasons
The Equipment Idletime Reasons report enables you to view the idletime reasons for a 
particular day selected from the Equipment Idletime Analysis page. The report displays
idletime hours and reasons for the equipment at Shifts level for a day.

To view equipment idletime reasons:
1. Navigate to the Equipment Idletime Analysis page and scroll down to the 

Equipment Idletime details region.

2. Select a link from the Idle Reason column. The Idletime Reasons page appears and 
displays equipment idletime reasons by Shift for the day.

3. Click the Return link to return to the Equipment Idletime Analysis page.
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Related Topics
See: Equipment Idletime Analysis, page 8-20.

Production Loss Analysis
You can use the Production Loss Analysis page to analyze production loss by 
equipment. Reporting regions include:

• Production Loss Distribution

• OEE Time Analysis

• Production Loss Analysis

You can view Production Loss by the following dimensions:

• Time dimension – Year, Quarter, Month, and Day

• Equipment dimension – Plant, Department, and Equipment

To view Production Loss Analysis:
1. Navigate to the OEE by Equipment page.

2. Select the Production Loss Analysis link. The Production Loss Analysis page 
appears.
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3. The page displays the distribution of production loss as well as the OEE time 
metrics for the equipment.

4. The page provides the Production Loss detail and can be defined as: 

• Planned

• Unplanned

• Due to Other Reasons

• Due to Inefficiency

• Due to Bad Quality

5. Scroll down the page to view Production Loss Analysis. This includes Total 
Production Loss in hours and Overall Effective Run Time in hours.

6. You can view the Production Loss Detail page by selecting a value in the Total 
Production Loss column and analyze the Production Loss by day and shift.
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7. Select the OEE by Equipment link to return to that page.

Related Topics
Production Loss Detail, page 8-25

Production Loss Detail
The Production Loss Detail page lets you view the Production Loss for a particular day, 
and is selected from the Production Loss Analysis page. The page displays the 
Production Loss and details for the equipment at the shift level for the day.

You can view Production Loss Detail page by the following dimensions:

• Time dimension – Year, Quarter, Month, Day and Shift

• Equipment dimension – Plant, Department, and Equipment

To view Production Loss Detail:
1. Navigate to the Production Loss Analysis page and scroll down to the Production 

Loss Analysis region.

2. Select a value in the Total Production Loss column to analyze the Production Loss 
by day and shift. The Production Loss Detail page appears.
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3. This report displays the Production Loss detail as well as the OEE Time Analysis 
for equipment.

4. Select the Return link to return to the Production Loss Analysis page.

Related Topics
Production Loss Analysis, page 8-23

Batch Performance
The Batch Performance page displays performance metrics that include Work Order 
Quantity Variance, PPM, Batch Cycle Time Trend, and Service Level Performance. 
Reporting regions include:

• Production Variance by Product Category

• Production Variance by Product

• PPM Trend (Month to Date)

• Batch Cycle Time Trend (Month to Date)

• Service Level Performance by Product Category

• Service Level Performance by Product

You can view Batch Performance by the following dimensions:

• Time dimension – Year, Quarter, Month, and Day

• Equipment dimension – Plant and Product Category
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To view Batch Performance:
1. Navigate to the Batch Performance page to view production variance. You can view

production variance by Product Category and by Product.

2. In the Production Variance By Product region, you can click on a Work Order 
Quantity Variance Percent bar within the bar graph to view work order 
contributing details.

3. Scroll down the Batch Performance page to view PPM Trend (Month to Date) and 
Batch Cycle Time Trend (Month to Date) regions.

4. Continue to scroll down the page to also view Service Level Performance by 
Product Category and by Product.
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Related Topics
Batch Performance Detail, page 8-28

Batch Performance Detail
The Batch Performance page allows you to navigate to the Batch Performance Detail 
page. From the Batch Performance Details page, you can view details of specific work 
orders that are contributing to the production variance.

To view Batch Performance Detail:
1. Navigate to the Batch Performance page.

2. In the Production Variance By Product region, you can click on a Work Order 
Quantity Variance Percent bar within the bar graph to view work order 
contributing details. The page displays details of work orders that contribute to the 
production variance for the product.
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3. Select the Batch Performance link at the bottom of the page to navigate back to the 
Batch Performance page.

Related Topics
Batch Performance, page 8-26

Production Performance
The Production Performance page provides the performance to schedule measures by 
plant, department, and bottom performing equipment. It also displays production 
slippage in comparison to different shifts and the current month production slippage 
trend. Reporting regions include:

• Performance to Schedule Measures by Plant

• Performance to Schedule Measures by Department

• Performance to Schedule Measures by Equipment (Bottom Performers)

• Production Slippage by Equipment

• Current Month Production Slippage Trend by Department

• Current Month Production Slippage Trend by Equipment

You can view Production Performance by the following dimensions:

• Time dimension – Year, Quarter, Month, Day, and Shift

• Equipment dimension – Plant and Department
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To view Production Performance:
1. Navigate to the Production Performance page. The page displays Performance to 

Schedule Measures By Plant, By Department, and By Equipment Bottom 
Performers.

2. Scroll down the Production Performance page to view the Production Slippage 
(Equipment) region.

3. You can scroll down the page further to view Current Month Production Slippage 
Trend by Department and by Equipment.
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Related Topics
Production Slippage Trend, page 8-14

Sustainability Performance by Department
The Sustainability Performance by Department page displays the electricity 
consumption, electricity cost, and carbon emission for all departments in a plant.

 To view the Sustainability Performance by Department page :
1. Navigate to the Plant Manager dashboard using the Manufacturing Operations 

Center User responsibility. Select the Sustainability Aspect tab.

2. Select the time period for which you want to view the details. Choose the Year, 
Quarter, Period, Week, and Date. All Choices displays as the default value for all 
the time period fields. 

3. Select the Plant for which you want to display the reports. All production sites from
the Site master display in the list of values. The first site in ascending alphabetical 
order of Sites is the default value.

4. Click Go. The Sustainability Performance by Department Appears. The following 
Plant Characteristics display:

• Plant

• Business Function is the business function of the plant.

• Headcount is the number of employees in the plant

• Area is the area of the plant.

• Area UOM is the unit of measure in which Area is expressed.

5. Scroll down the page to view the following reports for each department in the 
plant:

• Electricity Consumption

• Electricity Cost

• CO2 Emission

• Production Value Analysis by Product

• Trend
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• Ranking and Distribution

Electricity Consumption:

• Department is the name of the department of the plant. You can click on a 
department to view reports on the equipment in the department. 

• Business Function is the business function of the department

• Area is the area of the department.

• Headcount is the number of employees working in the department.

• Direct Actual Consumption- Period to Date is the actual electricity consumed 
by the department in a specific time period for production purposes.

• Indirect Actual Consumption- Period to Date is the actual electricity consumed 
by the department in a specific time period for non-production purposes. For 
example, lighting, air-conditioning, and water treatment systems.

• Total Actual Consumption – Period to Date is the sum of Direct and Indirect 
Actual Consumption.

• Plan Consumption- Period to Date is the planned electricity to be consumed by 
the department.

• Last Year Consumption – Period Date is the electricity consumed by the 
department in the same time period of the previous year.

• % Change (Plan) is the percentage deviation of actual consumption from 
planned electricity consumption by the department. A red flag displays when 
the value is more than zero.

• % Change (Last Year) is the percentage deviation of actual electricity usage by 
the department in the period of the current year from that of the last year. A red
flag displays when the value is more than zero.

• Actual Consumption Per Unit Area is the actual electricity consumed per unit 
area of the department. 

• Actual Consumption Per Person is the actual electricity consumed per person in
the department. 

• Electricity Consumption UOM is the unit of measure in which electricity 
consumption is expressed. 

• Area UOM is the unit of measure in which the department area is expressed.
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Electricity Cost:

• Actual Cost-Period to Date is the cost of actual electricity consumed by the 
department in a specific time period.

• Plan Cost-Period to Date is the cost of planned electricity to be consumed by the
department in a specific time period.

• Last Year Cost-Period Date is the cost of electricity consumed by the 
department in the same time period of the previous year.

• % Change (Plan) is the percentage deviation of cost of actual electricity 
consumption from planned electricity consumption by the department. A red 
flag displays when the value is more than zero.

• % Change (Last Year) is the percentage deviation of cost of actual electricity 
usage by the department in the period of the current year from that of the last 
year. A red flag displays when the value is more than zero.

• Actual Cost Per Unit Area is the cost of actual electricity consumed per unit 
area of the department.

• Actual Cost Per Person is the cost of actual electricity consumed per person in 
the department.

CO2 Emission

• Actual Emission-Period to Date is the carbon emission based on electricity 
consumption by the department in a specific time period.

• Plan Emission-Period to Date is planned emissions based on electricity 
consumption by the department.

• Last Year Emission-Period Date is emission based on electricity consumed by 
the department in the same time period of the previous year.

• % Change (Plan) is the percentage deviation of actual from planned emissions 
by the department. A red flag displays when the value is more than zero.

• % Change (Last Year) is the percentage deviation of actual emission by the 
department in the period of the current year from that of the last year. A red 
flag displays when the value is more than zero.

• Actual Emission Per Unit Area is the actual emission per unit area of the 
department.

• Actual Emission Per Person is the emission per person in the department.
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Production Value Analysis by Product:

The Production Value Analysis by Product report provides information on the 
actual electricity consumed, cost of electricity consumed, and carbon emissions due 
to the consumption per production output of the department. 

• Product is the product name.

• Production Value is the value of the produced product.

• Actual Electricity Consumption-Period to Date is the actual electricity 
consumed for producing the product.

• Actual Electricity Cost-Period to Date is the cost of the actual electricity 
consumed for producing the product.

• Actual CO2 Emission – Period to Date is carbon emission based on electricity 
consumption by the department in a specific time period.

• Actual Electricity Consumption per Unit Production Value is the actual 
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electricity consumed by the department for the production of the value of one 
unit of production output.

• Actual Electricity Cost Per Unit Production Value is the cost of actual electricity 
consumed by the department for the production of the value of one unit of 
production output.

• Actual CO2 Emission Per Unit Production Value is the CO2 emission based on 
actual electricity consumed by an entity for the production of the value of one 
unit of production output.

• Electricity Consumption UOM is the unit of measure in which the electricity 
consumption is expressed.

• CO2 Emission UOM is the unit of measure in which the CO2 emission is 
expressed.

• Currency UOM is the currency in which the Production Value is expressed.

Trend: 

The Trend graph report provides a graphical representation of the electricity 
consumption, electricity cost, and CO2 emission for:

• All departments in a plant by the Trend by Period-All Departments report.

• Each department in a plant by the Trend by Period-By Department report

To view the trend graph report, select the report you want to view in the Measure 
field from the following options.

• Electricity Consumption

• Electricity Consumption Per Unit Area

• Electricity Consumption Per Person

• Electricity Cost

• Electricity Cost Per Unit Area

• Electricity Cost Per Person

• CO2 Emission

• CO2 Emission Per Unit Area

• CO2 Emission Per Person 
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Ranking and Distribution:

The Ranking and Distribution report provides a graphical representation of the 
department rankings and distributions based on electricity consumption, cost, and 
CO2 emission. 

To view the Ranking and Distribution report select any one of the following KPIs in
the Measure field for which you want to view the report:

• Electricity Consumption

• Electricity Consumption Per Unit Area

• Electricity Consumption Per Person

• Electricity Cost

• Electricity Cost Per Unit Area

• Electricity Cost Per Person

• CO2 Emission

• CO2 Emission Per Unit Area

• CO2 Emission Per Person

Site Ranking report displays the top five departments in the descending order for 
the selected measure.

Distribution by Department report displays the distribution of the selected measure
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across all departments of the plant.

Distribution by Usage Category displays the distribution of the selected measure 
across various usage categories for all departments at the plant, for example, 
electricity consumption for air conditioning, lighting, production equipment etc. 

Sustainability Performance by Equipment 
You can view the electricity consumption, electricity cost, and carbon emission for all 
equipments in a department using the Sustainability Performance by Equipment page.

To view the sustainability performance by equipment page:
1. Navigate to the Sustainability Performance page.

2. Select a department from the Department column of the Electricity Consumption 
report. The Sustainability Performance page by Equipment displays. You can also 
change the time period and the Department for which you want to view the report 
or select All Choices to view the reports for all departments.

3. The following reports display:

• Distribution and Trend region displays the following graph reports:

• Distribution by Usage Categories graph provides the distribution of the 
selected measure across various usage categories for all equipment in the 
department. You can choose to view the report for the Measures, Electricity 
Consumption, CO2 Emission, and Electricity Cost.

• Trend by Period- By Equipment graph provides the trend in electricity 
consumption, CO2 emission, and electricity cost by all equipments in a 
department over a specific time period.



8-38    Oracle Manufacturing Operations Center User's Guide

• Department Summary region displays the following information for the 
department:

• Equipment is the name of the equipment.

• Department is the department in which the equipment is present.

• Scrap % is the percentage of scrap expected for equipment.

• Total Electricity Consumption is the actual electricity consumed by the 
equipment in the RUN, IDLE, DOWN, and OFF statuses.

• Value Added Electricity Consumption is the actual electricity consumed by 
the equipment in the RUN status. 

• Non- Value Added Electricity Consumption is the electricity consumed by 
the equipment in the IDLE, DOWN, or OFF statuses. 

• Value Added Electricity % is the percentage of the Value Added 
Consumption per Total consumption for an entity.

• CO2 Emission is the actual CO2 emission by the equipment.

• Overall Equipment Effectiveness is calculated by multiplying Availability 
Ratio, Performance Ratio, and First Pass Yield for an equipment. 

Sustainability Performance Equipment Hourly Summary Page
You can view the electricity consumption, electricity cost, equipment output, and 
carbon emission for hourly time periods for equipment in a plant using the 
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Sustainability Performance Equipment Hourly Summary Page. 

To view the sustainability performance equipment hourly summary page:
1. Navigate to the Sustainability Performance tab. The Sustainability Performance by 

Department displays.

2. Select a department from the Department column of the Electricity Consumption 
report. The Sustainability Performance page by Equipment displays.

3. Select equipment in the Equipment Summary report. The Sustainability 
Performance by Equipment Hourly Summary displays. You can also change the 
time period and the Equipment for which you want to view the reports or select All
Choices to view the reports for all equipments.

4. The following reports display for the equipment:

• Electricity Consumption Trend report is a graphical representation of the trend 
in electricity consumption of the equipment in hourly time intervals.

• Equipment Output Trend report is a graphical representation of the trend in 
output production and the scrap quantity recorded for the equipment during 
shifts.
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• Parameter Monitoring report is a graphical representation of the measures of 
parameters like temperature and pressure over hourly time periods.

• Equipment Status Trend is a graphical representation of the trend in which an 
equipment is in Idle, Run, Down, and Off statuses over hourly time periods. 
You can choose to display a Bar or Area Graph.

• Equipment Summary report is a tabular representation of the durations for 
which the equipment is in the Idle, Run, Down and Off statuses over hourly 
time periods. 
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Sustainability Performance Equipment Hourly Detail Page
You can view the detailed information on electricity consumption, electricity cost, 
equipment output, and carbon emission for an equipment in a specific hourly time 
period using the Sustainability Performance Equipment Hourly Detail Page.

To view the Sustainability Performance Equipment Hourly Detail page:
1. Navigate to the Equipment Summary region of the Equipment Hourly Summary 

page.

2. Click the From Time to view the equipment detail reports for the equipment within 
a specific hour. The Equipment Hourly Detail page appears.

3. The following reports display for the equipment within the selected hour:

• Electricity Consumption Detail Trend graphically displays the electricity 
consumption by the equipment within the selected hour.

• CO2 Emission Detail Trend graphically displays the carbon emission by the 
equipment within the selected hour.



8-42    Oracle Manufacturing Operations Center User's Guide

• Equipment Status Trend graphically displays the times for which the 
equipment is in the Up, Idle, Down, and Off Statuses within the selected hour.

• Production Output Trend graphically displays the product output quantity and
scrap quantity produced by the equipment within the selected hour.
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9
Process Engineer Dashboard

Overview of Process Engineer Dashboard
The Process Engineer Dashboard enables plant engineers to view the summarized 
information of process parameters and help to answer queries such as the average value
of temperature or pressure running on a particular equipment in the last hour. It also 
allows correlation between equipment output, status and the influencing variables.

From the Process Engineer Dashboard, you can view the reports based on the following 
dimensions:

• Time dimension – Year, Quarter, Month and Day

• Equipment dimension – Plant, Department and Equipment

Parameter Hourly Run Chart
The Parameter Hourly Run Chart report displays the hourly values of the summarized 
extensible attribute. The report can be run for multiple attributes. The Attribute Name 
list of values displays only those attributes that have transaction records.
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Equipment Output - Process Analysis
The equipment output tabular report displays the hourly values of the summarized 
extensible attributes along with the output summary information. The report can be run
for multiple attributes and a specific date. The data from the output summary such as 
the completed quantity, scrap quantity, output quantity, etc, are also displayed for 
correlation between equipment output and process parameters.

Equipment Status - Process Analysis
The equipment status tabular report displays the hourly values of the summarized 
extensible attribute(s) along with status summary information. The report can be run 
for multiple attributes and a specific date. The data from the status summary such as 
Up hours, Down Hours, Idle hours are displayed to correlate data between equipment 
status and process parameters.
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10
Asset Performance Dashboard

Overview of Asset Performance Dashboard
Asset Performance Dashboard provides reporting capabilities for production and 
maintenance assets within an organization. The dashboard displays the reports for the 
shop floor events such as breakdown, excessive scrap, unstable equipment and also 
details of asset status, production performance, output, scrap, and operating 
parameters.

Asset Performance Dashboard is a role-based dashboard for plant managers, providing 
an insight into:

• 360 degree view of equipment performance of production and non-production 
assets.

• Events, asset detail status trend, asset downtime analysis, asset production 
performance, asset output and scrap, and asset operational parameters for 
production assets.

• Events, asset detail status trend, asset downtime analysis, asset operational 
parameters for non-production assets.

It provides the following business values:

• Out-of-box dashboard for monitoring performance of production and 
non-production assets.

• Track equipment events and alarms on shop floor exceptions such as equipment 
down, excessive scrap or unstable equipment.

• Monitor Overall Equipment Effectiveness (OEE).

• Monitor critical process parameters and raise alerts for exceptions.
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• Overall visibility of equipment health in a maintenance organization.

• User friendly tool to create ad hoc reports.

Asset Performance Dashboard shows performance information of a production asset. It 
consists of Production Assets tab and Non-Production Assets tab.

Production Assets 
The Production Asset tab has several sections:

The first section shows the time prompts and the asset prompt that contain only the list 
of production assets. The default value for the time prompt is the previous month.
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The second section shows three charts: OEE By Asset, OEE Breakup by Asset and Asset 
Events. The OEE by Asset chart shows a gauge indicating the OEE value for the selected
production asset. The OEE Breakup chart shows Machine Availability, Machine 
Performance, and First Pass Yield values in a table format or a bar chart where table 
format defaults. You can navigate to the Machine Availability Details page, Machine 
Performance Details page, and First Pass Yield Details page by clicking on the links in 
the respective tables in Machine Availability, Machine Performance, and First Pass 
Yield columns, respectively. The third chart is Asset Events.

Asset Production Performance and Asset Output and Scrap are the two reports that you
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can generate from the third section.

The next section provides two reports such as Asset Details Status Trend and Asset 
Downtime Analysis. The Asset Downtime Analysis pie chart shows the percentage of 
down time by downtime reason. The Machine Availability Ratio Trend chart shows the 
daily values of machine availability ratio ranging from 0% to 100%.

Following are the reports available from the Production Asset page:

• OEE By Asset.

• OEE Breakup by Asset.

• Asset Events.

• Asset Production Performance.

• Asset Output and Scrap.

• Asset Status Trend.

• Asset Downtime Analysis.

• Asset Operation Parameter Trend.

The OEE By Asset chart shows a gauge indicating the OEE value for the selected 
production asset.

The OEE breakup chart shows Machine Availability, Machine Performance, and First 
Pass Yield values in a table format or a bar chart where table format defaults. You can 
drill down into Machine Availability Details page, Machine Performance Details page, 
and First Pass Yield Details page by clicking on the links in the table under Machine 
Availability, Machine Performance, and First Pass Yield columns, respectively.

Asset Events chart displays the details of events triggered for the assets such as time, 
description of events, reasons for the events and event actions. Manufacturing 
Operations Center (MOC) provides two seeded event actions, such as creation of work 
request in Oracle Enterprise Asset Management Application and Mail Notification.

The Asset Production Performance report compares the actual production rate and the 
completion quantity with the scheduled quantity and standard rate.

Asset Output and Scrap report shows the total quantity produced by the production 
asset, rejected quantity, scrap quantity, reworked quantity, and first pass yield.

The Asset Status Trend chart shows trend of run time, idle time, down time and off time
in hours. The Asset Downtime Analysis pie chart shows percentage of down time by 
downtime reasons.

Asset Operation Parameters show the trend of a selected operation parameter from the 
operation parameter prompt, which consists of a list of operation parameters seeded for
Extensible Attribute in MOC. These parameters include pressure, temperature, RPM, 
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length, width, thickness, and weight.

Non-Production Assets
The Non-Production Asset tab of Asset Performance dashboard shows performance 
information for a selected non-production asset.

Following are the reports available from the Non-Production Asset page:

• Asset Events.

• Asset Status Trend.

• Asset Downtime Analysis.

• Asset Operation Parameter Trend.

The default value of selected time period is the previous month from the current date. 
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The Asset prompt contains a list of non-production only assets.

The Asset Events region displays all the events generated for assets.

The Asset Detail Status Trend region shows two charts: The Asset Status Trend chart 
and Asset Downtime Analysis chart. The Asset Status Trend chart shows the trend of 
run time, idle time, down time, and off time in hours. The Asset Downtime Analysis pie
chart shows the percentage of down time by downtime reasons.

The Asset Operation Parameters region shows the daily chart of a selected operation 
parameter from the operation parameter prompt, which consists of a list of operation 
parameters seeded for Extensible Attribute in MOC. These parameters include pressure,
temperature, RPM, length, width, thickness, and weight.
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11
Production Supervisor Dashboard

Overview of Production Supervisor Dashboard
Production Supervisor Dashboard generates reports that fetch data from shop floor 
equipment and provide real-time information about equipment status and production 
performance. Using this dashboard you can generate the following reports:

• Equipment Status

• Equipment Status Analysis

• Equipment Status Trend

• Equipment Output Trend

• Equipment Downtime Analysis

After processing the equipment output, status and equipment production schedule 
information using tags or csv files, run the concurrent program MTH: Process EPP 
(Equipment Production Performance) Data in the incremental refresh mode. This 
program updates the MTH_EQUIP_PROD_PERFORMANCE_F table, which is used for 
Equipment Production Performance report in the Production Supervisor Dashboard.
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Equipment Status - Production Performance
The reports in the dashboard enable production supervisors, who are responsible for 
day-to-day monitoring and control of shop floor operations.

Equipment Status report provides the latest equipment status, time of last status 
change, and time since last status update.
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Equipment Production Performance report provides information about the actual 
production with respect to scheduled production. Catch up Rate indicates the 
production rate to meet the scheduled production target.

At the top of the dashboard there is an alert on high scrap. You can set up the threshold 
value of this in the OBIEE.

Equipment Status Analysis 
The Equipment Status Analysis report shows the breakup of Down Time, Idle Time, 
and Run time hours for equipment within a plant both in a graph and tabular format.

Equipment Status - Output Trend
Equipment Status Trend displays equipment run, idle and down trend for all reading 
times for the selected time period.
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Equipment Output Trend displays the trend of completed, scrap quantity for 
equipment for all reading times for the selected time period.
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12
Facilities Manager Dashboard

Overview of the Facilities Manager Dashboard
Oracle Manufacturing Operations Center provides new capabilities to accelerate 
sustainability improvements of companies focusing on manufacturing, innovation, or 
services.

Oracle Manufacturing Operations Center can directly connect to smart meters and 
environmental management systems to collect real time energy consumption and green 
house gases emission data in both manufacturing and non-manufacturing facilities of 
enterprises across all industries. 

The Sustainability Sensor Data Management system of Oracle MOC provides the 
Facilities Manager dashboard with built-in Key Performance Indicators (KPIs) that help 
you:

• Monitor and analyze energy consumption, energy cost, and carbon emissions.

• Identify specific opportunities for improving energy efficiency and reducing carbon
emissions.

• Directly integrate with smart meters, environmental management systems, and 
building automation systems, and collect energy consumption, and emissions data.

• Leverage as a certifiable data repository for reporting energy usage.

• Upload data through spreadsheets at any desired frequency and at any level of 
granularity, in cases where energy information is not available through meters or 
other sensors.

The Facilities Manager dashboard and the integrated reports provide the facility 
manager with information on the electricity consumption, electricity cost, and carbon 
emissions at the following five seeded levels of a facility hierarchy:

• Site
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• Building

• Floor

• Floor Section

• Equipment

You can also define hierarchies based on your requirements.

Understanding the Summary Page
The Summary page displays the electricity consumption, electricity cost, and carbon 
emission for all the sites in an enterprise.

To view the Summary page:
1. Navigate to the Facilities Manager dashboard using the Manufacturing Operations 

Center User responsibility. The Summary page displays.

2. Select the time period for which you want to view the details. Choose the Year, 
Quarter, Period, Week, and Date. All Choices displays as the default value for all 
the time period fields. Click Go. The following regions display for the enterprise:

Electricity Consumption

• Site is the name of the site in the enterprise. You can click on a site to view the 
Site reports. Refer to the "Understanding Site Page" topic for a detailed 
description of the site page.

• Plan vs Actual-Period to Date is the difference in the planned electricity 
consumption and actual electricity in a specific time period. A dial displays as 
red when the difference is greater than zero and as green when the difference is 
lesser than or equal to zero

• Business Function is the business function of the site.

• Area is the area of the site.

• Headcount is the number of employees working at the site

• Actual Consumption- Period to Date is the actual electricity consumed by the 
site in a specific time period.

• Plan Consumption- Period to Date is the planned electricity to be consumed by 
the site for the time period.

• Last Year Consumption – Period Date is the electricity consumed by the site in 
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the same time period of the previous year.

• % Change (Plan) is the percentage deviation of actual consumption from 
planned electricity consumption by the site. A red flag displays when the value 
is more than zero.

• % Change (Last Year) is the percentage deviation of actual electricity usage by 
the site in the period of the current year from that of the last year. A red flag 
displays when the value is more than zero.

• Actual Consumption Per Unit Area is the actual electricity consumed per unit 
area of the site. 

• Actual Consumption Per Person is the actual electricity consumed per person in
the site. 

• Electricity Consumption UOM is the unit of measure in which electricity is 
consumed. 

• Area UOM is the unit of measure for the site area.

Electricity Cost

• Actual Cost - Period to Date is the cost of the actual electricity consumed by the 
site in a specific time period.

• Plan Cost- Period to Date is the cost of planned electricity to be consumed by 
the site in a specific time period.

• Last Year Consumption – Period Date is the cost of electricity consumed by the 
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site in the same time period of the previous year.

• % Change (Plan) is the percentage deviation of cost of actual electricity 
consumption from planned electricity consumption by the site. A red flag 
displays when the value is more than zero.

• % Change (Last Year) is the percentage deviation of cost of actual electricity 
usage by the site in the period of the current year from that of the last year. A 
red flag displays when the value is more than zero.

• Actual Cost Per Unit Area is the cost of actual electricity consumed per unit 
area of the site.

• Actual Cost Per Person is the cost of actual electricity consumed per person in 
the site.

CO2 Emission

• Actual Emission-Period to Date is the carbon emission based on electricity 
consumption by the site in a specific time period.

• Plan Emission- Period to Date is planned emissions based on electricity 
consumption by the site.

• Last Year Emission-Period Date is emission based on electricity consumed by 
the site in a specified period of the previous year.

• % Change (Plan) is the percentage deviation of actual from planned emissions 
by the site. A red flag displays when the value is more than zero.

• % Change (Last Year) is the percentage deviation of actual emission by the site 
in the period of the current year from that of the last year. A red flag displays 
when the value is more than zero.

• Actual Emission Per Unit Area is the actual emission per unit area of the site.

• Actual Emission Per Person is the emission per person in the site.
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Trend 

The Trend graph reports provide a graphical representation of the electricity 
consumption, electricity cost, and CO2 emission of all sites in an enterprise and also
for each site of the enterprise for a specific time period. 

To view the Trend Graph Report:
1. Scroll down the Summary page. You can view the following reports:

• Trend by Period- All Sites displays the report for all sites of the enterprise.

• Trend by Period- By Site displays the report for each site of the enterprise.

2. To view the Trend by Period- All Sites, select the Period for which you want to view
the reports. Options are: Year, Quarter, Period, Week, and Date.

3. Select the report you want to view in the Measure field. Options are: Electricity 
Consumption, Electricity Cost, and CO2 Emission.

4. To view the Trend by Period- By Site, select the Period for which you want to view 
the reports. Options are: Year, Quarter, Period, Week, and Date.

5. Select the report you want to view in the Measure field:

• Electricity Consumption

• Electricity Cost

• CO2 Emission
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Ranking and Distribution

The Ranking and Distribution report provides a graphical representation of the site 
rankings and distributions based on electricity consumption, cost, and CO2 
emission. 

To view the Ranking and Distribution report:
1. Scroll down the Summary page to the Ranking and Distribution region. Select any 

one of the following KPIs in the Measure field for which you want to view the 
report:

• Electricity Consumption

• Electricity Consumption Per Unit Area

• Electricity Consumption Per Person

• Electricity Cost

• Electricity Cost Per Unit Area

• Electricity Cost Per Person

• CO2 Emission

• CO2 Emission Per Unit Area

• CO2 Emission Per Person

2. The Site Ranking report displays the top five sites in a descending order for the 
selected measure.

3. The Distribution by Site report displays the distribution of the selected measure 
across all sites of the enterprise.

4. The Distribution by Usage Category displays the distribution of the selected 
measure across various usage categories at all sites, for example, electricity 
consumption for air conditioning, lighting, production equipment etc. 
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Understanding the Site Page
The Site page displays the electricity consumption, electricity cost, and carbon emission 
for all the buildings of a site. You can also choose to view information for a single 
building. 

To view the Site page:
1. Navigate to the Facilities Manager dashboard using the Manufacturing Operations 

Center User responsibility. The Summary page displays.

2. Select the Site tab or click on a site in the Site field of the Summary page. The Site 
page appears.

3. Select the time period for which you want to view the details. Options are: Year, 
Quarter, Period, Week, and Date. Year displays the current year by default. All 
Choices displays as the default value for Quarter, Period, Week, and Date time 
periods.

4. Select the Site for which you want to view reports. A list of sites from the Site 
Master displays. If you navigate to the site page using the Site tab, then the first Site 
in ascending alphabetical order of Site names displays as the default value.

5. Select the Building for which you want to view report from a list of buildings of the 
site.

6. Click Go. The header region of the page displays the following Site Characteristics:

• Building

• Business Function is business function of the building.

• Area is the area of the building.
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• Headcount is the number of employees working in the building.

7. The following information displays for a site:

Electricity Consumption

• Actual Consumption- Period to Date is the actual electricity consumed by the 
building in a specific time period.

• Plan Consumption- Period to Date is the planned electricity to be consumed by 
the building in the specific time period.

• Last Year Consumption – Period Date is the electricity consumed by the 
building in the same time period of the previous year.

• % Change (Plan) is the percentage deviation of actual consumption from 
planned electricity consumption by the building. A red flag displays when the 
value is more than zero.

• % Change (Last Year) is the percentage deviation of actual electricity usage by 
the building in the period of the current year from that of the last year. A red 
flag displays when the value is more than zero.

• Actual Consumption Per Unit Area is the actual electricity consumed per unit 
area of the building. 

• Actual Consumption Per Person is the actual electricity consumed per person in
the building. 

• Electricity Consumption UOM is the unit of measure in which electricity is 
consumed. 

• Area UOM is the unit of measure for the building area.

Electricity Cost

• Actual Cost-Period to Date is the cost of the actual electricity consumed by the 
building in a specific time period.

• Plan Cost-Period to Date is the cost of planned electricity to be consumed by the
building in a specific time period.

• Last Year Consumption-Period Date is the cost of electricity consumed by the 
building in the same time period of the previous year.

• % Change (Plan) is the percentage deviation of cost of actual electricity 
consumption from planned electricity consumption by the building. A red flag 
displays when the value is more than zero.
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• % Change (Last Year) is the percentage deviation of cost of actual electricity 
usage by the building in the period of the current year from that of the last year.
A red flag displays when the value is more than zero.

• Actual Cost Per Unit Area is the cost of actual electricity consumed per unit 
area of the building.

• Actual Cost Per Person is the cost of actual electricity consumed per person in 
the building.

CO2 Emission

• Actual Emission - Period to Date is the carbon emission based on electricity 
consumption by the building in a specific time period.

• Plan Emission- Period to Date is planned emissions based on electricity 
consumption by the building.

• Last Year Emission – Period Date is emission based on electricity consumed by 
the building in a specified period of the previous year.

• % Change (Plan) is the percentage deviation of actual from planned emissions 
by the building. A red flag displays when the value is more than zero.

• % Change (Last Year) is the percentage deviation of actual emission by the 
building in the period of the current year from that of the last year. A red flag 
displays when the value is more than zero.

• Actual Emission Per Unit Area is the actual emission per unit area of the 
building.

• Actual Emission Per Person is the emission per person in the building.

Trend Graph Reports

The Trend graph reports provide a graphical representation of the electricity 
consumption, electricity cost, and CO2 emission of all buildings at a site and also 
for each building of the site for a specific time period. 

To view the Trend Graph Report:
1. Navigate to the Site page. You can view the following reports:

• Trend by Period- All Buildings displays the report for all buildings of the site.

• Trend by Period- By Building displays the report for each building of the site.

2. To view the Trend by Period- All Buildings and Trend by Period-By Building 
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reports, select the Period for which you want to view the reports. Options are: Year, 
Quarter, Period, Week, and Date.

3. Select the report you want to view in the Measure field:

• Electricity Consumption

• Electricity Consumption Per Unit Area

• Electricity Consumption Per Person

• Electricity Cost

• Electricity Cost Per Unit Area

• Electricity Cost Per Person

• CO2 Emission

• CO2 Emission Per Unit Area

• CO2 Emission Per Person

Ranking and Distribution

The Ranking and Distribution report provides a graphical representation of the 
building rankings and distributions based on electricity consumption, cost, and 
CO2 emission. 

To view the Ranking and Distribution report:
1. Navigate to the Site page.

2. Scroll down to the Ranking and Distribution page. Select any one of the following 
KPIs in the Measure field for which you want to view the report:

• Electricity Consumption

• Electricity Consumption Per Unit Area

• Electricity Consumption Per Person

• Electricity Cost

• Electricity Cost Per Unit Area

• Electricity Cost Per Person

• CO2 Emission
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• CO2 Emission Per Unit Area

• CO2 Emission Per Person

3. The Building Ranking report displays the top five buildings in a descending order 
for the selected measure.

4. The Distribution by Building report displays the distribution of the selected 
measure across all buildings of the site.

5. The Distribution by Usage Category displays the distribution of the selected 
measure across various usage categories for all the buildings at the site, for 
example, electricity consumption for air conditioning, lighting, production 
equipment etc. 

Understanding the Building Page
The Building page displays the electricity consumption, electricity cost, and carbon 
emission for all the floors in a building. You can also choose to view information for a 
single floor. 

To view the Building page:
1. Navigate to the Facilities Manager dashboard using the Manufacturing Operations 

Center User responsibility. The Summary page displays.

2. Select the Building tab or click on a building in the Building field of the Site page. 
The Building page appears.

3. Select the time period for which you want to view the details. Choose the Year, 
Quarter, Period, Week, and Date. Year displays the current year by default. All 
Choices displays as the default value for Quarter, Period, Week, and Date time 
periods.

4. Select the Site, Building, and Floor for which you want to view reports. All the 
floors in the building display in the list of values of the Floor field.

5. Click Go. The header region of the page displays the Building Characteristics. The 
following information displays for the building:

• Building

• Business Function is business function of the floor.

• Area is the area of the floor.
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• Area UOM is the unit of measure in which the building area is expressed.

• Headcount is the number of employees working on the floor.

Electricity Consumption

• Floor is the name of the floor.

• Actual Consumption- Period to Date is the actual electricity consumed by the 
floor in a specific time period.

• Plan Consumption- Period to Date is the planned electricity to be consumed by 
the floor in the specific time period.

• Last Year Consumption – Period Date is the electricity consumed by the floor in
the same time period of the previous year.

• % Change (Plan) is the percentage deviation of actual consumption from 
planned electricity consumption by the floor. A red flag displays when the 
value is more than zero.

• % Change (Last Year) is the percentage deviation of actual electricity usage by 
the floor in the period of the current year from that of the last year. A red flag 
displays when the value is more than zero.

• Actual Consumption Per Unit Area is the actual electricity consumed per unit 
area of the floor. 

• Actual Consumption Per Person is the actual electricity consumed per person in
the floor. 

Electricity Cost

• Actual Cost - Period to Date is the cost of the actual electricity consumed by the 
floor in a specific time period.

• Plan Cost- Period to Date is the cost of planned electricity to be consumed by 
the floor in a specific time period.

• Last Year Consumption – Period Date is the cost of electricity consumed by the 
floor in the same time period of the previous year.

• % Change (Plan) is the percentage deviation of cost of actual electricity 
consumption from planned electricity consumption by the floor. A red flag 
displays when the value is more than zero.

• % Change (Last Year) is the percentage deviation of cost of actual electricity 
usage by the floor in the period of the current year from that of the last year. A 
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red flag displays when the value is more than zero.

• Actual Cost Per Unit Area is the cost of actual electricity consumed per unit 
area of the floor.

• Actual Cost Per Person is the cost of actual electricity consumed per person in 
the floor.

CO2 Emission

• Actual Emission-Period to Date is the carbon emission based on electricity 
consumption by the floor in a specific time period.

• Plan Emission-Period to Date is planned emissions based on electricity 
consumption by the floor.

• Last Year Emission-Period Date is emission based on electricity consumed by 
the floor in a specified period of the previous year.

• % Change (Plan) is the percentage deviation of actual from planned emissions 
by the floor. A red flag displays when the value is more than zero.

• % Change (Last Year) is the percentage deviation of actual emission by the floor
in the period of the current year from that of the last year. A red flag displays 
when the value is more than zero.

• Actual Emission Per Unit Area is the actual emission per unit area of the floor.

• Actual Emission Per Person is the emission per person in the floor.

Trend

The Trend graph reports provide a graphical representation of the electricity 
consumption, electricity cost, and CO2 emission of all floors at a building and also 
for each floor of the building for a specific time period. 

To view the Trend Graph Report:
1. Scroll down to the Trend region. You can view the following reports:

• Trend by Period- All Floors displays the report for all floors of the building.

• Trend by Period- By Floor displays the report for each floor of the building.

2. To view the Trend by Period- All Floors and Trend by Period-By Floor reports, 
select the Period for which you want to view the reports. Options are: Year, 
Quarter, Period, Week, and Date.
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3. Select the report you want to view in the Measure field:

• Electricity Consumption

• Electricity Consumption Per Unit Area

• Electricity Consumption Per Person

• Electricity Cost

• Electricity Cost Per Unit Area

• Electricity Cost Per Person

• CO2 Emission

• CO2 Emission Per Unit Area

• CO2 Emission Per Person

Ranking and Distribution 

The Ranking and Distribution report provides a graphical representation of the 
floor rankings and distributions based on energy consumption, cost, and CO2 
emission. 

To view the Ranking and Distribution report:
1. Scroll down to the Ranking and Distribution page. Select any one of the following 

KPIs in the Measure field for which you want to view the report:

• Electricity Consumption

• Electricity Consumption Per Unit Area

• Electricity Consumption Per Person

• Electricity Cost

• Electricity Cost Per Unit Area

• Electricity Cost Per Person

• CO2 Emission

• CO2 Emission Per Unit Area

• CO2 Emission Per Person
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2. The Building Ranking report displays the top five floors in a descending order for 
the selected measure.

3. The Distribution by Building report displays the distribution of the selected 
measure across all floors of the building.

4. The Distribution by Usage Category displays the distribution of the selected 
measure across various usage categories at all floors of the building, for example, 
electricity consumption for air conditioning, lighting, production equipment etc.

Understanding the Floor Page
The Floor page displays the electricity consumption, electricity cost, and carbon 
emission for all the floor sections on a floor. You can also choose to view information for
a single floor section. 

To view the Floor page:
1. Navigate to the Facilities Manager dashboard using the Manufacturing Operations 

Center User responsibility. The Summary page displays.

2. Select the Floor tab or click on a floor in the Floor field of the Building page. The 
Floor page appears.

3. Select the time period for which you want to view the details. Choose the Year, 
Quarter, Period, Week, and Date. Year displays the current year by default. All 
Choices displays as the default value for Quarter, Period, Week, and Date time 
periods.

4. Select the Site, Building, Floor, and Floor Section for which you want to view 
reports. All the floor sections of the floor display in the list of values of the Floor 
Section field.

5. Click Go. The header region of the page displays the Floor Characteristics. The 
following information displays for the building:

• Floor

• Business Function is business function of the floor.

• Area is the area of the floor.

• Area UOM is the unit of measure in which the floor area is expressed.

• Headcount is the number of employees working on the floor.

Electricity Consumption



12-16    Oracle Manufacturing Operations Center User's Guide

• Floor Section is the name of the floor section.

• Actual Consumption- Period to Date is the actual electricity consumed by the 
floor section in a specific time period.

• Plan Consumption- Period to Date is the planned electricity to be consumed by 
the floor section in the specific time period.

• Last Year Consumption – Period Date is the electricity consumed by the floor 
section in the same time period of the previous year.

• % Change (Plan) is the percentage deviation of actual consumption from 
planned electricity consumption by the floor section. A red flag displays when 
the value is more than zero.

• % Change (Last Year) is the percentage deviation of actual electricity usage by 
the floor section in the period of the current year from that of last year. A red 
flag displays when the value is more than zero.

• Actual Consumption Per Unit Area is the actual electricity consumed per unit 
area of the floor section. 

• Actual Consumption Per Person is the actual electricity consumed per person in
the floor section. 

Electricity Cost

• Actual Cost-Period to Date is the cost of the actual electricity consumed by the 
floor section in a specific time period.

• Plan Cost-Period to Date is the cost of planned electricity to be consumed by the
floor section in a specific time period.

• Last Year Consumption-Period Date is the cost of electricity consumed by the 
floor section in the same time period of the previous year.

• % Change (Plan) is the percentage deviation of cost of actual electricity 
consumption from planned electricity consumption by the floor section. A red 
flag displays when the value is more than zero.

• % Change (Last Year) is the percentage deviation of cost of actual electricity 
usage by the floor section in the period of the current year from that of the last 
year. A red flag displays when the value is more than zero.

• Actual Cost Per Unit Area is the cost of actual electricity consumed per unit 
area of the floor section.
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• Actual Cost Per Person is the cost of actual electricity consumed per person in 
the floor section.

CO2 Emission

• Actual Emission-Period to Date is the carbon emission based on electricity 
consumption by the floor section in a specific time period.

• Plan Emission-Period to Date is planned emissions based on electricity 
consumption by the floor section.

• Last Year Emission-Period Date is emission based on electricity consumed by 
the floor section in a specified period of the previous year.

• % Change (Plan) is the percentage deviation of actual from planned emissions 
by the floor section. A red flag displays when the value is more than zero.

• % Change (Last Year) is the percentage deviation of actual emission by the floor
section in the period of the current year from that of the last year. A red flag 
displays when the value is more than zero.

• Actual Emission Per Unit Area is the actual emission per unit area of the floor 
section.

• Actual Emission Per Person is the emission per person in the floor section.

Trend

The Trend graph reports provide a graphical representation of the electricity 
consumption, electricity cost, and CO2 emission of all floors sections on a floor and 
also for each floor section of the floor for a specific time period. 

To view the Trend Graph Report:
1. Scroll down to the Trend region. You can view the following reports:

• Trend by Period-All Floor Sections displays the report for all floor sections of 
the floor.

• Trend by Period-By Floor section displays the report for each floor section of 
the floor.

2. To view the Trend by Period-All Floor Sections and Trend by Period-By Floor 
Section reports, select the Period for which you want to view the reports. Options 
are: Year, Quarter, Period, Week, and Date.

3. Select the report you want to view in the Measure field:
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• Electricity Consumption

• Electricity Cost

• CO2 Emission

Ranking and Distribution 

The Ranking and Distribution report provides a graphical representation of the 
floor section rankings and distributions based on energy consumption, cost, and 
CO2 emission. 

To view the Ranking and Distribution report:
1. Scroll down to the Ranking and Distribution page. Select any one of the following 

KPIs in the Measure field for which you want to view the report:

• Electricity Consumption

• Electricity Consumption Per Unit Area

• Electricity Consumption Per Person

• Electricity Cost

• Electricity Cost Per Unit Area

• Electricity Cost Per Person

• CO2 Emission

• CO2 Emission Per Unit Area

• CO2 Emission Per Person

2. The Floor Ranking report displays the top five floors in a descending order for the 
selected measure.

3. The Distribution by Floor report displays the distribution of the selected measure 
across all floors of the building.

4. The Distribution by Usage Category displays the distribution of the selected 
measure across various usage categories on all the floor sections of the floor, for 
example, electricity consumption for air conditioning, lighting, production 
equipment etc. 
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Understanding the Floor Section Page
The Floor Section page displays the electricity consumption, electricity cost, and carbon 
emission for all equipments in a floor section. You can also choose to view information 
for single equipment. 

To view the Floor Section page:
1. Navigate to the Facilities Manager dashboard using the Manufacturing Operations 

Center User responsibility. The Summary page displays.

2. Select the Floor Section tab or click on a floor section in the Floor Section field of the 
Floor page. The Floor Section page appears.

3. Select the time period for which you want to view the details. Choose the Year, 
Quarter, Period, Week, and Date. Year displays the current year by default. All 
Choices displays as the default value for Quarter, Period, Week, and Date time 
periods.

4. Select the Site, Building, Floor, Floor Section, and Equipment for which you want to
view reports. All the equipment on the floor section display in the list of values of 
the Equipment field.

5. Click Go. The header region of the page displays the Floor Section Characteristics. 
The following information displays for the floor section:

• Floor Section

• Business Function is business function of the floor section.

• Area is the area of the floor section.

• Area UOM is the unit of measure in which the floor section area is expressed.

• Headcount is the number of employees working on the floor section.

Equipment Summary

• Equipment is the name of the equipment.

• Actual Consumption- Period to Date is the actual electricity consumed by the 
equipment in a specific time period.

• Plan Consumption- Period to Date is the planned electricity to be consumed by 
the equipment in the specific time period.

• Last Year Consumption – Period Date is the electricity consumed by the 
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equipment in the same time period of the previous year.

• % Change (Plan) is the percentage deviation of actual consumption from 
planned electricity consumption by the equipment. A red flag displays when 
the value is more than zero.

• % Change (Last Year) is the percentage deviation of actual electricity usage by 
the equipment in the period of the current year from that of the last year. A red 
flag displays when the value is more than zero. 

• Actual Emission-Period to Date is the carbon emission based on electricity 
consumption by the equipment in a specific time period.

• Plan Emission-Period to Date is planned emissions based on electricity 
consumption by the equipment.

• Last Year Emission-Period Date is emission based on electricity consumed by 
the equipment in a specified period of the previous year.

Trend

The Trend graph reports provide a graphical representation of the electricity 
consumption, electricity cost, and CO2 emission of all equipments on a floor and 
also for a single equipment of the floor section for a specific time period. 

To view the Trend Report:
1. Scroll down to the Trend region. You can view the following reports:

• Trend by Period-All Equipments displays the report for all equipments of the 
floor section.

• Trend by Period-By Equipment displays the report for an equipment of the 
floor section.

2. To view the Trend by Period- All Equipments and Trend by Period-By Equipment 
reports, select the Period for which you want to view the reports. Options are: Year, 
Quarter, Period, Week, and Date.

3. Select the report you want to view in the Measure field:

• Electricity Consumption

• Electricity Cost

• CO2 Emission

Ranking and Distribution 
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The Ranking and Distribution report provides a graphical representation of the 
equipment rankings and distributions based on energy consumption, cost, and CO2
emission. 

To view the Ranking and Distribution report:
1. Scroll down to the Ranking and Distribution page. Select any one of the following 

KPIs in the Measure field for which you want to view the report:

• Electricity Consumption

• Electricity Cost

• CO2 Emission

2. The Equipment Ranking report displays the top five equipments in a descending 
order for the selected measure.

3. The Distribution by Equipment report displays the distribution of the selected 
measure across all equipments of the floor section.

4. The Distribution by Usage Category displays the distribution of the selected 
measure across various usage categories for all equipments on a floor section, for 
example, electricity consumption for air conditioning, lighting, production 
equipment etc. 

Equipment Hourly Summary Page
You can view the electricity consumption, electricity cost, equipment output, and 
carbon emission for hourly time periods for equipment using the Equipment Hourly 
Summary Page. 

To view the Equipment Hourly Summary page:
1. Navigate to the Equipment Summary region of the Floor Section page. Click in the 

Equipment field to view reports for an equipment. The Equipment Hourly 
Summary page appears.

2. Select the report you want to view using the following options for time and entity:

• Year, Quarter, Period, Week, and Date

• Site, Building, Floor, Floor Section, and Equipment

3. The following reports display for the equipment:
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• Electricity Consumption Trend report is a graphical representation of the trend 
in electricity consumption of the equipment in hourly time intervals.

• Parameter Monitoring report is a graphical representation of the measures of 
parameters like temperature and pressure over hourly time periods.

To view the report:

• Select Actual as Temperature or Pressure

• Select Specification as Temperature or Pressure. If you select Actual as 
Pressure, then you must also select the Specification as Pressure. The graph 
report displays the values of measured parameter over specified time 
periods with respect to the graphs of the Upper and Lower limits of the 
specifications. Refer to the topic "Creating Attribute Groups" in the Oracle 
Manufacturing Operations Center Implementation Guide for more information 
on specifications.
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• Equipment Status Trend is a graphical representation of the trend in which an 
equipment is in Idle, Run, Down, and Off statuses over hourly time periods. 
You can choose to display a Bar or Area Graph.

• Equipment Summary report is a tabular representation of the durations for 
which the equipment is in the Idle, Run, Down and Off statuses over hourly 
time periods. 

The report displays the following information:

• From Time and To Time is the hourly time period

• Run Time (Hrs) is the time in hours for which the equipment is in Run 
status.

• Idle Time (Hrs) is the time in hours for which the equipment is in Idle 
status.
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• Down Time (Hrs) is the time in hours for which the equipment is in Down 
status.

• Off Time (Hrs) is the time in hours for which the equipment is in Off status.

• Electricity Consumption is electricity consumed by the equipment for the 
time range.

Equipment Hourly Detail Page
You can view the detailed information on electricity consumption, electricity cost, 
equipment output, and carbon emission for an equipment in a specific hourly time 
period using the Sustainability Performance Equipment Hourly Detail Page.

To view the Equipment Hourly Detail page:
1. Navigate to the Equipment Summary region of the Equipment Hourly Summary 

page.

2. Click the From Time to view the equipment detail reports for the equipment within 
a specific hour. The Equipment Hourly Detail page appears.

3. The following reports display for the equipment within the selected hour:

• Electricity Consumption Detail Trend graphically displays the electricity 
consumption by the equipment within the selected hour.

• CO2 Emission Detail Trend graphically displays the carbon emission by the 
equipment within the selected hour.

• Equipment Status Trend graphically displays the times for which the 
equipment is in the Up, Idle, Down, and Off Statuses within the selected hour.
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13
MOC and Oracle Enterprise Asset 

Management (eAM) Integration

This chapter covers the following topics:

• Overview

• Setting Up MOC - eAM Integration Using Event Management Framework

Overview
Oracle Manufacturing Operations Center (MOC) and Oracle Enterprise Asset 
Management (eAM) integration provides effective coordination between production 
and maintenance departments to achieve greater utilization of equipment on the shop 
floor. This is achieved by the rapid exchange of information related to equipment. 
Examples include down or idle condition of equipment, or equipment exceeding 
control parameters. MOC initiates actions based on events and alerts captured from 
shop floor equipment and passes the actions to the specific roles, such as the 
Maintenance Supervisor. MOC also receives the expected and actual uptime from the 
maintenance department that assists the planner or scheduler to modify the production 
schedules according to equipment availability.

MOC and eAM integration:

• Reduces reaction time between event occurrence and the action/response.

• Improves scheduling based on equipment availability.

MOC and eAM integration supports:

• Configuration and collection of eAM specific objects including meter readings, 
events, and alarms from actual equipment in MOC.

• Process integration between MOC and eAM to meet the principles of Condition 
Based Maintenance (CBM).
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• Dashboards and KPI's designed for maintenance specific users and roles.

• Manual or automatic actions based on events using Event Management Framework.

The equipment status data from the shop floor can be obtained through tags and can be 
imported to MOC using OPC Server provided by device partners (Kepware, Matricon 
or ILS). The data is stored in the Tag Readings Raw table. MOC processes the data 
collected from the OPC server and creates events for the generation of notifications like 
e-mails and mobile alerts, and work requests in the EBS source system. You must run 
the Process Transactions concurrent program to load the data into the Tag Readings 
table and trigger the MOC Event Management procedure. The procedure creates event 
actions as defined in the Event Setup for the equipment. The following event actions are
available:

• Send notifications like e-mails or mobile alerts to the person setup in the Event.

• Create work request in the source instance eAM Application.

You must select the Work Request Auto Approve option for the maintenance 
organization in the EAM Parameters window of the Oracle Enterprise Asset 
Management application to create work requests. Refer to the Oracle Enterprise Asset 
Management User's Guide for more information. Equipment Event Action folder in the 
presentation layer of the OBIEE metadata analyzes the equipment events into 
equipment, work order, and shifts.

Setting Up MOC - eAM Integration Using Event Management Framework
Event Management Framework supports execution of manual or automatic actions 
based on the events, reduces the reaction time between event occurrence and the 
action/response, and improves scheduling based on equipment availability.

MOC creates EAM work request for the equipment on the occurrence of the configured 
events. Users can also create custom event actions like making a scrap transaction, etc., 
and configure them to be invoked whenever the event occurs.
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Complete the following steps to set up the MOC - EAM Integration using Event 
Management Framework:

1. Create User. Create the user using MTH_PERSONNEL.csv and then running the 
ODI scenario MTH_PKG_PERSONNEL_EXT.

2. Setup Message Domain. Set up message domain lookup value. This is required for 
mobile alerts.

3. Set up Asset and Maintenance Organization in MOC. Create an asset in MOC using 
MTH_ASSET_MASTER.csv and then running the ODI scenario, 
MTH_PKG_ASSETS_EXT.

The asset number, asset group, and the asset serial number should match with 
records in Oracle eAM.

4. Set up Tags, Equipment, and Contextualization. Create Tags for the assets using the
Tag Setup page.

See: Setting Up Tags, page 3-2, for more information.

5. Define MOC Equipments. See: Setting Up Equipment Dimensions chapter in the 
Oracle Manufacturing Operations Center Implementation Guide, for more information.

6. Map Tags to Equipment. See: Mapping Tags to Equipment, page 3-5, for more 
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information.

7. Generate Shifts for Equipment. See: Performing Entity Shift Setup topic in the Oracle
Manufacturing Operations Center Implementation Guide, for more information.

8. Set up Contextualization for Equipment.

9. Define Events. Log in to Oracle Applications portal and create a new event.

1. Navigate to the Event Setup page.

2. Search and select an equipment.

3. Click Update Sequentially button.

4. Click the Add button in the Event Types region of the Event Action Setup page.

5. Select an Event Type from the LOV.

6. Click the Add button in the Seeded Actions region of the Event Action pane.

7. Select Event Action as Create Work Request in eAM from the LOV.

8. Select the Notification tab.

9. Click the Add button in the Notification pane.

10. Enter the Full Name.

11. Select the Email Address check box.

12. Select the Mobile Phone Number check box.

The Domain field is enabled.

13. Select a domain from the LOV.

14. Click Apply to save the record.

See: Setting Up Events, page 3-14, for more information.

10. Setup Profile Options. Switch responsibility to System Administrator and set up the
following profile options for eAM Work Request Creation:

• MTH: Work Request Auto Approve

• MTH: Work Request Priority ID

• MTH: Maintenance User
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• MTH: Notification E-Mail From Display Name

• MTH: Notification E-Mail Server Name

• MTH: Notification E-Mail Server Port

See: Profile Options chapter in the Oracle Manufacturing Operations Center 
Implementation Guide, for more information.

11. Populate MTH Tag Readings Raw table using the device bridge such as Kepserver, 
ILS, Matrikon with MOC adapter or using the CSV template, 
MTH_TAG_READINGS_RAW.csv.

12. Process Tag Data. Run the MTH: Process Transactions concurrent program.

• Process Mode = Incremental Refresh

• Data Source = Raw Tag Data

13. Review Work Request and Notification. Check the e-mail notification received by 
the concerned personnel. Log in to the Oracle Applications portal. Select the 
responsibility 'Maintenance Super User, Process' and check if the work request is 
created.
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14
Ad hoc Reports

Using Ad hoc Reports
Oracle Manufacturing Operations Center (MOC) enables you to build custom reports 
for analyzing process parameters like electricity consumption, pressure, temperature, 
etc. that are captured for equipments based on specifications setup. Oracle MOC 
provides the following seeded reports for ad hoc analysis and enables you to analyze 
electricity consumption and parameters like temperature or pressure for single or 
multiple entities in a specific time period or over multiple time periods:

• Single Entity Ad hoc Analysis Report

• Multiple Entity Ad hoc Analysis Report

• Compare Periods Ad hoc Analysis Report

Single Entity Ad hoc Analysis Report
The Single Entity Ad hoc Analysis report enables you to analyze electricity 
consumption with parameters, Temperature or Pressure for a single entity and a single 
time period. 

To run a single entity ad hoc analysis report:
1. Using the Manufacturing Operations Center User responsibility, click Ad hoc 

Analysis menu option. The Ad hoc Analysis page displays.

2. In the Single Entity tab, enter the following fields:

• From Date and To Date to specify the time period for which you want to 
analyze the electricity consumption.

• Entity Type. Options are: Building, Department, Equipment, Floor, Floor 
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Section, Resource, Resource Group, and Site.

• Entity for which you want to analyze the electricity consumption. All entities of
the selected entity type display.

• Parameter as Temperature or Pressure.

3. Click Go. The Electricity Consumption and Parameter Monitoring graphical report 
displays electricity consumption and the parameter recordings 

Multiple Entities Ad hoc Analysis Report
The Multiple Entities Ad hoc Analysis report enables you to analyze electricity 
consumption or monitor temperature or pressure for multiple entities in a specified 
time period. 

To run the Multiple Entities Ad hoc Analysis Report:
1. Using the Manufacturing Operations Center User responsibility, click Ad hoc 

Analysis menu option. The Ad hoc Analysis page displays.

2. Select the Multiple Entities tab and enter the following fields:

• From Date and To Date to specify the time period for which you want to 
analyze the electricity consumption or monitor temperature or pressure.

• Entity Type. Options are: Building, Department, Equipment, Floor, Floor 
Section, Resource, Resource Group, and Site.

• Entities for which you want to analyze the electricity consumption or a 
parameter. All entities of the selected entity type display. 

• Parameter as Temperature, Pressure, or Electricity Consumption.

3. Click Go. The Electricity Consumption or Parameter Monitoring graphical report 
displays the electricity consumption or parameter readings for the selected entities 
for the specified time period. 

Compare Periods Ad hoc Analysis Report
The Compare Period Ad hoc Analysis report enables you to analyze electricity 
consumption and monitor temperature and pressure for an entity for multiple time 
periods.
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To run the Compare Periods Ad hoc Analysis Report:
1. Using the Manufacturing Operations Center User responsibility, click Ad hoc 

Analysis menu option. The Ad hoc Analysis page displays.

2. Select the Compare Period tab and enter the following fields

• Choose the time period. Options are Year, Quarter, Period, Week, and Day. 

• Entity Type. Options are: Building, Department, Equipment, Floor, Floor 
Section, Resource, Resource Group, and Site.

• Entities for which you want to analyze the electricity consumption or a 
parameter. All entities of the selected entity type display.

• Parameter as Temperature, Pressure, or Electricity Consumption.

3. Click Go. The Electricity Consumption or Parameter Monitoring graphical report 
displays the electricity consumption or parameter readings for the entity in the 
selected time period.
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A
Navigation

This appendix lists navigation paths for pages in the Oracle Manufacturing Operations 
Center application.

This appendix covers the following topics:

• Manufacturing Operations Center Navigation Paths

Manufacturing Operations Center Navigation Paths
Brackets ([ ]) indicate a button or link.

Page Name Navigation Path

Actual Meters Data Entry MOC User > Data Entry > Actual Meters Data 
Entry

Add Attribute Groups for Batch Operation MOC Administrator > Extensible Attributes 
Workbench > Batch Operations > [select Entity 
Name link] > Classifications tab [Attribute 
Groups] > [Add Attribute Groups] 

Add Attribute Groups for Equipment MOC Administrator > Extensible Attributes 
Workbench > Equipment > [select Entity Name
link] > Classifications tab [Attribute Groups] > 
[Add Attribute Groups] 

Add Attribute Groups for Item MOC Administrator > Extensible Attributes 
Workbench > Items > [select Entity Name link] 
> Classifications tab [Attribute Groups] > [Add
Attribute Groups] 
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Page Name Navigation Path

Add Attribute Groups for Others MOC Administrator > Extensible Attributes 
Workbench > Others > [select Entity Name 
link] > Classifications tab [Attribute Groups] > 
[Add Attribute Groups] 

Add Attribute Groups for Work Order MOC Administrator > Extensible Attributes 
Workbench > Work Orders > [select Entity 
Name link] > Classifications tab [Attribute 
Groups] > [Add Attribute Groups] 

Add Pages for Batch Operation MOC Administrator > Extensible Attributes 
Workbench > Batch Operations > [select Entity 
Name link] > Classifications tab [Pages] > [Add
Pages for Batch Operation] > [Create Page]

Add Pages for Equipment MOC Administrator > Extensible Attributes 
Workbench > Equipment > [select Entity Name
link] > Classifications tab [Pages] > [Add Pages
for Equipment] > [Create Page]

Add Pages for Item MOC Administrator > Extensible Attributes 
Workbench > Items > [select Entity Name link] 
> Classifications tab [Pages] > [Add Pages for 
Item] > [Create Page]

Add Pages for Others MOC Administrator > Extensible Attributes 
Workbench > Others > [select Entity Name 
link] > Classifications tab [Pages] > [Add Pages
for Others] > [Create Page]

Add Pages for Work Order MOC Administrator > Extensible Attributes 
Workbench >Work Orders > [select Entity 
Name link] > Classifications tab [Pages] > [Add
Pages for Work Order] > [Create Page]

Application Object Library Lookups Development Manager Responsibility > 
Lookups

Asset Performance Dashboard MOC User > Manufacturing Operations Center
Analytics: Asset Performance Dashboard

Attribute Function Page MOC Administrator > Extensible Attributes 
Workbench
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Page Name Navigation Path

Attribute Function Summary MOC Administrator > Extensible Attributes 
Workbench

OEE by Equipment MOC User > Manufacturing Operations Center
Analytics > Plant Manager Dashboard > [select 
a Bottom Performers Equipment Gauge]

Attribute Group Details MOC Administrator > Extensible Attributes 
Workbench > [select Entity type] > [select 
Entity Name link] > Classifications tab 
[Attribute Groups] > [Add Attribute Groups] >
[Display Name link]

Attribute Groups for Batch Operation MOC Administrator > Extensible Attributes 
Workbench > Batch Operations > [select Entity 
Name link] > Classifications tab [Attribute 
Groups]

Attribute Groups for Equipment MOC Administrator > Extensible Attributes 
Workbench > Equipment > [select Entity Name
link] > Classifications tab [Attribute Groups]

Attribute Groups for Item MOC Administrator > Extensible Attributes 
Workbench > Items > [select Entity Name link] 
>Classifications tab [Attribute Groups]

Attribute Groups for Others MOC Administrator > Extensible Attributes 
Workbench > Others > [select Entity Name 
link] > Classifications tab [Attribute Groups]

Attribute Groups for Work Order MOC Administrator > Extensible Attributes 
Workbench > Work Orders > [select Entity 
Name link] > Classifications tab [Attribute 
Groups]

Batch Equipment Contextualization Update MOC Administrator > Setup > 
Contextualization Setup > [select records] > 
[Enter Context in Batch]

Batch Operations Segments Overview MOC User > Extensible Attributes Data > Batch
Operations > [select an Entity Name link] > 
Entity: Batch Operation select [Entity Name 
link]
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Page Name Navigation Path

Batch Operation Pages MOC Administrator > Extensible Attributes 
Workbench > Batch Operations > [select Entity 
Name link] > Classifications tab [Page]

Batch Performance MOC User > Manufacturing Operations Center
Analytics > Plant Manager Dashboard > [Batch
Performance]

Batch Performance Detail MOC User > Manufacturing Operations Center
Analytics > Plant Manager Dashboard > [Batch
Performance] > Production Variance by 
Product region > [select a Work Order 
Quantity Variance Bar within bar graph]

Create Classification MOC Administrator > Extensible Attributes 
Workbench > Others > [Create]

Downtime Reasons Entry MOC User > Tag Data Workbench > 
Equipment Downtime Reasons > [select data 
on Equipment Downtime Reason] > [select 
records] > [Enter Downtime Reason]

Entity: Batch Operation MOC Administrator > Extensible Attributes 
Workbench > Batch Operations 

MOC User > Extensible Attributes Data > Batch
Operations

Entity: Batch Operation Classifications MOC Administrator > Extensible Attributes 
Workbench > Batch Operations > Entity: Batch 
Operation > [select Entity Name link] 

Entity: Equipment MOC Administrator > Extensible Attributes 
Workbench > Equipment

MOC User > Extensible Attributes Data > 
Equipment 

Entity: Equipment Classifications MOC Administrator > Extensible Attributes 
Workbench > Equipment > Entity: Equipment 
> [select Entity Name link] 
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Page Name Navigation Path

Entity: Item MOC Administrator > Extensible Attributes 
Workbench > Items

MOC User > Extensible Attributes Data > Items

Entity: Item Classifications MOC Administrator > Extensible Attributes 
Workbench > Items > Entity: Item > [select 
Entity Name link] 

Entity: Others MOC Administrator > Extensible Attributes 
Workbench > Others

MOC User > Extensible Attributes Data > 
Others 

Entity: Others Classifications MOC Administrator > Extensible Attributes 
Workbench > Others > Entity: Others > [select 
Entity Name link] 

Entity: Work Order MOC Administrator > Extensible Attributes 
Workbench > Work Orders

MOC User > Extensible Attributes Data > 
Work Orders

Entity: Work Order Classifications MOC Administrator > Extensible Attributes 
Workbench > Work Orders > Entity: Work 
Order > [select Entity Name link]

Equipment Contextualization Setup MOC Administrator > Setup > 
Contextualization Setup

Equipment Downtime Analysis MOC User > Manufacturing Operations Center
Analytics > Plant Manager Dashboard > [select 
a Bottom Performers Equipment Gauge] > 
[Overall Equipment Effectiveness Details 
Region] > [select a Machine Availability Value]

Equipment Downtime Reasons MOC User > Manufacturing Operations Center
Analytics > Plant Manager Dashboard > [select 
a Bottom Performers Equipment Gauge] > 
Overall Equipment Effectiveness Details 
Region > [select Machine Availability Value] > 
[select Actual Downtime Hours value]
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Page Name Navigation Path

Equipment Downtime Reason MOC User > Tag Data Workbench > 
Equipment Downtime Reasons 

Equipment Downtime Reasons Entry MOC User > Tag Data Workbench > 
Equipment Downtime Reasons > [Enter 
Downtime Reason]

Equipment Downtime Reasons [View] MOC User > Tag Data Workbench > 
Equipment Downtime Reasons > [select data 
on Equipment Downtime Reason] > [select 
records] > [View Reason]

Equipment Efficiency Analysis MOC User > Manufacturing Operations Center
Analytics > Plant Manager Dashboard > [select 
a Bottom Performers Equipment Gauge] > 
[Overall Equipment Effectiveness Details 
Region] > [select a Machine Performance 
Value]

Equipment Efficiency Detail MOC User > Manufacturing Operations Center
Analytics > Plant Manager Dashboard > [select 
a Bottom Performers Equipment Gauge] > 
[Overall Equipment Effectiveness Details 
Region] > [select a Machine Performance 
Value] > [select a Machine Efficiency value]

Equipment Overview MOC User > Extensible Attributes Data > 
Equipment > Entity: Equipment [select Entity 
Name link] 

Equipment Pages MOC Administrator > Extensible Attributes 
Workbench > Equipment > [select Entity Name
link] > Classifications tab [Pages]

Equipment Reason Code Setup MOC Administrator > Equipment Reason 
Code Setup

Equipment Scrap Analysis MOC User > Manufacturing Operations Center
Analytics > Plant Manager Dashboard > [select 
a Bottom Performers Equipment Gauge] > 
[Overall Equipment Effectiveness Details 
Region] > [select a First Pass Yield Value]
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Page Name Navigation Path

Equipment Scrap Reason MOC User > Tag Data Workbench > 
Equipment Scrap Reasons 

Equipment Scrap Reasons Entry MOC User > Tag Data Workbench > 
Equipment Scrap Reasons > [Enter Scrap 
Reason]

Equipment Scrap Reasons View MOC User > Tag Data Workbench > 
Equipment Scrap Reasons > [select data on 
Equipment Scrap Reason] > [select records] > 
[View Reason]

Equipment Scrap Reasons MOC User > Manufacturing Operations Center
Analytics > Plant Manager Dashboard > [select 
a Bottom Performers Equipment Gauge] > 
[Overall Equipment Effectiveness Details 
Region] > [select a First Pass Yield Value] > 
[select a Scrapped Quantity value] 

Event Setup MOC Administrator > Event Setup

Extensible Attributes Data MOC User > Extensible Attributes Data

Facilities Manager MOC User > Manufacturing Operations Center
Analytics > Facilities Manager

Items Overview MOC User > Extensible Attributes Data > Items
> [select an Entity Name link] > Entity: Item 
[Entity Name link]

Item Pages MOC Administrator > Extensible Attributes 
Workbench > Items > [select Entity Name link] 
> Pages

Manual Contextualization MOC User >Tag Data Workbench > Manual 
Contextualization 

Manufacturing Operations Center Catalog MOC User > Manufacturing Operations Center
Analytics > Manufacturing Operations Center 
Catalog 
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Page Name Navigation Path

Others Overview MOC User > Extensible Attributes Data > 
Others > [select an Entity Name link] > Entity: 
Others [select Entity Name link]

Others Pages MOC Administrator > Extensible Attributes 
Workbench > Others > [select Entity Name 
link] > Classifications tab [Pages]

Parameters MOC Administrator > Setup > Run Requests > 
Submit Request

Plant Manager Dashboard MOC User > Manufacturing Operations Center
Analytics > Plant Manager Dashboard

Production Loss Analysis MOC User > Manufacturing Operations Center
Analytics > Plant Manager Dashboard > [select 
a Bottom Performers Equipment Gauge] > 
[Production Loss Analysis]

Production Loss Detail MOC User > Manufacturing Operations Center
Analytics > Plant Manager Dashboard > [select 
a Bottom Performers Equipment Gauge] > 
[Production Loss Analysis] > [select a Total 
Production Loss value] 

Production Performance MOC User > Manufacturing Operations Center
Analytics > Plant Manager Dashboard > 
[Production Performance]

Production Slippage Trend MOC User > Manufacturing Operations Center
Analytics > Plant Manager Dashboard > 
[Production Performance]

Production Supervisor Dashboard MOC User > Manufacturing Operations Center
Analytics: Production Supervisor Dashboard

Reprocess Errors MOC Administrator > Setup > Reprocess 
Errors

Reprocess Transactions ODI Studio > MTH Transactions > MTH 
Equipment Transactions [Folder] > Reprocess 
Transactions
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Page Name Navigation Path

Scrap Reason MOC User > Tag Data Workbench > Scrap 
Reasons

Scrap Reasons Entry MOC User > Tag Data Workbench > 
Equipment Scrap Reasons > [select data on 
Equipment Scrap Reason] > [select records] > 
[Enter Scrap Reason]

Scrap Reasons [View] MOC User > Tag Data Workbench > 
Equipment Scrap Reasons > [select data on 
Equipment Scrap Reason] > [select records] > 
[View Reason

Sites Summary MOC Administrator > Setup > Site Home

Sustainability Performance MOC User > Manufacturing Operations Center
Analytics > Plant Manager Dashboard > 
Sustainability Performance

Tag Mapping MOC Administrator > Entity Hierarchy Home 
Page > Equipment Setup> Tag Mapping 

Tag Setup MOC Administrator > Setup > Tag Setup

Update Classification MOC Administrator > Extensible Attributes 
Workbench > Others > Entity: Others [select 
Entity Name link] > [Update]

Update Equipment Event Action Sequentially MOC Administrator > Event Setup > [Update 
Sequentially]

Update Equipment Reason Code Sequentially MOC Administrator > Equipment Reason 
Code Setup > [Update Sequentially]

Work Orders Order Type MOC User > Extensible Attributes Data > 
Work Orders > Entity: Work Order [select 
Entity Name link] > Order Type

Work Orders Overview MOC User > Extensible Attributes Data > 
Work Orders > Entity: Work Order [select 
Entity Name link] 
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Page Name Navigation Path

Work Order Pages MOC Administrator > Extensible Attributes 
Workbench > Work Orders > [select Entity 
Name link] > Classifications tab [Pages]
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Glossary

Attributes

Details that define the manufacturing entity and specify behavior. For example; 
physical item attributes identify the size, shape, and color of an item. 

Attribute Group

Attribute groups represent the logical grouping of similar entity attributes. They collect 
characteristics (attributes) that can be used to record specifications or represent the 
properties. 

Batch Quantity

A quantity scheduled to be produced. MOC uses process manufacturing batches.

• For discrete products, the batch is planned to be the standard batch quantity, but 
during production, the standard batch quantity may be broken into smaller lots.

• In non-discrete or process products, the batch is a quantity that is planned to be 
produced in a given time period—based on a formula or recipe developed to 
produce a given number of end items.

Contextualization

The ability to take highly granular tag data collected from shop floor transactions and 
convert it into meaningful business data. The contextualization rules engine 
synchronizes entities such as equipment, work orders, routing operations, items, and 
shifts—with ERP data. 

Device

This term is typically used for PLCs or any other type of devices such as sensors, 
counters, and bar code readers that can serve as means for collecting MOC data.

ETL or Extract, Transform, Load

Database and data warehousing involves extracting data from outside sources, 
transforming data per your requirements, and loading it into the database or data 
warehouse.
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ISA-95 or Instrumentation, Systems and Automation Society

A standard for Enterprise systems to control system integration that includes batch, 
continuous, and discrete industries. This standard is managed by the Instrumentation, 
Systems and Automation Society. ISA-95 defines terminology, functional requirements, 
and uses PRM (Purdue Reference Model) for manufacturing.

KPIs or Key Performance Indicators

Quantifiable measurements reflecting the critical success factors of an organization. 

MES or Manufacturing Execution System

MES is used for a class of mid-level systems that operate between ERP and the shop 
floor. These systems typically belong to an enterprise class of software, but provide a 
deeper view of the manufacturing execution process on the shop floor.

OBIEE or Oracle Business Intelligence Enterprise Edition

A comprehensive suite of enterprise business intelligence products that deliver a full 
range of analysis and reporting capabilities. OBIEE provides intelligence and analytics 
from data spanning enterprise sources and applications. 

OPC or OLE for Process Control 

OPC is a set of standard interfaces based upon Microsoft's OLE/COM technology. The 
application of the OPC standard interface makes possible interoperability between 
automation/control applications, field systems/devices, and so forth.

ODI or Oracle Data Integrator 

A comprehensive tool for ETL (extract, transform and load), relational and dimensional 
modeling, data quality, data auditing, and full lifecycle management of data and 
metadata.

OEE or Overall Equipment Effectiveness

The OEE measure is the basic building block of a manufacturing improvement 
approach called total productive manufacturing or TPM. Developed by the Japanese in 
the 1960s, TPM is a shop floor focused improvement program whose primary objective 
is to maximize OEE. The three performance elements of OEE are influenced by 
numerous events—also known as losses. For instance, availability may be lost because 
of breakdowns, material shortages, or operator absence. Each of these account for a 
proportion of the loss, and each can be measured in percentages. By understanding 
both the types of loss and their duration, operators can focus their improvement 
activities on areas that provide the greatest benefits.

PLC or Programmable Logic Controller

A type of industrial controller. Originally industrial automation was implemented with 
discrete relays and timers, which were connected together with copper wire; changes in 
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the function (or logic) of the control system required rewiring. PLCs were developed to 
replace these banks of relays in semi-automated factories, notably automobile plants in 
the late 1960s. The programming method that most PLCs use is called ladder logic. Scan
rates are critical for a PLC, because they constantly read (scan) all points, process logic, 
and then write to all points. Most PLCs run on a proprietary network.

Sensor

A device that responds to a physical stimulus (heat, light, sound, pressure, motion, 
flow, and so on), and produces a measurable corresponding electrical signal known as 
transducer.

Tag

A term used to represent individual data elements on a PLC. The tags are configurable 
and can be programmed using PLC programming techniques.
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